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Ohutus
Sissejuhatus
Enne tarkvara kasutamist on selle tõhusaks ja ohutuks kasutamiseks oluline lugeda see ohutuse jaotis ja kõik sellega 
seotud teemad läbi. Enne toote kasutamist on oluline selle kasutusjuhendi sisu läbi lugeda ja sellest aru saada. Peaksite 
perioodiliselt siinseid protseduure ja ohutusealaseid ettevaatusabinõusid taas üle vaatama. 

See tarkvara on ette nähtud ainult väljaõppinud ja kvalifitseeritud personalile.

Tarkvara suiteDXT/suiteHEART® eeldatav kasulik kasutusiga on 7 aastat alates selle esmaavaldamise kuupäevast.

ETTEVAATUST! USA föderaalseadus lubab seadet müüa, levitada ja kasutada ainult arstil või arsti korraldusel.

Tunnussõnu „Oht!“, „Hoiatus!“ ja „Ettevaatust!“ kasutatakse käesolevas juhendis ohtudele ning nende raskusastmele 
viitamiseks. Ohuna määratakse allikat, mis võib inimesele potentsiaalselt vigastusi põhjustada. Viige end allolevas tabelis 
olevate mõistete kirjeldustega kurssi.

Tabel 1:  Ohutusalased mõisted

Tingmärk Definitsioon

OHT!

Tunnussõna „Oht!“ kasutatakse selleks, et näidata tingimusi või tegevusi, mille puhul on 
teadaolevalt olemas konkreetne oht, mis juhiste eiramisel põhjustab raskeid kehavigastusi, 
surma või olulist varalist kahju.

HOIATUS! 

Tunnussõna „Hoiatus!“ kasutatakse selleks, et näidata tingimusi või tegevusi, mille puhul on 
teadaolevalt olemas konkreetne oht.

ETTEVAATUST! 

Tunnussõna „Ettevaatust!“ kasutatakse selleks, et näidata tingimusi või tegevusi, mille puhul on 
teadaolevalt olemas potentsiaalne oht.
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Kasutusnäidustused
Tarkvara suiteHEART® on analüütilise tarkvara tööriist, mis tagab meditsiiniliste kujutiste ülevaatamiseks ja aruandluseks 
taastatavad tööriistad. Tarkvara suiteHEART® suudab importida MR-süsteemidest meditsiinilisi kujutisi ja neid arvuti 
ekraanil vaatealal kuvada. Vaateala võimaldab ligipääsu mitmete lõikude ja mitmete faasidega kujutiste erinevatele 
uuringutele ja seeriatele. Mitme faasiga kujutiste järjestusi saab visualiseerimise lihtsustamiseks kuvada videorežiimis.

Olemas on ka aruande sisendi liides. Aruande liidese mõõtmistööriistad võimaldavad kiiresti ja usaldusväärselt täita 
piltdiagnostika uuringu täieliku kliinilise aruande. Olemasolevate tööriistades seas on punkti, kauguse, pindala ja mahu 
mõõtmise tööriistad nagu väljutusfraktsiooni, südame minutimahu, lõppdiastoolse mahu, lõppsüstoolse mahu ja voolu 
mahu mõõtmised.

Olemas on ka poolautomaatsed tööriistad vasaku vatsakese kontuuri, klapi tasapinna ja veresoone kontuuri 
tuvastamiseks, et teostada voolu analüüs, signaali intensiivsuse analüüs müokardi ja infarkti suuruse mõõtmiseks ning T2* 
analüüs.

Mõõtmistööriistade tulemusi tõlgendab arsti ja neid saab edastada suunavatele arstidele.

Kui neid tõlgendab koolitatud arst, võivad need tööriistad olla kasulikud diagnoosi panemise toetamiseks.

Kasutusotstarve
Tarkvara suiteHEART® eesmärk on aidata koolitatud kliinilisel personalil südame funktsiooni kvalitatiivselt ja 
kvantitatiivselt hinnata. Tarkvara annab tööriistad, millega DICOM-i kujutiste parameetreid kohandada, ja kujutise 
esitluse, kus kasutaja saab hinnata erinevaid MRT-ga saadud kujutisi südamest ja veresoonkonnast aja jooksul. Lisaks 
annab tarkvara tööriistad lineaarsete kauguste, pindalade ja mahtude mõõtmiseks, mida saab kasutada südame 
funktsiooni kvantitatiivseks hindamiseks. Tarkvara pakub lõpetuseks ka tööriistu voolu mahu mõõtmiseks ja võimaluse 
voolu väärtusi arvutada.

Toetatud DICOM-i kujutisevormingud
Tarkvara suiteHEART® toetab järgmisi DICOM-i vorminguid: MR ja tõhustatud MR. Lisateavet toetatud vormingute kohta 
vt tarkvara suiteHEART® DICOM-i vastavusavalduse juhendist.

ETTEVAATUST! DICOM-i kujutisena säilitatud andmed, mis on imporditud välisest PACS-ist, ei pruugi olla 
tarkvaras suiteHEART® vaadatavad. 
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Ohutusmärkused

HOIATUS! Rakendus ainult aitab kujutisi analüüsida ja ei anna automaatselt tulemuste kliinilist tõlgendust. 
Kvantitatiivsete mõõtmiste kasutamine ja paigutus on kasutaja äranägemisel. Kui mõõtmised on 
ebatäpsed, võib see tuua kaasa vale diagnoosi. Mõõtmised peaks tegema ainult nõuetekohaselt 
koolitatud ja kvalifitseeritud kasutaja.

HOIATUS! Kujutisel olevaid artefakte võidakse valesti tõlgendada ja see võib viia valediagnoosini. Ärge 
kasutage diagnoosimiseks artefaktidega kujutisi. Analüüsid peaks tegema ainult nõuetekohaselt 
koolitatud ja kvalifitseeritud kasutaja.

HOIATUS! Kui kujutistel ei ole patsiendi nime või ID-d, võidakse määrata diagnoos valele patsiendile. Ärge 
kasutage diagnoosi määramiseks kujutisi, millel ei ole patsiendi nime või ID-d. Veenduge 
visuaalselt enne analüüsimist, et patsiendiandmed on õige.

ETTEVAATUST! Kui kasutatakse kujutisi, millele on rakendatud kujutise filtrit, võidakse saada moonutatud 
tulemused. Pikselintensiivsusega korrigeeritud kujutiste analüüsimisel peaks kasutaja lähtuma 
oma äranägemisest. 

Ohud seadmetest

ETTEVAATUST! Kahjustatud või mitteterviklikke seadmeid kasutades võib patsiendi diagnoosimise 
edasilükkumise tõttu ohtu seada. Veenduge, et seadmed on töökorras.

ETTEVAATUST! Rakendused võivad töötada seadmetel, mis sisaldavad ühte või mitut kõvaketast, mis võivad 
sisaldada patsientidega seotud terviseandmeid. Mõnes riigis võivad sellistele seadmetele 
kehtida isikuandmete töötlemist ja selliste andmete vaba ringlust käsitlevad eeskirjad. 
Isikuandmete avaldamine võib olenevalt pädevast reguleerivast asutusest tuua kaasa 
õigusmeetmete võtmist. On tungivalt soovitatav, et juurdepääs patsiendi failidele oleks 
kaitstud. Kasutaja peab mõistma patsiendiandmeid reguleerivaid seadusi.
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Küberturve
Selle tarkvara loomisel ja rakendamisel kohaldab NeoSoft järgmisi küberturbe ettevaatusabinõusid.

• NeoSofti tarkvara haldamise teatud funktsioone (kasutajaõigused, andmebaaside ümberehitamine jne) saavad teostada 
vaid väljaõppinud haldurid.

• NeoSofti tarkvara analüüsitakse regulaarselt NIST-i andmebaasis loetletud tuntud haavatavuste suhtes ja vajadusel tehakse 
parandused. 

• NeoSofti tarkvara kasutab patsientide andmete säilitamiseks ja kasutaja konfigureeritud pordi kaudu patsientide andmete 
edastamiseks võrgus DICOM-i standardeid.

• Enne tarkvara paigaldamist kontrollitakse NeoSofti tarkvara terviklust md5 summas, et kindlustada tarkvara terviklik 
tarnimine. 

• NeoSofti tarkvara on kontrollitud kasutamiseks riistvaral, millel on krüptimine lubatud. 
• NeoSoft maandab küberturbe riske kooskõlas ISO 14971 standardiga.
• NeoSofti töötajad on läbinud küberturbe ja terviseandmete kaitsmise alase koolituse. 
• NeoSoft ei saa ega halda kaitstud terviseandmeid, välja arvatud siis, kui klient on andnud tõrkeotsingu jaoks 

erijuurdepääsu. 
• NeoSofti tarkvara on läbinud läbistustestimise. 
• Automaatne väljalogimine (ALOF) – suiteHEART võib olla konfigureeritud end sulgema, kui seda ette nähtud aja jooksul ei 

kasutata. suiteDXT jääb avatuks kuni kasutaja selle sulgeb või süsteem taaskäivitatakse. 
• Auditi kontrollid (AUDT) – suiteHEART ja suiteDXT loovad ajatempliga logisid, mis sisaldavad tarkvarasündmusi ja 

kasutajateavet.
• Autoriseerimine (AUTH) – suiteDXT-s võib haldur vaadata ja konfigureerida teiste kasutajate juurdepääsu kontrollimist. 

Olenevalt sellest, kuidas juurdepääs on konfigureeritud, võivad kasutajad suiteDXT-s ja suiteHEART-s teatud uuringuid 
ainult vaadata. Näiteks kasutajal A on juurdepääs uuringuteabele vaid asukohast A ja kasutaja B saab uuringule ligi nii 
asukohast A kui ka B.

• Seadme autentimine (NAUT) – suiteDXT saab konfigureerida suhtlema teiste DICOM-seadmetega, konfigureerides AE 
pealkirja, IP-aadressi ja DICOM-pordi. suiteHEART ei kasuta vaikimisi võrku, kuid see võib olla konfigureeritud saatma 
andmeid teistele süsteemidele konfiguratsioonimuudatuse kaudu, tuvastades teised süsteemid AE pealkirja, IP-aadressi ja 
pordi järgi. Mõlemaid tooteid võib kasutada ilma võrguta importides failisüsteemist kohalikud uuringuandmed, selle 
asemel, et saata või saada andmeid võrgu vahendusel. 

• Isiku autentimine (PAUT) – suiteHEART ja suiteDXT võivad olla konfigureeritud nii, et need võimaldavad kasutaja 
autentimist, kasutaja parooli kontrolli ja sisselogitud kasutaja jaoks saadaolevate patsiendiandmete konfigureerimist. 
Kasutajateave logitakse.

• Ühenduvusvõimalused (CONN) – suiteDXT võib andmete edastamiseks luua ühenduse teiste konfigureeritud DICOM-i 
partneritega. suiteHEART võib olla konfigureeritud saatma andmeid teistele süsteemidele konfiguratsioonimuudatuse 
kaudu, tuvastades teised süsteemid AE pealkirja, IP-aadressi ja pordi järgi. 

• Füüsilised lukud (PLOK) – pole asjakohane. NeoSoft soovitab kaitseks kasutada võrguturbetooteid.
• Süsteemi ja rakenduse tugevdamine (SAHD) – pole asjakohane. NeoSoft soovitab kaitseks kasutada võrguturbetooteid.
• Terviseandmete umbisikustamine (DIDT) – suiteDXT sisaldab Anonümiseerimise (Anonymize) funktsiooni patsiendi 

uuringute umbisikustamiseks. 
• Terviseandmete terviklus ja autentsus (IGAU) – suiteDXT sisaldab uuringute andmete importimiseks/edastamiseks 

olekuteateid, mis annavad eduka importimise või edastamise kinnituse ja teabe vigade esinemise kohta. suiteHEART 
hoiatab kasutajat hüpikakna kaudu, kui oodatud sisendandmed puuduvad või on rikutud. 

• Andmete varukoopia ja avariitaaste (DTBK) – suiteHEART-i genereeritud andmed on soovitav pikemaks säilitamiseks/
varundamiseks saata PACS-i. suiteDXT sisaldab andmebaasi taastamise tööriista, kui kohalik tarkvara peaks olema rikutud.

• Terviseandmete säilitamise konfidentsiaalsus (STCF) – suiteHEART ja suiteDXT on ette nähtud kasutamiseks kvalifitseeritud 
personali poolt ja neid võidakse kasutaja äranägemisel kaitsta kasutajanime ja parooliga.

• Edastamise konfidentsiaalsus (TXCF) – kõik andmed edastatakse DICOM-i vormingus.
• Edastamise terviklus (TXIG) – kõik andmed edastatakse DICOM-i vormingus.
• Toote küberturbe täiendused (CSUP) – kõik paigaldused ja täiendused on uue tarkvaraväljalaske kujul, mida lubab ja 

rakendab kasutaja omal äranägemisel.
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• Tarkvara materjalid (SBoM) – suiteHEART-i Lisateabe (About) kuval on loetletud kolmandate isikute tarkvara. suiteDXT 
kolmandate isikute tarkvara teave on leitav suiteDXT paigalduskataloogi kaustas „3pinfo“. 

• Kolmandate isikute komponentide teedekaart seadme elutsüklis (RDMP) – NeoSoft hindab kolmandate isikute tarkvara 
regulaarselt ja värskendab vajadusel suiteHEART-i ja/või suiteDXT-d.

• Turbejuhis (SGUD) – NeoSoft soovitab kasutada viirusetõrjetarkvara.
• Võrguturbefunktsioonide konfigureerimine (CNFS) – toote võime konfigureerida võrguturbefunktsioone vastavalt kasutaja 

vajadustele – nii suiteHEART-i kui ka suiteDXT-d saab kasutada ilma võrguühenduseta. Kui need aga on konfigureeritud 
võrgus edastamiseks, on vajalikud vaid AE pealkiri, IP-aadress ja pordi teave. Täiendavate turbemeetmete võtmine ei ole 
nõutav/vajalik. 

• Hädaolukorra juurdepääs (EMRG) – puudub. suiteHEART-i ja suiteDXT-d ei kasutata hädaolukorras.
• Kaugteenus (RMOT) – teenust võib osutada kaugteenusena kliendi poolt ette nähtud kaugjuurdepääsu meetodi (nt 

kaugtöölaua) kaudu. suiteHEART ja suiteDXT ei sisalda ise kaugjuurdepääsu.
• Pahavara tuvastamine/kaitse (MLDP) – puudub. suiteHEART ja suiteDXT ei sisalda pahavara tuvastamist või sellevastast 

kaitset. NeoSoft soovitab kaitseks kasutada võrguturbetooteid.
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Alustamine

Rakenduse käivitamine ja sellest väljumine
Tarkvara suiteHEART® on rakendus, mida kasutatakse südame MRT (magnetresonantstomograafia) uuringute 
analüüsimiseks, vaatamiseks ja nende kohta aruannete tegemiseks. See kasutusjuhend annab üksikasjalikud selgitused 
tarkvara suiteHEART® kasutajaliidese ja südame MR-kujutiste kvantitatiivse analüüsi tegemise töövoo kohta.

Tarkvara suiteHEART® käivitamine
1. Käivitage suiteDXT arvuti töölaual oleva otsetee abil.

MÄRKUS. Tarkvara mõlemad rakendused (suiteDXT ja suiteHEART®) peavad töötama (samaaegselt), et lihtsustada 
rakenduste vahel vajalike failide edastamist.

2. Avage põhikuval Käivita rakendus (Launch Application) rippmenüü ja valige tarkvara suiteHEART®.

JOONIS 1. Tarkvara käivitamine
 

3. Valige uuringute loendist uuring ja tehke ühte järgmistest tegevustest.
• Valige Käivita (Launch).
• Tehke uuringul topeltklõps.

4. Valige uuringurühm ja vajutage Käivita (Launch).

Teiste uuringute vaatamiseks kasutage Fail (File) > Uuringu vahetamine (Switch Study).

MÄRKUS. Ekraani lahutusvõime peab olema 1920 × 1080 px või suurem (rõhtpaigutus); 2160 × 3840 või suurem 
(püstpaigutus), muidu tarkvara ei käivitu.

HOIATUS! Kui kasutada kujutisi, mille analüüsiks on rakendatud pikslite intensiivsuse filtreid, siis võivad 
tekkida ebatäpsed tulemused.
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Tarkvarast suiteHEART® väljumine
Rakendusest väljumiseks valige Fail (File) > Välju (Exit) või klõpsake kasutajaliidese ülemises paremas nurgas risti (X) 
ikooni.

JOONIS 2. Tarkvara suiteHEART® sulgemine
Tarkvara suiteHEART® kasutusjuhend NS-03-043-0003-ET Red. 2 7



Kasutajaliidese ülevaade
Ülevaade

Tarkvara suiteHEART® analüüsirežiimide liidesed on organiseeritud järgmiselt.

• Tulemuste (Result) paan – juurdepääs analüüsirežiimide analüüsitööriistadele ja tulemuste tabelile
• Pisipiltide vaade (Thumbnail View) – kõikide lõikude asukohtade vaade
• Redaktorivaade (Editor View) – segmenteerimise redigeerimine ja ülevaatamine
• Maatriks (Matrix) – olemas Funktsiooni (Function) ja Müokardi perfusiooni (Myocardial Perfusion) analüüside jaoks 
• Video vaade (Cine View) – kujutiste vaatamine filmina 
• Ristlõiked (Cross Reference) – 3 vaateava 
• Aruandlus (Alt + R): Juurdepääs aruandlusele

JOONIS 1. Analüüsirežiimide liides (joonisel on funktsiooni analüüsi režiim) 
Pisipiltide vaade Maatriks 

Video vaade RedaktorivaadeTulemuste paan Aruandlus 

Ristlõigete 
vaateavad
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Analüüsi/vaatamise režiimid

MÄRKUS. Avatud ovaalmulgu (Patent Foramen Ovale (PFO)) analüüse saab valida faili rippmenüüst või kasutades klaviatuuril 
klahvikombinatsiooni Ctrl + 5.

Seeriate sirvimine

Valitud uuringu kujutiste vaatamiseks või seeriate vahetamiseks kasutage parem- ja vasaknoolenuppe kujutisevaaturi ülaservas. 
Seeriate valimiseks saab kasutada ka seeriatefaili rippmenüüd, mis asub filtri nupust vasakul. Seeriad, milles on olemas huvipakkuv 
analüüs või piirkond, tuuakse välja poolpaksus kirjas, nagu joonisel Joonis 2.

JOONIS 2. Seeriate sirvimine

Tabel 1:  Analüüsirežiimid

Funktsiooni 
analüüs

vool 
analüüsid

Müokardi 
hindamine

T1 
kaardistamine

T2 
kaardistamine

Müokardi 
perfusiooni 
analüüsid

T2* analüüs

Tabel 2:  Vaatamisrežiimid

Vaatur Virtual
Fellow®

3D/4D voolu 
vaatur
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Redaktori aken ja režiimi vaade

Kui kujutisevaaturis teha kujutisel paremklõps, aktiveeritakse kujutise töötlemise tööriistad. 

Failimenüü suvandid
Vali analüüs (Select Analysis) – valib analüüsirežiimi (funktsioon, vool, müokardi hindamine, müokardi perfusioon, PFO, T2*, T1 

kaardistamine, T2 kaardistamine, 3D/4D ja DENSE•) 
Andmebaasi sirvimine (BrowseDB) – avab kohaliku andmebaasi
Uuringute vahetamine (Switch Study) – loetleb uuringud kiireks ligipääsuks
Aruandlus (Reporting) – avab aruandluse liidese
Aruande ülevaatamine (Preview Report) – vormindatud aruande ülevaatamine
Aruande printimine (Print Report) – prindib aruande välja
Uuringu kinnitamine (Approve Exam) – kinnitab lõpliku aruande ja lukustab selle allkirjaga
Laadi üles kinnitatud uuring (Load Approved Exam) – taastab eelnevalt avatud aruande
Välju (Exit) – salvestab praegused analüüsitulemused sekundaarse ülesvõtte (SCPT) seeriatesse ja sulgeb rakenduse.

• eeldab teadustöölepingut

Tööriistade menüü suvandid
Eelistused (Preferences) >

Redigeeri (Edit) – avab eelistuste redaktori, et määrata tarkvara ja mallide eelistused
Impordi (Import) – taastab kasutajaeelistused ja makrod
Ekspordi (Export) – ekspordib kõik kasutajaeelistused

Ekspordi (Export) >
Aruanne DICOM-i (Report to DICOM) – loob praeguse analüüsi põhjal aruande ja salvestab selle sekundaarse ülesvõtte 

seeriana (SCPT).
Aruanne Excelisse (Report to Excel) – loob analüüsi tulemustega Exceli tabeli.
Aruanne XML-i (Report to XML) – ekspordib aruande XML-failina.
Kujutised DICOM-i (Images to DICOM) – salvestab hetkel valitud seeriate DICOM-video SCPT-failina.
Aruanne saata ... (Report to...) – ekspordib tulemused kolmanda isiku aruandesüsteemi.
Kujutised JPEG-i, AVI-sse jne (Images to JPEG, AVI, etc.) – ekspordib hetkel valitud seeriate kujutised valitud 

failivormingusse. Võimalikud vormingud on tihendatud QuickTime 
video, JPEG, TIFF, GIF, PNG või tihendamata AVI video.

Andmed Matlabi (Data to Matlab) – ekspordib binaarvormingus Mat-faili. (eeldab uurimislepingut)

Tabel 3:  Kujutise töötlemise tööriistad

Aken/tasand

Panoraam

Suumi

Roteeri

Pööra ümber

Saada aruannetesse

Skannimisparameetrid

Lähtesta
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Täpsustatud andmed Matlabi (Strain Data to Matlab) – ekspordib binaarvormingus Mat-faili. (Täpsustatud analüüs eeldab 
uurimislepingut)

Aruande andmebaas (Report Database) – avab andmebaasi otsingu liidese
Märkmete lülitamine (Toggle Annotation) – lülitab ROI märkmete kuvamist
Joone paksuse lülitamine (Toggle Line Thickness) – lülitab märkmete tegemisel kasutatava joone paksust.
Ristlõigete joonte lülitamine (Toggle Cross Reference Lines) – lülitab kujutiste ristlõigete jooni.
Vaatevälja lülitamine (Toggle FOV) – lülitab vaatevälja
Akna/tasandi ümbervahetamine (Invert Window/Level) – vahetab ringi akna/tasandi vaate

Abimenüü suvandid
Kasutusjuhend (Instructions for Use) – tarkvara suiteHEART® kasutusjuhend
Kiirklahvid (Quick Keys) – klaviatuuri funktsioonid
DICOM-i vastavusavaldus (DICOM Conformance Statement) – tarkvara suiteHEART® DICOM-i vastavusavaldus
Täpsemalt tarkvarast suiteHEART® (About suiteHEART®) – rakenduse versiooni teave 
Info eeskirjade kohta (Regulatory Information) – meditsiiniseadmete direktiiv

Redaktori vaate juhtnupud

Faasi liuguriga  kontrollitakse video faasi valikut.

Kerige läbi faaside hoides ühel ajal all Ctrl-klahvi ja keskmist hiireklahvi.

Kujutise etappide ikoonid  võimaldavad lõik lõigu haaval 
sirvimist, kui pisipiltide vaade on lõikudel või faasidel. Lõiku saab navigeerida ka keskmise hiireratta abil.

Klaviatuuril saate olenevalt eelistuste seadistustest lõike sirvida parem-/vasaknooleklahviga ja faase sirvida üles-/allanooleklahvidega. 

MÄRKUS. X-telje (lõik) ja y-telje (faas) saab omavahel ümber vahetada. Vt Funktsioon lk 34. Kui teljed ümber vahetatakse, tuleb 
rakendus uuesti käivitada.

Video vaate juhtnupud

 - Video juhtriba: määrab video algus- ja lõpukaadri.

 - Kaadrid sekundis (Frames Per Second (FPS)): Video kiiruse muutmiseks klõpsake noolel või sisestage tekstiväljale 
väärtus

 - Käivita ikoon: asub video juhtriba kõrval

 - Pausi ikoon: asub video juhtriba kõrval
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Ristlõigete vaateavad

Kui kujutiseredaktori vaateavades kuvatakse parajasti kujutise lühikese telje vaadet, kuvavad kolm ristlõigete vaadet kujutise pikitelje 
vaate. Pikitelje vaade on redaktori vaateavas kuvatava kujutise suhtes olev ristlõik. Antud on kõigi võimalike ristlõigete rippmenüü 
koos nupuga, millega ristlõigete indikaatorite kuvamist lülitada. Kasutage miinus- ja plussmärki või keskmist hiireratast lõikude 
asukohtade vahel navigeerimiseks.

JOONIS 3. Seeriate valiku rippmenüü

 

Kujutise töötlemise tööriistad

Tabel 4:  Tööriista kirjeldus

Lõigu/faasi vaate lülitamine

Aken/tasand – valige ja kasutage muudatuste tegemiseks keskmist hiireklahvi

Värviskaala – valige ja kasutage muudatuste tegemiseks keskmist hiireklahvi

Panoraami – valige ja kasutage muudatuste tegemiseks keskmist hiireklahvi

Suumi – valige ja kasutage muudatuste tegemiseks keskmist hiireklahvi

Roteeri – valige ja kasutage muudatuste tegemiseks keskmist hiireklahvi

Keera horisontaalselt – keerab kujutist horisontaalselt

Ulatus kõik – rakendab kujutise töötlust kõikidele lõikudele

Ulatus praegusest lõpuni – rakendab kujutise töötlust aktiivsest lõigust kuni viimase lõiguni

Ulatus ainult praegusele – rakendab kujutise töötlust vaid aktiivsele lõigule

Vaateavade paigutus – muudab vaaturi paigutust
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Võrdlusrežiim – läheb üle võrdlusrežiimile

Ülevaate režiim – läheb üle ülevaaterežiimile

Näita ristlõigete jooni – lülitab ristlõigete jooned sisse/välja

Värvikaardi ülekate – lülitab lõikude klassifitseerimise värvikaardi sisse/välja

Lähtesta – lähtestab W/L, panoraami, suumi ja pööra tagasi vaikeväärtustele olenevalt ulatuse sättest

Huvipakkuv piirkond – annab pindala ja ümbermõõdu

Sihikujoonestik – annab ühe piksli andmed

Lineaar – annab mõõtmistulemused sirgel joonel

Silt – võimaldab redaktori (Editor) aknas lisada kasutaja märkme

Nurk – võimaldab mõõta nurka

Leia tunnus – ristlõigete tööriist, mis automaatselt tuvastab ja kuvab kujutise, mis sisaldab sama asukohta

Tühista – tühistamise funktsioon ROI redigeerimiseks

Värskenda (Refresh) – klõpsake nupul kujutisevaaturi värskendamiseks äsja võrgust toodud uute kujutistega või 
analüüsirežiimide värskendamiseks
Filtreeri – sorteerib seeriad pulsisageduse tüübi järgi analüüsirežiimi kohaselt. Tühistamiseks valige KÕIK (ALL). 
Filtreid saab sätestada Eelistuste (Preferences) all. Kui filtrit kasutatakse, muutub filtri nupp roheliseks.

Tabel 4:  Tööriista kirjeldus
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Kiirklahvid 

*Aktiivne säte sõltub eelistustes valitud valikust.

Tegevus Kiirklahv Tegevus Kiirklahv

Kujutise suumimine Ctrl + keskmine hiireklahv T2* Ctrl + 6

Kujutise roteerimine Ctrl + Shift + keskmine 
hiireklahv

T1 kaardistamine Ctrl + 7

Panoraamkujutis Shift + keskmine hiireklahv T2 kaardistamine Ctrl + 8

Aken/tasand Alt + keskmine hiireklahv 3D/4D voolu vaatur Ctrl + 9

Video taasesitus/paus Tühikuklahv Navigeerimine lõikude vahel* Vasak- ja paremnooleklahvid

Faasi kerimine Ctrl + keskmine hiireratas Navigeerimine faaside vahel* Üles- ja allanooleklahvid

Lõigu kerimine Keskmine hiireratas Navigeerimine Virtual Fellow® 
lõikudel

Z ja A klahv järgmise ja eelmise 
lõigu jaoks

Aruandlus Alt+R Üldised märkmed

Vali vaatamiseks uuesti kõik 
kujutised

Ctrl + A Lineaar Shift + 1

Aruande andmebaas Ctrl + D Niitrist Shift + 2

Eelistuste redigeerimine Ctrl + E Huvipakkuv piirkond Shift + 3

Vaatevälja lülitamine Ctrl + F Silt Shift + 4

Uuringu kinnitamine Ctrl + G Nurk Shift + 5

Akna/tasandi ringivahetamine Ctrl + I ROI redigeerimistööriistad

Paksu joonega märkus Ctrl + L Kopeeri huvipakkuv piirkond Ctrl + C

Andmebaasi sirvimine Ctrl + O Kleebi huvipakkuv piirkond Ctrl + V

Prindi aruanne Ctrl + P ROI silumine Ctrl + S

Lahku rakendusest või välju Ctrl + Q Nihuta ROI-d vertikaalselt W- ja S-klahvid

Ülevaade, aruande Ctrl + R Nihuta ROI-d horisontaalselt A- ja D-klahvid

Vaheta uuringut Ctrl + S Loo punktsplaini nurk Alt + hiire vasakklahv

Märkuse lülitamine Ctrl + T Kustuta punkt (punktsplainil) KUSTUTUSKLAHV + kursor 
valitud punktil

Ristlõigete joonte lülitamine Ctrl + X 3D/4D voolu vaaturi redigeerimistööriistad

Tühista Ctrl + Z 3D-rotatsioon Ctrl + Alt + keskmine hiireklahv

DENSE Ctrl + 0 Kujutise suumimine Ctrl + keskmine hiireklahv

Funktsioon Ctrl + 1 Aken/tasand Alt + keskmine hiireklahv

vool Ctrl + 2

Müokardi hindamine Ctrl + 3

Müokardi perfusioon Ctrl + 4

PFO Ctrl + 5
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Tulemuste paan

Tulemuste paan on olemas igale analüüsirežiimile.

JOONIS 4. Tulemuste paan

 1. Tulemuste tabel, 2. Graafiku kuva, 3. Kustuta, 4. Graafikud, 5. Tabelid

1

2

5

3

4
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Tulemuste tabel

Mõõtmistulemusi saab eelistustes ümber korraldada ja konfigureerida (vt Printimise vahekaart lk 42). Mõõtmiste tabelit saab ümber 
korraldada nii, et valite rea ja lohistate selle uude kohta. Selline tabeli järjestus on alati vaikimisi kõikide uute uuringute eelisjärjestus. 
Klõpsates mõõtmise kõrval oleval kastil valige või tühistage mõõtmise lisamine aruandesse.

JOONIS 5. Tulemuste tabel

MÄRKUS. Südame löögisageduse muutmiseks või sisestamiseks klõpsake otse tabelile.

 Graafiku ja tabeli tulemused

Tulemusi saab kuvada graafikuna või tabelina klõpsates soovitud ikoonil, mis asub analüüsirežiimi paremal all nurgas.

JOONIS 6. Graafik (vasakul) ja tabel (paremal)
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Tabel 5:  Analüüsitööriistad

 Vasaku vatsakese endokardiaalne ROI  Pikitelje LV endokardiaalne ROI 

 Vasaku vatsakese epikardiaalne ROI
 Pikitelje LV epikardiaalne ROI 

 Parema vatsakese endokardiaalne ROI
 Vasaku vatsakese vaheseinmine ROI

 Parema vatsakese epikardiaalne ROI
 Vasaku vatsakese lokaalne ROI

 Mitraalklapi rõngas
 Vasaku vatsakese verevoo ROI

 Trikuspidaalklapi rõngas

 Parema vatsakese sisestuspunkt

 Vasaku vatsakesese papillaarlihase ROI

 Parema vatsakese papilaarlihase ROI

 Vasaku koja ROI 

 Parema koja ROI

 Pikitelje RV endokardiaalne ROI

 Pikitelje RV epikardiaalne ROI
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Aruandlus

Aruandluse liidese valimiseks vajutage korraga ALT + R. Lisateabe saamiseks vt Aruandlus lk 167.

JOONIS 7. Aruandluse liides

 - Aruandlus: kasutatakse aruandluse liidese või analüüsirežiimi avamiseks

 - Aruande ülevaade: kasutatakse aruande ülevaatamiseks

 - Kinnita uuring: kasutatakse aruande allkirjastamiseks

Andmebaasi sirvimine

Aken Andmebaasi sirvimine (Browse DB) näitab uuringuid kohaliku andmebaasis. Juhtnuppudega saab valida, milliseid uuringud 
vaadata või vahetatavate uuringute loendisse lisada.
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JOONIS 8. Andmebaasi sirvimine

1. Kohaliku andmebaasi loend, 2. Tarkvara suiteHEART® andmebaasi vaatur, 3. Lisa vaaturisse (Add to Viewer), 
4. Eemalda vaaturist (Remove from Viewer), 5. Uuenda vaadet (Update View), 6. Tühista (Cancel)

Andmebaasi sirvimise funktsioonid

Aken Andmebaasi sirvimine (Browse DB) kuvab alati vaikimisi kohalikku andmebaasi.

1. Kohaliku andmebaasi loend (Local database listing) – kuvab uuringuid, mis on kohalikku andmebaasi salvestatud.
2. Tarkvara suiteHEART® andmebaasi vaatur (suiteHEART® Software database viewer) – kuvab uuringuid, mis on praegu tarkvara 

suiteHEART® andmebaasis.
3. Lisa vaaturisse (Add to viewer) – lisab kohalikust andmebaasist (näha akna ülemises osas) valitud uuringu tarkvara suiteHEART® 

andmebaasi vaatealale.
4. Eemalda vaaturist (Remove from Viewer) – eemaldab uuringu tarkvara suiteHEART® andmebaasi vaatealalt.
5. Uuenda vaadet (Update View) – sulgeb akna Andmebaasi sirvimine (Browse Database) ja toob vaadatava loendi uuringu 

rakenduse vaaturisse. Kasutatakse vahetatavate uuringute akna jaoks.
6. Tühista (Cancel) – sulgeb akna Andmebaasi sirvimine (Browse Database) ilma loendis muudatusi tegemata.

1

2

3 4

6

5
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Andmebaasi sirvimise protseduur

Uuringuid saab vaadata valides neid kohalikust andmebaasist, lisades neid tarkvara suiteHEART® andmebaasi vaaturi loendisse ja 
klõpsates nupul Uuenda vaadet (Update View).

Uuringu lisamine tarkvara suiteHEART® vahetatavate uuringute loendisse
1. Klõpsake Fail (File) > Andmebaasi sirvimine (Browse DB).
2. Leidke uuring andmebaasi vaaturis ja klõpsake uuringul, et see esile tõsta.
3. Klõpsake Lisa vaaturisse (Add to Viewer).
4. Klõpsake Uuenda vaadet (Update View).
5. Uuring ilmub nüüd tarkvara suiteHEART® vahetatavate uuringute loendisse.

Uuringu eemaldamine tarkvara suiteHEART® vahetatavate uuringute loendist
1. Klõpsake Fail (File) > Andmebaasi sirvimine (Browse DB).
2. Leidke uuring ja klõpsake Eemalda vaaturist (Remove from Viewer).
3. Klõpsake Uuenda vaaturit (Update Viewer).

ETTEVAATUST! Ärge kustutage hetkel tarkvaras suiteHEART® avatud uuringut.

Et uuringuid vaaturis näha, tuleb need enne tarkvarasse suiteHEART® laadida. Vahetatavate uuringute loendurisse uuringute lisamise 
õppimiseks vt Andmebaasi sirvimise protseduur lk 20.

Tarkvara suiteHEART® sees uuringute vahetamine
1. Klõpsake Fail (File) > Vaheta uuringut (Switch Study).

Kuvatakse olemasolevate uuringute aken koos loendiga kõikidest uuringutest, mis on eelnevalt andmebaasi sirvimise 
protseduuriga laaditud.

2. Valige uuring.
Kui te ei soovi pärast vahetatavate uuringute akna avamist uuringuid vahetada, klõpsake rakendusse tagasipöördumiseks 
ükskõik kuhu väljapoole akent.
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Kujutisehalduse tööriistad

Vaatur
Vaatur võimaldab uuringu kiiret ülevaadet koos ristlõigetega. Vaaturi liides kuvab valitud uuringu jaoks seeriate loendi, kus 
iga seeriat kuvatakse vaateavas. Analüüsi ja vaatamise jaoks vaaturi liideses saab luua uusi seeria tüüpe. Uuringu 
vaatamise kiirendamiseks saab luua ka kasutaja määratud vaatamisprotokolle rutiinselt saadud seeriata kohta.

MÄRKUS. Kujutisi saab eksportida vaid analüüsirežiimis. 

JOONIS 1. Vaatur 

1. Kujutise filter, 2. Seeria/kujutise loend, 3. Kujutise vaateavad, 4. Ristlõiked, 5. Salvesta seeriad (Save series), 6. Ristlõiked, 7. Leia tunnus, 
8. Mõõtmistööriistad

1

4

8 5
67

2
3
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Kujutise/seeriate sirvimine
Klõpsake seerial ja kasutage klaviatuuril klahve Page Up või Page Down, et seeria sees lõike sirvida.

Järgmisele seeriale liikumiseks vajutage paremnooleklahvile ja eelmisele seeriale liikumiseks vasaknooleklahvile.

Liikumisel mitmefaasilisse seeriasse kuvatakse need automaatse paigutusega, ühefaasilised seeriad kuvatakse 1 × 1 
paigutusega.

Leia tunnus*

1. Ristlõigete tööriista kasutamiseks valige . 

Lilla kursor on primaarne kursor, mida saab kujutise peale asetada. 

2. Vajutage klahvi Ctrl ja valige ristlõigete tööriist primaarse kursori aktiveerimiseks. Kuvatakse automaatselt kõik 
lähedal asuva lõike asukohad. 

Peavaatesse ilmuvad ainult need lõigud, kus sekundaarne roheline kursor oli arvutuslikult primaarse lilla kursori 
lähedal. 

MÄRKUS. Vaateavadesse ilmuvad rohelised sekundaarsed ristmärkmed, mis sisaldavad mitteparalleelseid kujutisi ja 
nendes kohtades, mis on arvutatult 10 mm 3D kaugusel esmasest kursorist.

MÄRKUS. Vaateavadesse ilmuvad rohelised sekundaarsed ristmärkmed, mis sisaldavad paralleelseid kujutisi ja 
nendes kohtades, mis on arvutatult 5 mm 3D kaugusel esmasest kursorist.

*USA esmane patenditaotlus nr 62/923,061
Pealkiri: Method and System for Identifying and Displaying Medical Images
Leiutaja(d): Wolff et al.

Laienda/kahanda seeriaid
Kõigi seeriate laiendamiseks klõpsake (+); kahandamiseks klõpsake (-). 

JOONIS 2. Laienda seeriaid

Kiirklahv 

Funktsioon Tegevus
Vali vaatamiseks uuesti kõik 
kujutised

Ctrl + A
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Vaaturi funktsioonid
Uute seeriate loomine

Vaatur võimaldab luua uusi seeriate tüüpe, mida saab kasutada Funktsiooni (Function), Müokardi hindamise (Myocardial 
Evaluation), Müokardi perfusiooni (Myocardial Perfusion), T2*, T1 kaardistamise (T1 Mapping) ja T2 kaardistamise (T2 
Mapping) jaoks ning ainult ülevaatamiseks (kohandatud). Loodud seeriad lisatakse selle uuringu seeriate loendisse ja 
on tarkvara suiteHEART® rakenduses vaatamiseks ja analüüsimiseks saadaval.

MÄRKUS. Et seeria analüüsi jaoks sobiks, peab igal lõigu asukohal olema sama arv faase ning samad 
hõiveparameetrid ja skannimistasapinna ettekirjutus.

HOIATUS! Kasutaja vastutab selle eest, et analüüsimiseks loodud uued seeriad sisaldavad analüüsimiseks 
õigeid kujutisi. Ebaõigesti koostatud seeriaid saab analüüsida, kuid see võib anda ebaõigeid 
tulemusi. Kasutaja peab olema saanud südame analüüsimiseks korraliku väljaõppe ja ta peab 
olema teadlik lõikude asukohast, mis on uutesse seeriatesse kopeeritud. Ärge kustutage ära 
originaalkujutisi, mida kasutati DICOM-i importimiseks.

1. Valige seeriate loendist soovitud seeriad või lõikude asukohad.
2. Ühe seeria või lõigu asukoha lisamiseks valige seeriate rühm või lõigu asukoht ja klõpsake sellel kasutades klahvi Shift 

või Ctrl.
3. Klõpsamine ja lohistamine võimaldab kujutisi vaateavades järjestada.
4. Vaateavast kujutise kustutamiseks valige vaateava ja vajutage klaviatuuril kustusklahvi.

5. Valige  Salvesta seeria (Save series) paanil Joonis 3.

JOONIS 3. Seeriate salvestamise paan

6. Sisestage seeria nimi rakenduse seeriate kirjeldusse (Series description). 
7. Valige rippmenüüst seeriale sobivat tüüpi rakendus (Joonis 4). Kui on valitud Kohandatud (Custom), saab seeriatena 

salvestada erineva skannimistasapinnaga ja järjestustüüpidega kujutisi.
JOONIS 4. Uute seeriate salvestamine

Vaatamisprotokollid

Saadaval vaid siis, kui on NeoSoft tellitud.
Aruandlus

Aruandlusele ligipääsemiseks või vaaturi funktsiooni juurde tagasi pöördumiseks klõpsake .
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Võrdlusrežiim
Võrdlusrežiim annab võimaluse vaadata praeguse või eelneva uuringu kujutisi/seeriaid ühel ajal samas liideses.

MÄRKUS. Eelnevast uuringust aruandlusse saadetud kujutised on võrdlusrežiimis bittrastervormingus. Nendel 
kujutistel ei ole töötlemine võimalik.

HOIATUS! Enne uuringute (või uuringu seeriate) ülevaatamist või võrdlemist veenduge visuaalselt, et uuringu 
patsiendi kogu indikaatoriteave on mõlemas vaaturis sama. 

JOONIS 5. Vaaturi võrdlusrežiim

1 2

Vaatur 1

Vaatur 2

3
4 5

6

7 8

10
9

12

11
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Vaatur Tähis Kirjeldus
Vaatur 1 1 Seeriate rippmenüü

2 Seeriate valija
3 Hetkel vaadatava patsiendi uuringu indikaatorrida
4 Kujutise juhtnupp
5 Vaateava paigutuse valikud

Vaatur 2 6 Hetkel vaadatava patsiendi uuringu indikaatorrida
7 Uuringuvalija 
8 Seeriate valija 
9 Vaateava paigutuse valikud

Mõlemad vaaturid 10 Muuda ulatuse sätteid
11 Vaaterežiimi lüliti
12 Video sünkroonimise lülitamine
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Töövoo näidis
1. Topeltklõpsake suvalises analüüsirežiimis redaktori aknal.

2. Valige , et jagada liides kaheks vaaturiks, nagu näitab Joonis 6.

JOONIS 6. Vaatamine võrdlusrežiimis

3. Vahetage vaaturis 1 seeriaid, kasutades seeriate valimise rippmenüüd või parem-/vasaknooleklahvi.
• Ülemine vaatur kuvab alati praegust uuringut, mis on varasemalt käivitatud. 

4. Vaaturiga 1 võrdlemiseks valige vaaturile 2 sama uuringu sees olev teistsugune seeria, kasutades seeriate 
rippmenüüd. 

• Kui mistahes vaaturis on vaateava valitud ja lõik on paralleelne näiteks lühikese telje seeriaga, tuuakse lähtuvalt lõigu 
asukohast vastav lõik esile.

Vaatur 1

Vaatur 2
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JOONIS 7. Seeriate rippmenüü, vaatur 2

5. Kasutage uuringuvalijat, et võrrelda vaaturis 1 olevat praegust uuringut ja vaaturis 2 olevat muud uuringut.

JOONIS 8. Uuringuvalija, vaatur 2

6. Veenduge õige uuringu valikus, kontrollides mõlema vaaturi uuringu indikaatoriteavet.

JOONIS 9. Uuringu indikaatoriteave

7. Kui teete mistahes vaaturil paremklõpsu, avatakse kujutise töötlemise tööriistad.
• Ulatuse valik kehtib mõlemale vaaturile.

MÄRKUS. Kui kujutis on mõnest teisest uuringust, ei sobi kujutise asukoha määramine kujutiste vahekaardilt. 

MÄRKUS. Kui mõlemas vaaturis on valitud seeria jaoks video ja mõlemas seerias on sama arv faase, klõpsake videode 

vaate sünkroonimiseks .
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Eelistuste määramine

Kui valite tarkvara suiteHEART® liidese menüüribal Tööriistad (Tools) > Eelistused (Preferences), kuvatakse kolm suvandit: 
• Redigeerimine
• Importimine
• Ekspordi

TÄHTIS! Soovitav on sätestada kasutaja eelistused enne esimese juhu aruandluseks analüüsimist. Et eelistused 
jõustuksid, sulgege praegune uuringu ja sulgege ning taaskäivitage suiteDXT.

Seadete eelistused
Üldine (Global) vahekaart – eelistusi saab isikupärastada järgmiste funktsioonide osas. 

•  Aruanne
•  Vaatur
•  Virtual Fellow®
•  Aruannete lubatud kinnitajad
•  Üldine
•  Vool
•  Jõudeoleku taimer
•  Funktsioon
•  Müokardi hindamine
•  Seeria filter
•  Eksportimine (kujutis/video) 

 Mallide vahekaart – loob tulemuste parameetrite vahemike mallid aruannetes kasutamiseks.

 Makro vahekaart – võimaldab luua teksti eelvalikuid aruande jaotiste Mulje (Impression), Tehnikad (Techniques), 
Anamnees (History) ja Leiud (Findings).

 Printimise vahekaart – järjestab ja valib tulemuste parameetrid aruannete jaoks.

 Virtual Fellow® vahekaart – valib vaatamise eelistused.

 T1/T2 kaardistamise vahekaart – valib vaatamise ja analüüsimise eelistused.

 Aruandluse vahekaart – menüüpõhiste tekstivalikute redigeerimine ja kategooriate vahemike konfigureerimine automaatse 
eeltäitmise funktsiooni jaoks.
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Üldine vahekaart
Valik Lähtesta (Reset) vahekaardi ülemises paremas nurgas tühjendab kõik kasutaja valikud.

Aruanne 

Konfigureerib kõikide aruannete päises ilmuva teabe.

JOONIS 1. Aruande eelistused

Aruande eelistuste valikud
1. Valige menüüribal Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit). 
2. Valige Üldine (Global) vahekaart.

3. Pange kursor Aruande (Report) paanil soovitud väljale ja sisestage teave. 
Kindla paberisuurusega aruandele ilmuvad pealkirjad, päised ja logo. Aruandest selle teabe väljajätmiseks tühjendage 
märkeruut „Kasuta allpool toodud väljade väärtusi aruandes“ (Use the field values below in Report). See jõustub kõikide 
patsientide aruannete kohta, mis välja prinditakse. 

Märkeruudu „paaris ja paaritute ridade tugi“ (support even and odd row) tõstab liideses ja aruandes esile 
tulemuste read.

4. Aruandesse asukoha logo lisamiseks kasutage jpeg-, png- või gif-vormingus faili ja salvestage see kõvakettale või CD-
ROM-ile. Valige logo jaotise alt Lehitse (Browse) ja leidke süsteemi lehtiseja aknas faili asukoht. Valige õige logoga fail 
ja valige Ava (Open). 

Logo peaks nüüd aruande eelistuste paanile ilmuma.

5. Klõpsake Uuringu faili nimi (Exam File Name), et konfigureerida eksporditava aruande faili nimi.

6. Valige Salvesta ja välju (Save and Exit). 
Ilma salvestamata väljumiseks või muudatuste tühistamiseks valige Tühista (Cancel). 
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Vaatur

1. Valige menüüribal Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit).
2. Kasutage liugurit, et reguleerida faasikontrastsuspiltidel värvülekatte kiirust.

Värvülekatte eemaldamiseks seadke läbipaistmatus 0% peale.

Virtual Fellow®

JOONIS 2. Virtual Fellow® eelistused

1. Valige menüüribal Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit).
2. Valige Üldine (Global) vahekaart.

3. Valige märkeruut Ava uuring rakenduses Virtual Fellow® (Open study in Virtual Fellow®), et avada uuring otse 
rakenduses Virtual Fellow®. 

4. Valige Salvesta ja välju (Save and Exit).
Ilma salvestamata väljumiseks või muudatuste tühistamiseks valige Tühista (Cancel).

Aruannete lubatud kinnitajad

Rakendusel on aruannete kinnitamise funktsioon, mis lukustab lõpliku aruande. Kui aruanne on kinnitatud, ei saa seda 
enam muuta. Kinnitajaid saab lisada, muuta ja kustutada.

JOONIS 3. Aruannete lubatud kinnitajad
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Aruannete kinnitajate haldamine
1. Valige menüüribal Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit). 
2. Valige Üldine (Global) vahekaart ja pange kursor paanile Aruannete lubatud kinnitajad (Authorized Report 

Approvers). 
3. Kasutaja nime lisamiseks lubatud kinnitajate nimekirja valige Lisa (Add) vahekaart.

• Sisestage kasutaja nimi.
• Sisestage kaks korda parool.
• Valige Lisa (Add). 

4. Lubatud kinnitajate loendis oleva kasutaja parooli muutmiseks valige Muuda (Modify) vahekaart.
• Valige muutmiseks kasutaja.
• Sisestage vana parool.
• Sisestage kaks korda uus parool.
• Valige Rakenda (Apply).

5. Kasutaja kustutamiseks lubatud kinnitajate loendist valige Kustuta (Delete) vahekaart.
• Valige kustutatav(ad) kasutaja(d).
• Valige Kustuta (Delete).

6. Valige sobivad automaatse ekspordi sihtkohad (Auto Export Destinations).
Eksporditakse automaatselt koos uuringu kinnitamisega. 

7. Valige Salvesta ja välju (Save and Exit).
• Ilma salvestamata väljumiseks või muudatuste tühistamiseks valige Tühista (Cancel).

Üldine

JOONIS 4. Üldised eelistused

Üldiste eelistuste valikud
1. Valige menüüribal Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit).
2. Valige Üldine (Global) vahekaart.
Tarkvara suiteHEART® kasutusjuhend NS-03-043-0003-ET Red. 2 31



3. Märkuste joone paksuna nägemiseks valige märkeruut Paksu joonega märkus (Thick Line Annotation).
4. Valige märkeruut Ülekatte vältimiseks piira aktiivset ROI-d (Limit Active ROI for No Overlap). Kui see märkeruut on 

valitud, domineerivad valimata ROI-d, ja kui märkeruut on tühi, domineerib redigeeritav ROI.

5. Vabakäelise ROI automaatseks muutmiseks punktsplainiks valige märkeruut Automaatne vabakäe konverteerimine 
punktsplainiks (Automatic Free Hand to Point Spline Conversion).

6. Liidese tööriistavihjete nägemiseks valige märkeruut Kuva tööriistavihjed (Display Tooltips).

7. Aruandes patsiendi nime ja ID peitmiseks valige märkeruut Anonümiseeri patsient (Anonymize Patient).
Kõigi patsientide nimedena kuvatakse „anonymous“ ja ID on tühi. Neid muudatusi rakendatakse aruandele ja 
kujutisevaaturile.

8. Aruande eksportimiseks pärast kinnitamist DICOM-failina valige märkeruut Kinnitatud uuringu automaatne eksport 
(Automatically Export Approved Exam).

9. Valige märkeruut Mitme lõiguga kujutised aruandesse (Multi-Slice Image to Report), et lisada 
paremklõpsumenüüsse mitmekaadriliste lühikese telje kujutiste rühma lisamise suvand.

10. Kui märkmed on välja lülitatud ja soovite näha lõigu asukohta, valige märkeruut Näita alati lõigu asukohta (Always 
show slice location).

11. Seadistage Ulatuse (Scope) valik kujutise töötlemiseks faili rippmenüüst.

12. Seadistage Mõõtühikute süsteem (Measurement System) – valige rippmenüüst Tollmõõdustik (Imperial) või 
Meetermõõdustik (Metric).

13. Seadistage Lineaarse mõõtmise ühik (Linear Measurement Unit) kas cm või mm.

14. Seadistage rippmenüüst Monitori valik (Monitor Selection), kui kasutatakse kahte monitori.

15. Seadistage rippmenüüst Algse märkuse redigeerimise režiim (Initial Annotation Editing Mode). Valikus on valikud Ei 
ühtegi (None), Müksamise tööriist (Nudge Tool) või Tõmbamise tööriist (Pull Tool).

16. Seadistage rippmenüüs Kuupäeva ja kellaaja vorming (Date & Time Format).

Vool

JOONIS 5. Voolu eelistused

Voolu eelistuste valikud
1. Valige menüüribal Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit).
2. Valige Üldine (Global) vahekaart.

3. 2D ja 4D faasikontrastse automaatse faasivea korrigeerimiseks valige märkeruut Automaatne algtaseme 
korrigeerimine (Auto Baseline Correction).
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4. Valige märkeruut Regurgitatiivne režiim: automaatne (Regurgitant Mode): Automaatne (Auto), et arvutada 
automaatselt negatiivset netovoolu (allpool x-telge). 

5. Kasutaja muudetud ROI tagasiasetamiseks pärast levitamist valige märkeruut Asenda kasutaja muudetud ROI 
(Replace User Edited ROI).

6. Muutmise tööriistade nägemiseks otse kujutise vaateavas valige märkeruut Kuva redigeerimistööriistad (Display 
Tools for Editing).

7. Uute kategooriate määramiseks Voolule 1 (Flow 1) või Voolule 2 (Flow 2) sisestage uus silt. Neid silte kuvatakse voolu 
liideses kohtspikritena.

8. Valige rippmenüüst sobiv Voolu ühik (Flow Unit) – ml löögi kohta või l/min või mitte ühtegi.

9. Valige integreeritud voolu paanil arvutamise meetodi säilitamiseks Vaikemeetod (Default Method).
10. Kasutage Voolu värvi läbipaistmatuse (Flow Color Opacity) reguleerimiseks liugurit.

Värvülekatte eemaldamiseks seadke läbipaistmatus 0% peale.

11. Valige Salvesta ja välju (Save and Exit).
 Ilma salvestamata väljumiseks või muudatuste tühistamiseks valige Tühista (Cancel).

Jõudeoleku taimer 

Paan Jõudeoleku taimer (Idle Timer) seadistab minutites ajavahemiku, mil rakendus peale mittekasutamist sulgub. 

JOONIS 6. Jõudeoleku taimeri seadistused

Jõudeoleku taimeri valikud
1. Valige menüüribal Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit). 
2. Valige Üldine (Global) vahekaart ja pange kursor paanile Jõudeoleku taimer (Idle Timer). 
3. Taimeri funktsiooni lubamiseks valige märkeruut Jõudeoleku taimer (Idle Timer).

4. Lohistage jõudeoleku taimeri marker soovitud ajavahemikule minutites. 

5. Valiku salvestamiseks valige Salvesta ja välju (Save and Exit). 
Ilma salvestamata väljumiseks või muudatuste tühistamiseks valige Tühista (Cancel). 
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Funktsioon

JOONIS 7. Funktsiooni eelistused

1. Valige kujutisevaaturi menüüribal Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit).
2. Valige Üldine (Global) vahekaart.

3. Põhimiku interpolatsioonile automaatse rõnga lisamiseks valige märkeruut Automaatne MV rõnga lisamine 
(Automatic MV Annulus Insertion) ja Kaasa 4-kambriline MV rõngas (Include 4-Chamber MV Annulus) Valige 
märkeruut Automaatne TV rõnga lisamine (Automatic TV Annulus Insertion).

4. Telje vahetamiseks valige märkeruut Vaheta maatriksrežiimi jaoks omavahel teljed x(lõik) ja y(faas) (Flip x(slice) and 
y(phase) axis for matrix mode).

5. Mõlema kõvera kuvamiseks valige märkeruut Võimalda LV (Enable LV) või RV varju kõver (RV Shadow Curve).
6. Funktsiooni segmenteerimiseks valige märkeruut Säilita funktsiooni analüüsi tööriistad automaatselt (Persist 

analysis tools for Function Auto).
7. Redigeerimiseks valige redigeerimisrežiimis märkeruut Säilita endo/epi ROI (Persist Endo/Epi ROI). 
8. Valige märkeruut Lõikude vahel liikumise korrigeerimise (Motion Correction Between Slices), et pääseda ligi sellele 

funktsioonile südamefunktsiooni analüüsimisel; vt Liikumise korrigeerimine seeriate vahel lk 71. 

9. Valige Koja mahu silt: MaxV, MinV (Atrial Volume label: MaxV, MinV), et muuta mahusilte.

10. Seadistage alumine ja ülemine piir valikus Piirkonna analüüsi polaardiagrammid (Regional Analysis Polar Plots).
11. Valiku salvestamiseks valige Salvesta ja välju (Save and Exit). 

Ilma salvestamata väljumiseks või muudatuste tühistamiseks valige Tühista (Cancel). 
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Müokardi hindamine

JOONIS 8. Müokardi hindamise eelistused

1. Valige menüüribal Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit).
2. Valige Üldine (Global) vahekaart.

3. Mõõtetulemuste siltide määratlemiseks vt Mõõtetulemuste siltide määramine lk 115.

4. Valige Salvesta ja välju (Save and Exit).
Ilma salvestamata väljumiseks või muudatuste tühistamiseks valige Tühista (Cancel).

Seeria filter

Analüüsirežiimi tüüpide põhjal saab analüüsiks sobilike seeriate valimise kiirendamiseks rakendada seeria filtrit. Filtri 
eelistusi saab valida ka analüüsi ajal, klõpsates peamenüü pisipiltide vaate kohal filtri nupul. 

JOONIS 9. Filtri eelistused

Filtri eelistuste seadistamine
1. Valige menüüribal Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit).
2. Valige Üldine (Global) vahekaart.

3. Klõpsake igale analüüsitüübile sobiv sisse/välja valik.

4. Valige Salvesta ja välju (Save and Exit). 
• Ilma salvestamata väljumiseks või muudatuste tühistamiseks valige Tühista (Cancel). 
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MÄRKUS. Kui seeriale rakendatakse filtrit ja soovitud seeriat ei ole, ilmub tekst: „Valitud analüüsitüübiga seotud 
seeriaid ei ole“ (There are no series associated with the selected analysis type). Klõpsates OK filter 
tühistatakse ja kuvatakse kõik .uuringu seeriad.

Eksportimine (kujutis/video)

Ekspordi paan võimaldab valida kujutiste ja videode andmete eksportimisel kujutise formaadi. Eksportimise funktsioon 
võimaldab kujutiseandmetest luua tihendamata AVI videoid, tihendatud QuickTime videoid, GIF-, JPEG-, TIFF- ja PNG-faile.

JOONIS 10. Kujutise/video eksportimise eelistused

Ekspordi valikud 
1. Valige menüüribal Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit). 
2. Valige Üldine (Global) vahekaart ja pange kursor paanile Eksport (Export). 
3. Valige sobiv kujutise andmete tüüp. 

4. Valiku salvestamiseks valige Salvesta ja välju (Save and Exit). 
Väljumiseks ilma muutusi salvestamata või aktsepteerimata valige Tühista (Cancel). 
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Mallide vahekaart
Rakendus pakub tööriista, millega luua malle, mis põhinevad kasutaja määratletud normvahemikel, mis on määratud vanuse 
ja soo järgi. Z-skooride arvutamist ja aruandlust toetatakse kasutaja määratletud malli alusel. Vt soovitatud allikaid.

JOONIS 11. Mallide vahekaart

Kaalutlused

Enne analüüsi alustamise tuleb pealiidesest valida kasutaja määratud mall. Klõpsake paremal üleval olevat Vaikimisi 
(Default) nuppu ja valige soovitud mall. Malli muutmine pärast analüüsi tegemist rakendab mallis määratud 
normvahemiku ja/või Z-skoori.

JOONIS 12. Malli muutmine

MÄRKUS. Varasema suiteHEART-analüüsiga imporditud uuringud võivad näidata malli, mida kasutati selles uuringus. 
See mall ei pruugi olla muude uuringute jaoks saadaval.

Kui analüüsiks kasutatakse kahte süsteemi, on soovitatav luua esimeses süsteemis mallieelistuste fail ja seejärel importida 
teise süsteemi. Teisest süsteemist imporditud mallieelistuste failid kirjutavad mallieelistused üle, kui need on selles 
süsteemis juba loodud.

Malli loomine

HOIATUS! Normvahemike ja Z-skooride parameetrite jaoks sisestatud väärtuste sobivuse eest vastutab 
ainuisikuliselt kasutaja. Enne analüüsimist veenduge, et kõik sisestused on õiged. Valed väärtused 
võivad põhjustada valediagnoosi.

Kõik uued mallid luuakse algselt vaikemalli dubleerimise teel. Vaikemall ei ole muudetav. 

1. Valige Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit). 
2. Valige Malli (Template) vahekaart.

3. Klõpsake Loo uus (Create New) või malli dubleerimiseks klõpsake Dubleeri (Duplicate).
Vanus on vaikemäärang.
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JOONIS 13. Mallide valikute loomine

4. Sisestage mallile uus nimi. 
Uue nime sisestamisel lahtrisse The Current Template is uuendatakse rippmenüüd.

JOONIS 14. Mallide vahekaardi näide – näidatakse lühikese telje funktsiooni

1. Praegune mall, 2. Vanuse vahemiku riba, 3. Tulemuste parameetrid analüüsitüübi kohta, 4. Meeste Z-skoori BSA piirid, 5. Meeste alumised ja 
ülemised piirid, 6. Meeste Z-skoori parameetrid, 7. Naiste Z-skoori BSA piirid, 8. Naiste alumised ja ülemised piirid, 9. Naiste Z-skoori parameetrid

5. Valige soovitud rakenduse analüüsitüüp, millele mall luua.

6. Kui soovite kasutada vanusevahemikke, paremklõpsake vanusevahemiku ribal, et luua vanusevahemiku jaotur.
Vanusevahemiku jaotusribasid saab lohistada ja kohandada soovitud vanusevahemiku jaoks.
Saate luua mitu vanusevahemiku jaotusriba.
Vanusevahemiku jaotusribasid saab kustutada, asetades kursori riba lähedale ja valides paremklõpsumenüüst Kustuta 
vahemik (Delete Range).

7. Sisestage sobiva analüüsirežiimi normvahemiku väärtused ja nii alumine kui ka ülemine piir.

8. Vajadusel eristage meeste ja naiste väärtusi. Kasutage sugude vahel väärtuste kopeerimiseks nooli Kopeeri kõik (Copy 
all). Kasutage kerimisriba, et liikuda selle analüüsitüübi täieliku mõõtmiste loendi juurde.

9. Kui tuleb arvutada z-skoore, peab kasutaja sisestama väärtused a, b ja SD ning BSA piirid.

Aruandluse prioriteet on välja toodud allolevas tabelis. Olenevalt olukorrast kuvatakse mõõtetulemuste tabelites kas 
normvahemik või arvutatud z-skoor.

1

2

3

4
5 6

7
8 9
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HOIATUS! Normvahemike ja Z-skooride parameetrite jaoks sisestatud väärtuste sobivuse eest vastutab 
ainuisikuliselt kasutaja. Enne analüüsimist veenduge, et kõik sisestused on õiged. Valed väärtused 
võivad põhjustada valediagnoosi.

10. Kõikide sissekannete salvestamiseks valige Salvesta ja välju (Save and Exit).
- Ilma salvestamata väljumiseks või muudatuste tühistamiseks valige Tühista (Cancel).

MÄRKUS. Malli sobivuse tagamiseks tuleb parameetrite väärtused sisestada numbritena, sisestades nii ülemised kui 
ka alumised väärtused. Kui väärtustes leitakse ebakõlasid, kuvatakse järgmine teade „Valitud on sobimatu 
normvahemik (Invalid normal range selected). Parandage ja salvestage uuesti (Please correct and save 
again).” Parandust vajav parameeter tõstetakse esile punasega. Tühja malli salvestamine ei ole lubatud ja 
sel juhul kuvatakse teade „Malle ei saa salvestada“ (Unable to Save Template(s)).

MÄRKUS. Voolu vahekaardile sisestatud normvahemikud kehtivad nii 2D kui ka 4D voolu analüüsi tulemuste kohta.

Allikad
Buechel EV, Kaiser T, Jackson C, Schmitz A, Kellenberger CJ. Normal right- and left ventricular volumes and myocardial mass in children 
measured by steady state free precession cardiovascular magnetic resonance. J Cardiovasc Magn Reson. 2009 Jun 21;11(1):19. doi: 
10.1186/1532-429X-11-19. PMID: 19545393; PMCID: PMC2718870.
Kawel-Boehm N, Maceira A, Valsangiacomo-Buechel ER, Vogel-Claussen J, Turkbey EB, Williams R, Plein S, Tee M, Eng J, Bluemke DA. 
Normal values for cardiovascular magnetic resonance in adults and children. J Cardiovasc Magn Reson. 2015 Apr 18;17(1):29. doi: 
10.1186/s12968-015-0111-7. PMID: 25928314; PMCID: PMC4403942.
Maceira AM, Prasad SK, Khan M, Pennell DJ. Normalized left ventricular systolic and diastolic function by steady state free precession 
cardiovascular magnetic resonance. J Cardiovasc Magn Reson. 2006;8(3):417-26. doi: 10.1080/10976640600572889. PMID: 16755827.
Maceira AM, Prasad SK, Khan M, Pennell DJ. Reference right ventricular systolic and diastolic function normalized to age, gender and 
body surface area from steady-state free precession cardiovascular magnetic resonance. Eur Heart J. 2006 Dec;27(23):2879-88. doi: 
10.1093/eurheartj/ehl336. Epub 2006 Nov 6. PMID: 17088316.

Malli kustutamine
1. Valige Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit).
2. Valige Malli (Template) vahekaart.

3. Valige rippmenüüst Praegune mall on (The Current Template is) soovitud mall.

4. Klõpsake Kustuta (Delete).

Aruandest/arvutatud Tingimus

z-skoor; arvutatud Kui z-skoori parameetrid on sisestatud ja BSA on piirides.

Teatatakse normvahemik Kui z-skoor ja normvahemik on sisestatud ja BSA on väljaspool 
piire.

Teatatakse normvahemik Ainult siis, kui normvahemik on sisestatud.

Ei arvutata normvahemikku ega z-skoori Kui z-skoori parameetrid on sisestatud. Normvahemikku ei 
sisestatud ja BSA on piiridest väljas.

Ei arvutata normvahemikku ega z-skoori Sisestatud pole z-skoori parameetreid ega normvahemikku.
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Makro vahekaart
Saate luua kohandatud aruandemakrosid, mida saab automaatselt arvutatud väärtustega täita. Makrod on mallidest 
sõltumatud, kuna loodud makrod on kõigile kasutajatele kättesaadavad.

Makrosid saab luua aruande järgmiste jaotiste jaoks:
• anamnees
• mulje
• tehnika
• leiud

Muljete makro lisamine
MÄRKUS. Ajaloo või tehnika makro loomine käib samade sammude järgu, mis kuvamise makro loomisel.

1. Valige Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit).
2. Valige Makro (Macro) vahekaart.

3. Valige Lisa muljete makro (Add Impressions Macro). 
Makro paanile ilmub uus tekstiväli.

JOONIS 15. Muljete makrode aken

4. Pange kursor uuele tekstiväljale ja muutke nime vastavalt soovile.

MÄRKUS. Loodud makrosid saab ümber järjestada. Klõpsake soovitud makrol ja lohistage see loendis uude kohta.

Makro teksti sisestamine
1. Pange kursor makro teabe tekstikasti ja sisestage vastav tekst.

2. Parameetri tulemuse sisestamiseks valige mõni allpool olevatest analüüsi vahekaartidest ja valige soovitud 
parameetri nupp, mis sisestatakse automaatselt makro teabesse. Selles näites valiti parameeter LV väljutusfraktsioon 
(LV Ejection Fraction) ja sisestati see teksti lõppu.

JOONIS 16. Makro teave
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JOONIS 17. Makro parameetrite tulemuste valik 

3. Valige Salvesta ja välju (Save and Exit).
Ilma salvestamata väljumiseks või muudatuste tühistamiseks valige Tühista (Cancel).

Makro rakendamine

Makro rakendamise eeltingimusena tuleb analüüsi tulemused genereerida enne tulemuste parameetreid sisaldavate 
makrode rakendamist. Aruande loomise automatiseerimiseks saab luua tehnika- ja muljetemakrosid.

MÄRKUS. Kui makro sisaldab parameetri tulemust, mida on analüüsirežiimis muudetud, peab makro olema uuesti 
valitud, et kajastada uuendatud tulemust.

Makro kustutamine
1. Valige Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit).
2. Valige Makro (Macro) vahekaart.

3. Valige loendist makro. 

Näites on kustutamiseks valitud makro nimega Funktsioon (Function).

JOONIS 18. Makro valimise loend (Macro Selection List)

4. Valige Eemalda valitud makro(d) (Remove Selected Macro(s)).
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Printimise vahekaart
Iga analüüsirežiimi arvutatud tulemusi saab aruandes kaasamiseks ja järjestamiseks konfigureerida Prindi (Print) 
vahekaardil.

JOONIS 19. Printimise eelistused 

1. Valige menüüst Tööriistad (Tools) > Eelistused (Preferences) > Prindi (Print).
2. Valige sobiv analüüsi vahekaart ja valige soovitud tulemus, mida aruandesse lisada.

3. Aruandes loetletud tulemuste järjekorda saab muuta, klõpsates otse tulemusel ja lohistades selle loendis uude kohta. 

4. Tehke samamoodi igal analüüsirežiimi vahekaardil.

5. Valige Salvesta ja välju (Save and Exit).
Ilma salvestamata väljumiseks või muudatuste tühistamiseks valige Tühista (Cancel).

MÄRKUS. Kui printimise valikud tehakse otse rakenduse liideses, ei salvestata neid malliga.

MÄRKUS. Kui mõõtmiste järjekorda muudetakse otse liideses, siis muudatust malliga ei salvestata.

MÄRKUS. Funktsioonianalüüsis Muu (Other) all loodud kasutaja määratud mõõtmised kuvatakse Printimiseelistuste 
vahekaardil Muu (Other). Neid mõõte saab uuesti järjestada.
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Virtual Fellow® vahekaart

JOONIS 20. Virtual Fellow® eelistused

1.  Valige Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit).
2.  Valige Virtual Fellow® vahekaart.

3. Valige pikitelje vaadeteks Apikaalne suund (Apical Direction).

4. Valige müokardi hindamiseks kuvatavad kas Faasi (Phase) või Magnituudi (Magnitude) seeriad.

5. Valige müokardi perfusiooniks kuvatavad kas MOCO või NO MOCO seeriad. 

6. Valige Salvesta ja välju (Save and Exit).
Ilma salvestamata väljumiseks või muudatuste tühistamiseks valige Tühista (Cancel).
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T1/T2 kaardistamise vahekaart

JOONIS 21. T1/T2 kaardistamise eelistused

1. Valige menüüribal Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit).
2. Valige T1/T2 kaardistamise (T1/T2 Mapping) vahekaart.

3. Analüüsiks sobiva seeria loomiseks valige sobiv suvand jaotises Koosta analüüsiks automaatselt seeria (Auto 
Compose Series for Analysis).

4. Endo/Epi Nihe (Endo/Epi Offset) on seadistatud 1 ja -1, kus 1 võrdub .25 piksliga.

5. Valige Salvesta ja välju (Save and Exit).
Ilma salvestamata väljumiseks või muudatuste tühistamiseks valige Tühista (Cancel).

T1 kaardistamine
1. T1 kaardistamisel valige järjestuse tüübiks ajaseeriate analüüsimisel MOLLI või Saturatsiooni taastumine (Saturation 

Recovery).
2. Värvikaardi automaatseks kuvamiseks valige Ajaseeriate ülekate (Time Series Overlay) või Kaardi ülekate (Map 

Overlay).
3. Sisestage ICF, vt T1 kaardistamise analüüs lk 129.

4. Valige Välja tugevus (Field Strength) ja seadistage värvikaardi tüüp ning skaala väärtused kas 1.5T või 3T.

5. Valige Salvesta ja välju (Save and Exit).
Ilma salvestamata väljumiseks või muudatuste tühistamiseks valige Tühista (Cancel).
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T2 kaardistamine
1. Ajaseeriate analüüsiks valige sobiv Parameetri sobivuse (Parameter Fit) arvutamine.

2. Värvikaardi automaatseks kuvamiseks valige Ajaseeriate ülekate (Time Series Overlay) või Kaardi ülekate (Map 
Overlay).

3. Valige Välja tugevus (Field Strength) ja seadistage värvikaardi tüüp ning skaala väärtused kas 1.5T või 3T.

4. Valige Salvesta ja välju (Save and Exit).
Ilma salvestamata väljumiseks või muudatuste tühistamiseks valige Tühista (Cancel).

Aruandluse vahekaart
1. Valige menüüribal Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit).
2. Valige Aruandluse (Reporting) vahekaart.

3. Klõpsake vastaval väljal, et muuta menüü kirjelduste vaiketeksti, nagu näidatud Joonis 22.

4. Lisage parameetri tulemus koos tekstiga, valides õige analüüsi vahekaardi ja klõpsates soovitud parameetril, nagu 
näidatud Joonis 22. 

5. Parameetri tulemuse eemaldamiseks pange kursor sisestatud tulemuse järele ja vajutage kustutusklahvi.

JOONIS 22. Aruandluse eelistused

6. Vaiketeksti taastamiseks klõpsake .

Tekstiredaktori vaikeväljad

Analüüside vahekaart

Parameetri tulemuse valik 
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7. Menüü valikuga seotud parameetritulemuse aruannete kategooriate vahemike määramiseks klõpsake .

8. Valige seotud analüüsi vahekaardilt sobiv parameetri tulemus. 

9. Valige Absoluutne (Absolute) või Nihe (Offset) .

10. Sisestage kategooriate vahemikele sobivad väärtused. Aruande kategooria eemaldamiseks klõpsake värviribal, riba 
muutub halliks ja väärtus kaob. Joonis 23. 

JOONIS 23. Aruande kategooria eemaldamine

MÄRKUS. Kategooriate vahemike täitmine võimaldab aruande automaatset eeltäitmist. Tekst eeltäidetakse vastavalt 
kasutaja määratud väärtustele. Kui aruande tegemise ajal tehakse menüü liidesest valik, siis eeltäitmise 
funktsioon enam ei tööta.

MÄRKUS. Järgmiste parameetritulemuste eeltäidetud teksti jaoks on vaja, et kasutaja teeks vastava analüüsi: kodade 
mahud, hüpertroofia: maksimaalne seina paksus, T2*, klapi stenoos, klapi regurgitatsioon.

11. Aruande kategooriate vahemike lähestamiseks ja väärtuse valimiseks klõpsake .

Hüpertroofia kategooriate määramine

Hüpertroofia aruannet võib edasi määratleda kui kontsentrilist või ekstsentrilist. Kategooriate vahemike jaoks tuleb 
sisestada väärtused ja lisada meeste ning naiste kontsentrilisuse väärtused. Vt Joonis 24.

JOONIS 24. Hüpertroofia kategooria vahemikud ja kontsentrilisus 

Allikad
Petersen SE, Khanji MY, Plein S, Lancellotti P, Bucciarelli-Ducci C. European Association of Cardiovascular Imaging expert consensus 
paper: a comprehensive review of cardiovascular magnetic resonance normal values of cardiac chamber size and aortic root in adults 
and recommendations for grading severity. Eur Heart J Cardiovasc Imaging. 2019 Dec 1;20(12):1321-1331. doi: 10.1093/ehjci/jez232. 
Erratum in: Eur Heart J Cardiovasc Imaging. 2019 Dec 1;20(12):1331. PMID: 31544926.

Valik Kirjeldus

Absoluutne Vahemikud põhinevad soo absoluutväärtustel olenemata 
vanusest. 

Nihe Vahemikud põhinevad sellel, kui suur on nihe mallis määratud 
normvahemikust vastava vanuse korral.
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Kontsentrilisuse allikad 
Khouri MG, Peshock RM, Ayers CR, de Lemos JA, Drazner MH. A 4-tiered classification of left ventricular hypertrophy based on left 
ventricular geometry: the Dallas heart study. Circ Cardiovasc Imaging. 2010 Mar;3(2):164-71. doi: 10.1161/CIRCIMAGING.109.883652. 
Epub 2010 Jan 8. PMID: 20061518.

Impordi eelistused
1. Valige Tööriistad (Tools) > Eelistused (Preferences) > Impordi (Import).

JOONIS 25. Impordi eelistused

2. Valige Sirvija (Browse) nupp, valige eelistuste faili asukoht ja valige seejärel nupp Ava (Open).

3. Vaatamisprotokollide importimiseks valige nupp Ainult vaatamisprotokollid (Only Viewing Protocols).
4. Määratud impordi tegemiseks valige OK.

 Väljumiseks ilma importimata valige Tühista (Cancel).
MÄRKUS. Eelistuste importimist tarkvara suiteHEART® varasematest versioonidest (4.0.4 või vanemad) ei toetata. Abi 

saamiseks eelmiste versioonide eelistuste importimisel võtke ühendust NeoSofti toega aadressil 
service@neosoftmedical.com.

Eksportimise eelistused
1. Valige Tööriistad (Tools) > Eelistused (Preferences) > Ekspordi (Export).

JOONIS 26. Eksportimise eelistused

2. Valige Sirvija (Browse), valige kaust, kuhu eelistuste fail salvestada ja valige Salvesta (Save).
3. Valige OK.

 Ilma eksportimata väljumiseks valige Tühista (Cancel).
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Virtual Fellow®

Virtual Fellow® on kujutiste vaatamise standardiseeritud funktsioon südame MR-uuringute jaoks. Funktsioon parandab 
vaatamise töövoogu lihtsustades nii arstidel südame MR-uuringute ülevaatamist. Funktsioon rakendub automaatselt 
kujutise töötlemise tööriistadele nagu akna tasand, suumimine, panoraam ja roteerimine. Praegusi ja varasemaid südame 
MR-uuringuid saab lihtsasti funktsiooniga Virtual Fellow® üle vaadata.

MÄRKUS. Funktsiooni Virtual Fellow® kasutamist koos eeltöötlusega vt suiteDXT kasutusjuhendist.

MÄRKUS. Patsiendi ID peab olema sama nii praegusel kui ka varasemal uuringul, et seda saaks rakenduses Virtual 
Fellow® vaadata. 

MÄRKUS. Funktsiooni Virtual Fellow® kasutamisel ei saa analüüsitulemusi redigeerida, selleks valige sobiv 
redigeerimisrežiim. 

HOIATUS! Kasutaja vastutab Virtual Fellow® loodud vaatamisprotokollide õige pildivaliku kinnitamise eest. 
Praeguste/varasemate vaatamisprotokollide jaoks valesti tuvastatud pilte saab valida käsitsi. 
Kasutaja peab olema saanud korraliku koolituse südame piltdiagnostika tehnikate alal, et tagada, 
et üle vaadatakse sobivad kujutised. Kõigi uuringu jaoks saadud kujutiste ülevaatamiseks kasutage 
Vaaturi (Viewer) režiimi, mida selgitab jaotis Kujutisehalduse tööriistad lk 21.

HOIATUS! Enne uuringute ülevaatamist või võrdlemist veenduge visuaalselt liidese ülaosas, et uuringu 
patsiendi kogu indikaatoriteave on sama. #1 tähistab praegust uuringut, #2 tähistab varasemat 
uuringut.

HOIATUS! Virtual Fellow® teostatavad kujutise manipulatsioonid, nagu WW/WL, panoraam, suumimine, 
roteerimine ja ümberpööramine, võivad mõjutada erinevate patoloogiate ilmnemist ja teiste 
anatoomiliste struktuuride eristamist. Vaadake üle iga vaatamisprotokoll ja tehke vastavad 
kohandused.
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Virtual Fellow® abil töötlemine

Seeriate tuvastamine

Automaatne

(identifitseeritud seeriate)

Automaatne klapirõnga
tuvastamine (kui on lubatud)

Virtual Fellow® – vaaturi
optimeerimine (kui on lubatud)

Valmis

segmenteerimine
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Virtual Fellow® liides

Virtual Fellow® valikud

Valik Kirjeldus

Virtual Fellow®

Kuvatakse funktsiooni tulemused

Kuvatakse voolu tulemused

Kuvatakse müokardi hindamise tulemused

Pikitelge ristlõigete ja 
tulemuste vaade

Põhivaatur

Kujutisevaaturi 

Vaatamisprotokollid
Tarkvara suiteHEART® kasutusjuhend NS-03-043-0003-ET Red. 2             50



Ühendamise lüliti, mida kasutatakse nii 
praegustel kui varasematel seeriatel WW/WL-i 
muutmiseks, panoraamimiseks, roteerimiseks ja 
ümberpööramiseks.

Lahtiühendamise lüliti, mida kasutatakse ühe 
seeria WW/WL-i muutmiseks, panoraamimiseks, 
roteerimiseks ja ümberpööramiseks.
Märkus. Suumi rakendatakse alati nii 
praegustele kui ka varasematele seeriatele.

Faasi kasutatakse faasitundliku hilisema 
täiustamisega kujutiste vaatamiseks.

Magnituudi kasutatakse magnituudi hilise 
täiustamise vaatamiseks.

MOCO-t kasutatakse müokardi perfusiooni 
seeria vaatamiseks liikumise 
korrigeerimisega.

NO MOCO-t kasutatakse müokardi 
perfusiooni seeria vaatamiseks ilma liikumise 
korrigeerimiseta.

#1 on praeguse uuringu jaoks kuvatavate 
seeriate indikaator. Seeria muutmiseks tehke 
vasakklõps otse #1 peal. 

#2 on eelnevate uuringuseeriate jaoks 
kuvatud seeriate indikaator. Seeria 
muutmiseks tehke vasakklõps otse #2 peal.

Video juhtnuppe kasutatakse video 
taasesitamiseks, peatamiseks, kaadrite arvu 
valimiseks sekundis ning videofilmi algus- ja 
lõpukaadri määramiseks.

Ristlõike tööriist, mis tuvastab automaatselt ja 
kuvab kujutised, mis sisaldavad sama 
asukohta. Selle funktsiooni kasutamiseks vt 
Leia tunnus* lk 22.

Mõõtetööriistu saab kasutada põhivaaturis ja 
pikitelje vaadetel.

Valik Kirjeldus
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Vaatamisprotokollid

Võta tagasi üldised mõõtmiste muudatused.

Vaateava paigutuse suvandid*: 1x1, 1x2, 4x4 ja 
5x4.
*Sõltub valitud protokollist.

Ulatusel on sama funktsioon, nagu kirjeldatud 
jaotises Kujutise töötlemise tööriistad lk 12.

Vasaknooleklahv Kasutatakse praeguses/varasemas 
vaatamisprotokollis lõigu asukoha edasi 
liigutamiseks.

Paremnooleklahv Kasutatakse praeguses/varasemas 
vaatamisprotokollis lõigu asukoha 
ümberpööramiseks.

Seeria tüüp

Lühikese telje videofunktsiooniga seeria.

Praegune lühikese telje videofunktsiooniga seeria koos 
varasemaga.

Müokardi hindamine.

Praegune müokardi hindamine varasemaga.

Lühikese telje videofunktsiooniga koos müokardi 
hindamisega.

Müokardi perfusiooni seeria Stress.

Valik Kirjeldus
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Kiirklahvid – pikitelje vaateavad

Praegune müokardi perfusiooni seeria Stress koos 
varasemaga.

Praegune müokardi perfusiooni seeria Stress koos müokardi 
hindamisega.

Müokardi perfusiooni stressi/puhkuse seeria.

T1 aksiaalne seeria.

SSFP T1 koos aksiaalse seeriaga.

Funktsioon Tegevus

Lõigu navigeerimine edasi. Z

Lõigu navigeerimine tagasi. A

Lõigu navigeerimine. Keskmine hiireratas

Seeria tüüp
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Kasutaja tehtud seeriate valik vaatamisprotokollide jaoks
Vaatamisprotokollid on konfigureeritud praeguse uuringu või praeguse ja varasema uuringu kujutiste vaatamiseks. Kui 
kuvatavad kujutised ei ole need, mida sooviti üle vaadata, valige sobiv seeria uuesti, tehes vasakklõpsu otse 
numbermärgise kohal (#1 näitab praegust uuringut, #2 varasemat uuringut) Virtual Fellow® liideses, nagu näidatud Joonis 
1. Kuvatakse praeguse uuringu (#1) seeriate loend, valige sealt õige seeria. 

JOONIS 1. Virtual Fellow® liides
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Kasutaja tehtud seeriate valik pikitelje ristlõigete vaateavades
Kui kuvatavad kujutised ei ole need, mida oodati, saab sobiva seeria valida klõpsates otse pikitelje vaateavas ja valides 
seejärel kujutise faili rippmenüüst, nagu on näidatud alloleval joonisel.

MÄRKUS. Kui kasutatakse klaviatuurivalikuid Z või A, ei ole kasutaja valitud kujutis enam vaateavas.

MÄRKUS. Soovitud apikaalse suuna määramiseks valige kujutisevaaturi menüüribal Tööriistad (Tools) > Eelistused 
(Preferences) > Redigeeri (Edit) ja vahekaart Virtual Fellow®.
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Automaatne värskendamine
Automaatse värskendamise funktsioon võimaldab käivitada uuringu selle taustal töötlemisega. Kui kujutisi tuuakse võrgu 
kaudu, kui uuring on juba käivitatud, rakendatakse analüüsi (ja kui on konfigureeritud, siis ka funktsiooni Virtual Fellow®) 
taustal, kui kehtivad seeriatüübid on algoritmiga määratud. Toetatud analüüsirežiimid on järgmised.

• Funktsioon 
• vool
• müokardi hindamine (ainult lühikese telje hilisem täiustamine)
• T1 kaardistamine
• T2 kaardistamine 

Automaatse uuendamise konfigureerimiseks vaadake suiteDXT kasutusjuhendit. 

HOIATUS! Pärast eeltöötlust vastutab kasutaja kogu analüüsi täpsuse hindamise ja vajalike paranduste 
tegemise eest.

Töövoog
1. Kui uuringut tuuakse võrgu kaudu või uuring on pooleli ja võrgu kaudu toomisel ja DXT-loendis on helesinine 

indikaatorrõngas (nagu Joonis 1), võib uuringu käivitada.

MÄRKUS. Kui enne automaatset värskendamist tehakse analüüs käsitsi, tulemusi üle ei kirjutata.

MÄRKUS. Kui uuring on suletud, näitab roheline ring, et töötlemine on lõppenud.

JOONIS 1. DXT uuringute loend
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2. Kui uuring avaneb, ilmub Joonis 2 näidatud sõnum. 

JOONIS 2. Uuringu käivitamine

3. Kui seerial tehtud analüüs on lõpetatud, muutub Värskenda (Refresh) indikaator kollaseks, nagu on näidatud Joonis 
3. Klõpsake, et analüüsirežiimi värskendada. 

Olenevalt analüüsitud seeriatüüpide arvust võib olla vajalik vajutada Värskenda (Refresh) nupule mitu korda.

JOONIS 3. Värskenda (Refresh) indikaator 

4. Kui uuring on suletud, ilmub Joonis 4 näidatud sõnum. 

MÄRKUS. Kui peale uuringu sulgemist tuuakse võrgu kaudu seeriatüüpe juurde, võib töötlemine toimuda.

JOONIS 4. Uuringu sulgemine 
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Kontuuride redigeerimine

Kontuuride redigeerimine, mida kirjeldatakse selles jaotises, on võimalik kõigis analüüsirežiimides. See funktsioon on 
olemas nii Redaktori (Editor) aknas kui ja Ülevaatamise (Review) aknas.

ROI punktsplain
1. Tehke Redaktori (Editor) aknas kontuuril vasakklõps. Valimisel muutub kontuur lillaks.

2. Kontuuri liigutamiseks tehke vasakklõps kontuuri keskosal ja lohistage seda, nagu näidatud joonisel Joonis 1.
• Kui valitud kontuur loodi punktsplaini meetodil, kuvatakse redigeerimiseks punktid. Kontuuri suuruse ja kuju muutmiseks 

tehke vasakklõps mis tahes punktil ja lohistage seda, nagu näidatud joonisel Joonis 1.
• Kui valitud kontuur loodi vabakäe joone tööriista abil, tehke vasakklõps ja redigeerige kontuuri vabakäeliselt.

Lisafunktsioonid
• Alt+ vasakklõps loob nurgapunkti.
• Esimesel punktil klõpsamine sulgeb kontuuri.
• Kontuuril klõpsamine loob punkti otse.
• Kustutusklahv + kursor punktil eemaldab punkti.
• Punkti lohistamine naaberpunkti lähedale eemaldab naaberpunkti.
• Kui punktide arv jääb alla 3, siis ROI kustutatakse.

JOONIS 1. Tavapärane kontuuri redigeerimine
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Müksamise tööriist
1. Müksamise tööriista aktiveerimiseks tehke kontuuri valimiseks sellel vasaklõps. Seejärel tehke paremklõps ja valige 

hüpikmenüüst müksamise tööriist, nagu näidatud Joonis 2.
• Kui rakendatakse müksamise tööriista, muutub valitud punktsplaini ROI automaatselt vabakäe ROI-ks.

JOONIS 2. Müksamise tööriista aktiveerimine

2. Kursor kuvatakse ruuduna. Pange kursor ROI-st eemale ning vajutage ja hoidke all vasakut hiireklahvi. Ilmub 
müksamise tööriist, nagu näidatud Joonis 3.

MÄRKUS. Müksamisringi suuruseks on vaikimisi suurus, mis võrdub kaugusega kursorist valitud ROI-ni. Suuruse 
muutmiseks pange kursor teise kohta.

JOONIS 3. Müksamise tööriist
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3. Müksamise tööriista deaktiveerimiseks tehke kontuuril vasakklõps, seejärel paremklõps ja valige rippmenüüst 
müksamise tööriist, nagu näidatud Joonis 4.

JOONIS 4. Müksamise tööriista deaktiveerimine

MÄRKUS. Müksamise tööriista vaikimisi sees/väljas oleku saab seadistada Eelistustest (Preferences).

Kontuuri tõmbamise tööriist
1. Tõmbamise tööriista aktiveerimiseks tehke kontuuril selle valimiseks vasakklõps. Seejärel tehke paremklõps ja valige 

hüpikmenüüst tõmbamise tööriist, nagu on näidatud joonisel 5. See võimaldab kontuuri segmenti kohandada, 
lohistades kontuuri osi väikeste kohanduste tegemiseks.

JOONIS 5. Tõmbamise tööriista aktiveerimine
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2. Tehke vasakklõps otse redigeeritava kontuuri segmendil. Musta katkendliku segmendi pikkust saab muuta keskmise 
hiirerattaga. Hiirekursori kaugus mustast katkendjoonest juhib kontuuri vastava segmendi redigeerimist.

JOONIS 6. Tõmbamise tööriist

3. Tõmbamise tööriista deaktiveerimiseks tehke kontuuril vasakklõps, seejärel paremklõps ja valige rippmenüüst 
tõmbamise tööriist, nagu näidatud joonisel 7.

JOONIS 7. Tõmbamise tööriista deaktiveerimine
Tarkvara suiteHEART® kasutusjuhend NS-03-043-0003-ET Red. 2 61



Kontuuri kustutamine
1. Kontuuri valimiseks tehke sellel vasakklõps ja vajutage klaviatuuril kustutusklahvi.

või

2. Tehke kontuuri valimiseks sellel vasakklõps, seejärel paremklõps ja valige  ühe kontuuri kustutamiseks või 

 kõikide faaside või kõikide ajapunktide kontuuride kustutamiseks, nagu näidatud joonisel 8.

JOONIS 8. Kontuuri kustutamine

MÄRKUS. Punktsplaini funktsioon kehtib kõikide analüüside puhul, välja arvatud 3D/4D voolu vaatur. 

Järgmised kopeerimise/kleepimise ja muutmise funktsioonid on saadaval kõigis analüüsirežiimides, välja arvatud PFO-
analüüsis.

• Ctrl + C = ROI kopeerimine
• Ctrl + V = ROI kleepimine
• Ctrl + S = ROI silumine

Täiendav redigeerimistööriist (ainult funktsiooni analüüsis)
Redaktori vaateavas kuvatakse valikuid kolme redigeerimisrežiimi vahel lülitamiseks. 

Tööriist Kirjeldus
Piiranguga 
ROI

Piiranguta 
ROI

Ülekate
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Funktsiooni analüüs
Kasutaja vastutab kõikide huvipakkuvate piirkondade (ROI-de) täpse ja täieliku paigutamise (ja õige määratlemise) 
eest, kaasa arvatud nende eest, mille on genereerinud või mida on muutnud automaatse segmenteerimise algoritm. 
Kvantitatiivsed väärtused, mille on genereerinud tarkvara, sõltuvad sellest, kui täpselt ja täielikult on huvipakkuvad 
piirkonnad paigutatud (ja õigesti määratletud).

Uuringu eeltöötluse funktsioon võimaldab funktsiooni analüüsi eeltöödelda. Vt suiteDXT kasutusjuhendit.

Selles jaotises kirjeldatakse südamefunktsiooni analüüsi tüüpilisi samme. Näidistöövood annavad ülevaate sammudest, 
mida rakenduses südamefunktsiooni analüüsi tegemiseks kasutatakse. Toimingud kirjeldavad, kuidas teha kvantitatiivset 
analüüsi.

TÄHTIS! Soovitatav on omada südameanalüüsi tegemise kvalifikatsiooni, kui analüüsitulemusi kasutatakse 
diagnoosi panemiseks.

HOIATUS! Pärast eeltöötlust vastutab kasutaja kogu analüüsi täpsuse hindamise ja vajalike paranduste 
tegemise eest. Põhjalik ülevaade peaks sisaldama järgmist.
- ROI paigutamine/tuvastamine
- ED/ES-i määramine
- MV/TV rõngaste paigutus
- RV sisestamise koht

HOIATUS! Rakendus ainult aitab kujutisi analüüsida ja ei anna automaatselt tulemuste kliinilist tõlgendust. 
Kvantitatiivsete mõõtmiste kasutamine ja paigutus on kasutaja äranägemisel. Kui mõõtmised on 
ebatäpsed, võib see tuua kaasa vale diagnoosi. Mõõtmised peaks tegema ainult nõuetekohaselt 
koolitatud ja kvalifitseeritud kasutaja.

HOIATUS! Vale skannimistasapind võib põhjustada ebatäpseid analüüsitulemusi. Vt Lisa B.
MÄRKUS. Retrospektiivsed 2D seeriad, mis on loodud 4D voolu põhjal, võivad vajada käsitsi segmenteerimist.

Valige . Analüüsil on kolm kategooriat.

 - Sisaldab vasaku vatsakese (LV) ja parema vatsakese (RV) mahu analüüsi.

 - Sisaldab vasaku koja (LA) ja parema koja (RA) mahu analüüsi.

 - Sisaldab eelmääratletud lineaarseid mõõtmisi ja lisada saab muid kasutaja määratud mõõtmisi.
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 Vatsakesed
Valige analüüsi tüüp.

 Kontuuride kustutamiseks klõpsake .

MÄRKUS. Kontuuride kustutamiseks võib kasutada maatriksrežiimi.

Indeksmõõtude arvutamine

1. Klõpsake .

2. Sisestage patsiendi Pikkus (Height) ja Kaal (Weight).
Lõppdiastoolse mahu indeksi, lõppsüstoolse mahu indeksi, lõppdiastoolse massi indeksi, lõppsüstoolse massi 
indeksi, faasi massi indeksi, südame minutimahu indeksi ja südamelöögi mahu indeksi mõõtetulemused 
arvutatakse Mõõtmiste (Measurement) tabelis.

MÄRKUS. Keha pindala (BSA) arvutusmeetodi saab valida Aruandluse (Reporting) liideses.

Automaatne LV ja RV segmenteerimine
Automaatse segmenteerimise funktsioon arvutab südamefunktsiooni standardparameetrid ilma anatoomilise sisendita. 
Pärast segmenteerimise tulemuste genereerimist saab valida, milliseid ROI tüüpe vaatamisel kuvada. Kasutaja sisestuste 
abil saab ka segmente redigeerida. 

MÄRKUS. Kui nii LV kui ka RV nupud on funktsiooni lühikese telje jaoks valimata või pikitelje kambri valimise nupp on 
valimata, ei saa kasutada nuppu Alusta automaatset laiendamist (Start Auto Propagation).

LV ja RV segmenteerimise alustamiseks tehke järgmist. 

1. Valige lühikese telje seeria ja kohandage akent/tasandit.

2. Klõpsake .

3. Automaatseks segmenteerimiseks klõpsake .

4. Tehke segmenteerimise menüüribal vajalikud valikud nagu näidatud Joonis 1.

5. Automaatse segmenteerimise alustamiseks valige .

Lühike telg Pikitelg
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JOONIS 1. Segmenteerimise tööriistariba

*Laiendamise funktsioonid vahetatakse välja, kui märgitakse eelistus x-telje (lõik) ja y-telje (faas) jaoks maatriksrežiimis.

Tabel 1:  Automaatse segmenteerimise kontuuride tüübid

Papillaar-
lihastega režiim 
– kaasab 
vatsakeste 
mahtu papillaar-
lihased. 

Papillaar-
lihasteta režiim – 
välistab 
vatsakeste 
mahust papillaar-
lihased. 

Papillaar-
lihastete LV, 
papillaar-
lihastega RV.

Papillaar-
lihastega LV, 
papillaar-
lihasteta RV

Näitab 
endokardi ja 
epikardi 
kontuure. 

Näitab 
endokardi 
kontuure.

Näitab 
kõõluskee-
likut.

Tabel 2:  Automaatse segmenteerimise laiendamise* tüübid

Laienda kõikidele lõikudele 
kõikides faasides või kuva kõik 
lõigud kõikides faasides

Levita kõikidele lõikudele, 
üks faas.

Laienda kõikidele 
faasidele; üks lõik

Laienda, näidates ainult 
ED/ES faaside kontuure

Tabel 3:  Vatsakese valik

Parem vatsake – genereerib segmenteerimise või kuvab. Vasak vatsake – genereerib segmenteerimise või kuvab. 
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Automaatne segmenteerimine kõikidel lõikudel ja faasidel

See valik on vajalik piirkondliku analüüsi, mittesünkroonsuse ja klapitasandi analüüsi tulemuste jaoks. 

1. Valige lühikese telje seeria ja kohandage akent/tasandit.

2. Klõpsake .

3. Automaatseks segmenteerimiseks klõpsake .

4. Valige segmenteerimise menüüribalt kas papillaarlihastega  või papillaarlihasteta režiim .

5. Müokardi massi tulemuste genereerimiseks valige .

6. Kõikide faaside ja lõikude jaoks klõpsake .

7. Klõpsake  või  või mõlemad.

MÄRKUS. Optimaalse RV segmenteerimise jaoks valige mõlemad, nii epikardiaalsed kui ka endokardiaalsed 
kontuurid.

8. Automaatse segmenteerimise alustamiseks valige .

MÄRKUS. Automaatse laiendamise alustamise nupp ei tööta, kui ei ole valitud ei LV ega RV.

Segmenteerimise täpsuse ja redigeerimise ülevaatamine
1. Vaadake lühikese telje seeriat videorežiimis ja kontrollige kontuuride täpsust.

2. Redigeerige kõiki ebatäpseid kontuure.

MÄRKUS. Papillaarlihastega režiimi puhul on kontuuride redigeerimine toetatud. Redigeerige kontuuri ja valige 
automaatse segmenteerimise alustamine.

ED või ES uuesti määramiseks klõpsake nuppu ED või ES ja valige maatriksi lahtri vasak või parem pool. Vt Maatriksvaade lk 73.

MÄRKUS. ED ja ES-i faaside määramised määratakse segmenteerimisega. Suurimale arvutatud mahule omistatakse 
ED ja väikseimale arvutatud mahule ES.

3. Vaadake igal lõigul üle madalama RV sisestuspunkti asukoht. Vajadusel kohandage seda iga lõigu jaoks.

4. Vaadake üle maatriksrežiim ja veenduge ED ja ES-i määrangutes.
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Automaatne segmenteerimine kõikidel lõikudel ühes faasis
1. Valige lühikese telje seeria ja kohandage akent/tasandit.

2. Klõpsake .

3. Klõpsake .

4. Valige segmenteerimise menüüribalt kas papillaarlihastega  või papillaarlihasteta režiim .

5. Müokardi massi tulemuste genereerimiseks valige .

6. Vaadake üle lühikese telje kujutised ja valige lõppdiastoolne faas.

7. Valige  või  või mõlemad. 

8. Valige kõikide lõikude jaoks ühes faasis .

9. Automaatse segmenteerimise alustamiseks valige .

10. Vaadake üle lühikese telje kujutised ja valige lõppsüstoolne faas.

11. Automaatse segmenteerimise alustamiseks valige . 

MÄRKUS. Automaatse laiendamise alustamise nupp ei tööta, kui ei ole valitud ei LV ega RV.

Segmenteerimise täpsuse/redigeerimise ülevaatamine
1. Vaadake lühikese telje seeriat videorežiimis ja kontrollige kontuuride täpsust.

2. Redigeerige kõiki ebatäpseid kontuure.

3. Vaadake üle maatriksrežiim ja veenduge ED ja ES-i määrangutes.

4. Vaadake mõõtmiste tabelis üle kõik tulemused.
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LV ja RV funktsiooni käsitsi analüüsimise protseduur
MÄRKUS. Soovitatav on kasutada lõppdiastoolset ja lõppsüstoolset faasi. Töötlemist peaks algustama lõppdiastoolse 

faasiga. Analüüsi töövoog viiakse tavaliselt läbi põhimikust tipuni.

1. Valige .

2. Valige kujutisevaaturist sobiv lühikese telje seeria. 

3. Klõpsake .

4. Mahu mõõtmiseks klõpsake nupul .

5. Lokaliseerige lõppdiastoolne faas.

Endokardi määramine

1. Valige LV jaoks  või RV jaoks . 

2. Joonistage endokardi kontuur.

3. Liikuge järgmise lõigu juurde , kasutades vasakule või paremale nooleklahvi, hiire kerimisratast või valige 
pisipilt.

4. Korrake samme 2 ja 3, kuni kogu vasak ja/või parem vatsake on segmenteeritud.

Endokardi kontuuri tööriist jääb mitme lõigu segmenteerimise kiirendamiseks valituks.

5. Leidke lõppsüstoolne faas.

6. Korrake samme 2 ja 3 lõppsüstoolses faasis, kuni kogu vasak ja/või parem vatsake on segmenteeritud.

MÄRKUS. Tarkvara määratleb automaatselt suurima mahuga faasi lõppdiastoolse faasina ja väikseima mahuga faasi 
lõppsüstoolse faasina. Lõppdiastoolse ja lõppsüstoolse faasi määratlusi uuendatakse segmenteerimise 
käigus.

Segmenteerimise täpsuse ja redigeerimise ülevaatamine
1. Vaadake lühikese telje seeriat videorežiimis ja kontrollige kontuuride täpsust.

2. Redigeerige kõiki ebatäpseid kontuure.

3. Vaadake üle maatriksrežiim ja veenduge ED ja ES-i määrangutes.

4. Vaadake mõõtmiste tabelis üle kõik tulemused.
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LV ja RV müokardi massi käsitsi määramise protseduur
1. Valige sobiv südametöö faas.

2. Valige LV epikardi jaoks  või RV epikardi jaoks . 

3. Joonistage epikardi kontuur.

4. Liikuge järgmise lõigu juurde, kasutades  või <-- ja --> või valige pisipilt.

5. Korrake samme 3 ja 4 kuni kogu vasaku ja/või parema vatsakese epikard on segmenteeritud.
Massitulemusi uuendatakse automaatselt, kui epikardi kontuurid on määratletud.

Segmenteerimise täpsuse/redigeerimise ülevaatamine
1. Vaadake lühikese telje seeriat videorežiimis ja kontrollige kontuuride täpsust.

2. Redigeerige kõiki ebatäpseid kontuure.

3. Vaadake üle maatriksrežiim ja veenduge ED ja ES-i määrangutes.

4. Vaadake mõõtmiste tabelis üle kõik tulemused.

Põhimiku interpoleerimine
Põhimiku lõikude interpoleerimiseks tuvastage pikitelje vaates, kas mitraal- või trikuspidaalklapi rõngas.

MÄRKUS. Interpolatsiooni funktsioon on välja lülitatud, välja arvatud juhul, kui eelistustes on seadistatud klapi rõnga 
automaatne sisestamine LV ja RV jaoks. Valige Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri 
(Edit). Valige jaotises Funktsioon (Function) märkeruut Automaatne MV või TV rõnga sisestamine 
(Automatic MV or TV Annulus Insertion).

1. LV põhimiku interpoleerimise jaoks valige ristlõigete režiimis 2-kambriline vaade.

2. Valige .

3. Määrake MV rõngas nagu Joonis 2. Vaadake üle joone paigutus sobivas lõppsüstoolses ja lõppdiastoolses faasis, 
kasutades video juhtnuppe.

MÄRKUS. Toetatakse mitmetasandilist põhimiku interpoleerimist. Näiteks MV rõngast saab tuvastada 2-kambrilisel ja 
4-kambrilisel vaatel; sobitamine tehakse kahe tasapinna vahel. Automaatseks paigutamiseks valige 
Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit). Valige märkeruudud Automaatne MV 
rõnga sisestamine (Automatic MV Annulus Insertion) ja Kaasa 4-kambriline MV rõngas (Include 4-chamber 
MV Annulus). 

MÄRKUS. MV või TV rõnga asukohaga seeria lokaliseerimiseks klõpsake  või , mis asuvad vaateavas all 
vasakul. 
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JOONIS 2. MV rõngas

4. Vaadake uuendatud arvutus üle, vaadates üle reaga seotud ristlõiked. 

Nagu näha Joonis 3, põhineb interpoleeritud mahu arvutamine joone ja lõigu (roosa joon) ristumiskoha suhtel, see maht 
on nüüd kaasatud mahu tulemustesse. Tegelikku huvipakkuvat piirkonda ei kuvata. Kujutise vasakus nurgas näidatakse 
interpoleeritud lõikudel mahu hulka koos interpolatsiooni protsendiga, nagu näidatud Joonis 3.

JOONIS 3. Mahu arvutamine

5. RV põhimiku interpoleerimise jaoks valige ristlõigete režiimis 4-kambriline vaade.

6. Valige .

7. Määrake TV rõngas nagu Joonis 4. Vaadake sobivas lõppsüstoolses ja lõppdiastoolses faasis üle joone asukoht 
kasutades video juhtnuppe.
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JOONIS 4. TV rõngas

8. Vaadake uuendatud arvutused üle, vaadates üle ristlõikude lõigud, mis on seotud joonega ja maatriksvaates ED ja ES-
i määratlused.

9. Tulemuse algväärtuse taastamiseks tehke paremklõps ja hoidke kustutamiseks otse real või tehke real vasakklõps ja 
kasutage klaviatuuri kustutusklahvi. 

Täpsuse üle vaatamine
1. Vaadake pikitelje seeriat videorežiimis ja kontrollige kontuuri asukohta.

2. Kohandage vajadusel joone asukohta.

3. Kui kasutatakse automaatset sisestamist, kontrollige, et valitud on õige seeria ja et joone asukoht on õige. Kui asukoht 
ei ole õige, tehke joonel paremklõps ja kustutage see.

Liikumise korrigeerimine seeriate vahel
Liikumise korrigeerimine seeriate vahel kompenseerib südame kulgliikumise e. translatsiooni, mis võib tekkida pikitelje ja 
lühikese telje kujutiste saamise vahel. Kambrite mahtudes võivad tekkida vead, kui klapirõngaste tasapinnad saadakse 
pikitelje kujutistest, mis ei registreeru ruumiliselt lühikese telje kujutistega, mis sisaldavad mahuanalüüsiks kasutatavaid 
endokardi kontuure. Viga võib ilmneda juhul, kui lühikese ja pikitelje kujutised saadakse hingamistsükli erinevates 
etappides või kui patsient muudab piki- ja lühikese telje kujutise saamise vahel asendit (st liigub küljele). Kui on valitud 
Liikumise korrigeerimine seeriate vahel (Motion Correction Between Series), määratakse atrioventrikulaarse klapi 
tasandi lõppdiastoolne keskpunkt kõige põhimikupoolsem lõppdiastoolse vatsakese endokardi kontuuriga. Klapirõnga 
tasapinna nurk ja selle keskpunkti suhteline asend teiste südamefaaside suhtes määratakse rõngaste joonte nurga ja rõnga 
keskpunktide suhtelise asendi järgi, nagu on määratletud pikitelje kujutistel. 

MÄRKUS. Funktsioonile ligipääsemiseks funktsiooni analüüsi režiimis. Valige Tööriistad (Tools) > Eelistused 
(Preferences) > Redigeeri (Edit). Valige Funktsiooni alt Liikumise korrigeerimine seeriate vahel (Motion 
Correction Between Series).

1. Tehke LV ja RV automaatne segmenteerimine kõikides faasides ja kõikides lõikudes.

2. Tehke LV ja RV põhimiku interpoleerimine. 

3. Valige .
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4. Nõustumine kinnitatakse, kui katkendjoon kuvatakse MV rõngas joone asukoha peal, nagu on näidatud joonisel 5 
(vasakul).

JOONIS 5. Kinnitatud nõustumine (vasakul) ja südame translatsioon (paremal)

5. Joonisel 5 (paremal) on kujutatud tühimik pideva ja katkendliku rõnga joone vahel. 

6. Pidev joon tähistab pikitelje kujutisele joonistatud rõnga tasapinda. Katkendjoon tähistab rõnga transleeritud 
tasapinda, mis põhineb kõige põhimikupoolsemal endokardi kontuuri asukohal. 

MÄRKUS. Kasutaja vastutab pideva ja katkendjoone vahelise tühimiku põhjuse väljaselgitamise eest ning vajadusel 
analüüsi korrigeerimise eest. Tühimiku võimalikud põhjused on järgmised.
- Lühikese telje kujutise kõige põhimikupoolsem endokardi kontuur ei ole joonistatud õigele lõigule. Kui seda ei 

parandata, kompenseerib tarkvara translatsiooni valesti. 
- Rõnga joon ei tähista rõnga asukohta. Kui seda ei parandata, kompenseerib tarkvara translatsiooni valesti. 
- Südame translatsioon piki- ja lühikese telje kujutise tegemise vahel.

Kui kõige põhimikupoolsem endokardi kontuur on joonistatud õigele lõigule ja rõnga kontuur on joonistatud 
pikitelje kujutisel õigesti, siis pidev- ja katkendjoone vaheline tühimik tähistab tõelist südame translatsiooni ja 
tarkvara korrigeerib selle.

7. Kui RV segmenteerimine on tehtud ja TV rõngas on asetatud, vaadake translatsioon üle. 
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Maatriksvaade 
MÄRKUS. X-telje (lõik) ja y-telje (faas) saab omavahel ümber vahetada. Valige Tööriistad (Tools) > Eelistused 
(Preferences) > Redigeeri (Edit). Valige Funktsiooni (Function) alt Vaheta maatriksrežiimi jaoks omavahel teljed x(lõik) ja 
y(faas) (Flip X (slice) and Y (phase) axis for matrix mode). Kui eelistust muudetakse, tuleb rakendus taaskäivitada.

Maatriksit kasutatakse lõppsüstoolse ja lõppdiastoolse faasi ülevaatamiseks ja määramiseks ning faaside ja lõikude 
sirvimiseks. Määratud ED ja ES-i faasid on näidatud ühevärviliste plokkidena, ED puhul punaselt ja ES-i puhul siniselt, nagu 
näidatud Joonis 6.

JOONIS 6. LV ja RV maatriksvaade

Vatsakese määramine

Vasaku vatsakese ED (Joonis 7) või ES (Joonis 8) määratakse valides maatriksi üksikvälja parema poole.

Parema vatsakese ED (Joonis 9) või ES (Joonis 10) määratakse valides maatriksi üksikvälja vasaku poole.

JOONIS 7. JOONIS 8.

JOONIS 9. JOONIS 10.

Määratud ES faas

Määratud ED faas
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Kodade määramine

Vasaku koja ED (Joonis 11) või ES (Joonis 12) määratakse valides maatriksi üksikvälja parema poole.

Parema koja ED (Joonis 13) või ES (Joonis 14) määratakse valides maatriksi üksikvälja parema poole.

Maatriksi funktsioonid

Kontuure saab kustutada, valides faasi või lõigu rea või üksiku maatriksi välja ja tehes paremklõpsu.

Interpolatsiooni märgivad värvitud indikaatorid. Interpolatsiooni saab rakendada järgmistel tingimustel. 
• Kui samas südamefaasis jälgitakse lõike lõppsüstoolse või lõppdiastoolse töö osas ja üks lõik on vahele jäetud.
• Kui samas südamefaasis jälgitakse lõikusid kas lõppsüstoolse või lõppdiastoolse töö osas ja/või üks lõik on vahele jäetud, 

võib rakendada basaalinterpolatsiooni.

Kuvamise suvandid

JOONIS 11. JOONIS 12.

JOONIS 13. JOONIS 14.

Kuvatakse LV/RV 
maatriks

Kuvatakse RA/LA 
maatriks
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Valikud 

*Vt märkust jaotise Kojad lk 81 all.

Kambrite indikaatorid 

Vatsakese segmentatsiooni indikaatorid 

Koja segmentatsiooni indikaatorid 

Üldine ED/ES Kui on valitud üldine, põhineb kombineeritud maht sama faasi ED ja ES-i 
määrangutel.

Üksik ED/ES Kui on valitud üksik, põhineb kombineeritud maht iga lõigu suurimal ja 
vähimal mahul lõigu kohta. Aktiveerimiseks tuleb valida režiim Laienda 
kõikidele lõikudele, kõikidele faasidele (Propagate All Slices, All Phases). 
Põhimiku interpoleerimist selles režiimis ei toetata. 

Interpolatsioon Valige sisse/välja lülitamiseks Sees (On) või Väljas (Off). Näidatakse otse 
mahukõveral. 

ED Lõppdiastoolse faasi määramiseks klõpsake RV jaoks otse maatriksi välja 
vasakul poolel või LV jaoks välja paremal poolel.

Lõppdiastoolse faasi määramiseks klõpsake RA jaoks otse maatriksi välja 
vasakul poolel või LA jaoks välja paremal poolel.

ES Lõppsüstoolse faasi määramiseks klõpsake RV jaoks otse maatriksi välja 
vasakul poolel või LV jaoks välja paremal poolel.

Lõppsüstoolse faasi määramiseks klõpsake RA jaoks otse maatriksi välja 
vasakul poolel või LA jaoks välja paremal poolel.

Max

 

Valik koja maksimaalse mahu jaoks*

Min

 

Valik koja minimaalse mahu jaoks*

LV endokard LV epikard RV endokard RV epikard

RA endokard LA endokard
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Vatsakeste funktsiooni analüüsi tulemused

JOONIS 15. Vatsakese automaatse segmenteerimise tulemused

1. Mahumeetrilised tulemused, 2. Mahu kõver, 3. Maatriks

Mahu kõver

Kui automaatne segmenteerimine viiakse läbi kõikides faasides ja kõikides lõikudes kas LV või RV jaoks, luuakse vatsakeste 
mahu ja aja suhte kõver, nagu näidatud Joonis 15. Mahu kõvera lisamiseks aruandesse tehke paremklõps.

• Punane ring tähistab diastoli lõppu (kujutise vaateavas märgistatud kui ED).
- Klõpsake ja lohistage punast ringi, et ED uuesti määrata.

• Sinine ring tähistab süstoli lõppu (kujutise vaateavas märgistatud kui ES).
- Klõpsake ja lohistage punast ringi, et ES uuesti määrata.

• Roheline kursor näitab maksimaalset väljutuskiirust (PER) ml/s. (Interaktiivne vertikaalne kursor).
• Kollane kursor näitab maksimaalset täitumiskiirust (PFR) ml/s. (Interaktiivne vertikaalne kursor).
• Vastavat kujutise faasi valikut näitab valge ring mahu kõveral.

Mahulisi tulemusi kuvatakse mõõtemiste tabelis. 
• Vatsakese massi tulemuste või massi indeksi ülevaatamiseks tehke vasakklõps LV või RV ümberpööratud kolmnurgal.
• Faaside loendist valitud faas kuvatakse aruandes. Vaikemäärang on ED.

1

2

3
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JOONIS 16. Massi tulemused

JOONIS 17. Kambrite mahtude tabel

LV ja RV mahu väärtused kuvatakse Kambrite mahtude (Chamber Volume) tabelis. 
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Vasaku vatsakese piirkondlik analüüs
LV piirkondlik analüüs võimaldab vaadata seina liikumist, seina paksust, seina paksenemist ja seina paksuse tulemusi.

MÄRKUS. Kui nii LV kui ka RV nupud on funktsiooni lühikese telje jaoks valimata või pikitelje kambri valimise nupp on 
valimata, ei saa kasutada nuppu Alusta automaatset laiendamist (Start Auto Propagation). 

1. Tehke automaatne LV segmenteerimine kõikides lõikudes ja kõikides faasides (vt lk 66).

2. Vaadake üle RV sisestuspunkti asukoht igal lõigul ja kohandage RV sisestuspunkti põhimiku lõikude jaoks.

3. RV sisestuspunkti lisamiseks lõigu asukohal klõpsake RV sisestuspunktil , valige automaatselt segmenteeritud 
lõik ja sisestage RV sisestuspunkt. 

4. Veenduge põhimiku, keskosa ja tipu klassifitseerimises. 

5. Klõpsake piirkondlikul analüüsil . Paksust, paksenemise protsenti ja seina liikumist kuvatakse diagrammi, 
graafiku või tabeli vormis.

JOONIS 18. Piirkondlikud analüüsid
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Mittesünkroonsuse analüüs
Mittesünkroonsus on piirkondliku analüüsi tulemuste laiendus, mis võimaldab arvutada seina paksuse ajalise ühtsuse 
(TUWT), mis põhineb piirkondlikul analüüsil saadud ümbermõõdu teabel. 

Mittesünkroonsuse analüüsimise protseduur
1. Tehke LV automaatne segmenteerimine (Vt Automaatne segmenteerimine kõikidel lõikudel ja faasidel lk 66).

2. Valige piirkondlikud analüüsid .

3. Valige mittesünkroonsuse vahekaart.

4. Mõõtmiste tabelis kuvatakse iga lõigu tulemusi ja keskmist üldist tulemust.

5. Üldise tulemuse arvutamine on optimaalne, kui kaasatakse ainult LV keskosa lõigud. Lõigu tulemuse eemaldamiseks 
üldisest tulemuste arvutamisest klõpsake otse paremas äärmises veerus (Joonis 19) täidetud märkeruudul.

JOONIS 19. Üldiste tulemuste arvutamine

Soovitatud allikas

Bilchick et al, “Cardiac Magnetic Resonance Assessment of Dyssynchrony and Myocardial Scar Predicts Function Class Improvement 
Following Cardiac Resynchronization Therapy”, JACC, Vol.1:No 5: 2008 p.561-8

Helm RH, Leclercq C, Faris OP, Ozturk C, McVeigh E, Lardo AC, Kass DA. Cardiac dyssynchrony analysis using circumferential versus 
longitudinal strain: implications for assessing cardiac resynchronization. Circulation. 2005 May 31;111(21):2760-7. doi: 10.1161/
CIRCULATIONAHA.104.508457. Epub 2005 May 23. PMID: 15911694; PMCID: PMC2396330.
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Automaatne segmenteerimine pikiteljel

1. Valige .

2. Valige pikitelje seeria.

Soovitav on luua seeria standardse pikitelje vaatega.

3. Valige .

4. Kõikidele lõikudele ja faasidele laiendamiseks valige .

5. Klõpsake .

MÄRKUS. Nupp Alusta automaatset laiendamist (Start Auto Propagation) ei tööta, kui pikitelje vaade ei ole valitud.

6. Vaadake üle kõik jooned. Kohandage keskjoont nii, et see vastaks vasaku vatsakese pikiteljele põhimikust tipuni.

7. Käsitsi keskjoone tõmbamiseks klõpsake vasaku vatsakese endokardi puhul  ja parema vatsakese endokardi 

puhul  nii diastoli lõpu kui süstoli lõpu jaoks.

8. Massi arvutamiseks valige vasaku vatsakese epikard  või parema vatsakese epikard .

JOONIS 20. Keskjoone paigutamine

Tulemusi kuvatakse mõõtmiste tabelis.
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 Kojad
MÄRKUS. Kodade mahtude vaikimisi mõõtetulemuste sildid on EDV, mis viitab maksimaalsele koja mahule, ja ESV, mis 

viitab minimaalsele koja mahule. Siltide MaxV ja MinV seadistamiseks valige Tools (Tööriistad) > 
Preferences (Eelistused) > Edit (Redigeeri). Valige Koja mahu silt: MaxV, MinV (Atrial Volume Label: 
MaxV, MinV) jaotises Funktsioon (Function).

LA ja RA käsitsi analüüsimine
1. Valige kujutistevaaturist sobiv seeria. 

MÄRKUS. Optimaalsete tulemuste jaoks on soovitav kasutada 4 kambri analüüsi. 4 kambri vaade kujutab kodade 
anatoomiat paremini.

2. Klõpsake .

3. Valige nuppe .

4. Lokaliseerige lõppdiastoolne faas.

Endokardi määramine

1. LA endokardi jaoks valige  või RA endokardi jaoks .

2. Joonistage endokardi kontuur.

3. Liikuge järgmise lõigu juurde , kasutades vasakule või paremale nooleklahvi, hiire kerimisratast või 
vajutades pisipilti.

4. Korrake samme 2 ja 3 kuni kogud koda on segmenteeritud.

5. Leidke lõppsüstoolne faas.

6. Korrake lõppsüstoolses faasis samme 2 ja 3, kuni kogu koda on segmenteeritud.

MÄRKUS. Tarkvara määratleb automaatselt suurima mahuga faasi lõppdiastoolse faasina ja väikseima mahuga faasi 
lõppsüstoolse faasina. Lõppdiastoolse ja lõppsüstoolse faasi määratlusi uuendatakse segmenteerimise 
käigus.

7. Kui kasutatakse lühikese telje vaadet, tuvastage MV ja/või TV rõngas.
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LA või RA automaatne analüüsimine

1. Klõpsake .

2. Valige pikitelje seeria.

MÄRKUS. Soovitav on luua seeria standardse pikitelje vaatega. Kodade segmenteerimist toetatakse nii 2 kui ka 
4 kambri vaates. 

3. Valige .

4. Kõikidele lõikudele ja faasidele laiendamiseks valige .

5. Klõpsake .

MÄRKUS. Nupp Alusta automaatset laiendamist (Start Auto Propagation) ei tööta, kui pikitelje vaade ei ole valitud.

6. Vaadake üle kõik jooned. Kohandage keskjoont nii, et see oleks koja kambriga paralleelne.

7. Käsitsi keskjoone tõmbamiseks klõpsake parema vatsakese endokardi puhul  ja vasaku vatsakese endokardi 

puhul  nii diastoli lõpu kui süstoli lõpu jaoks.

JOONIS 21. Keskjoone paigutamine
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Kodade mõõdud ja pindala

1. Klõpsake .

2. Valige sobiv seeria.

3. Kodade mõõtude määramiseks klõpsake otse tabelis LA või RA veerul ja pange paika kaks punkti. Vt Joonis 22.

4. Kodade pindala mõõtmiseks klõpsake otse tabelis LA või RA veerul ja joonistage seejärel ROI. Vt Joonis 22.

JOONIS 22. Kodade mõõdud
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Vaikemõõtmised
Rakendus võimaldab teha lineaarsete ja pindala mõõtude aruande. Tööriistad on saadaval, kui panna kursor tabelis 
toodud mõõdule.

JOONIS 23. Vaikemõõtmised

1. Kaasa aruandesse, 2. Tekstiväli perikardi jaoks, 3. Lisa/eemalda kohandatud mõõtmine, 4. Kustuta kõik mõõtmised

Mõõtmine

1. Valige .

2. Valige seeria. 

3. Klõpsake nupul .

4. Lokaliseerige kujutis, mille anatoomiat soovite mõõta.

5. Klõpsake soovitud mõõtmisel, mis tõstetakse esile, näidates, et valik on aktiivne. 

ETTEVAATUST! Joone täpne asukoht on mõõtmistulemuste jaoks ülioluline. Kui mõõtmised on ebatäpsed, 
võib see tuua kaasa vale diagnoosi. Mõõtmised peaks tegema ainult nõuetekohaselt koolitatud 
ja kvalifitseeritud kasutaja.

1

2

3 4
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6. Redigeerimiseks klõpsake märkmel ja kui värv muutub lillaks, on see aktiivne. Viige kursor ühe lõpp-punkti kohale ja 
kohandage lõpp-punkti. 

Mõõdetud kauguse väärtust uuendatakse tabelis Mõõtmised (Measurements) vastavalt siis, kui liigutate kursori 
Kujutiseredaktori (Image Editor) aknast välja.

Kogu kauguse mõõtmise joone teise kohta viimiseks asetage kursor keskmise markeri kohale.

MÄRKUS. Mõõtmise lähtestamiseks valige kauguse mõõtmise joon ja avage paremklõpsumenüü ning valige prügikast; 
või kasutage klaviatuuril kustutusklahvi. 

MÄRKUS. Kohandatud mõõtmisi saab ümberorganiseerida vahekaardil Prindi teised eelistused (Print Preferences 
Other), valides Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit)

Mõõtmiste kustutamine

Kõikide mõõtmiste kustutamiseks klõpsake .

Kohandatud mõõtmise lisamine

1. Klõpsake . 

2. Sisestage hüpikaknasse Lisa kohandatud mõõt (Add Custom Measure) kordumatu silt.

3. Valige mõõtmise tüüp, kas lineaarne või pindala.

4. Valige OK. 

Kohandatud mõõtmise eemaldamine

1. Klõpsake . 

2. Valige kohandatud mõõtmine, mida loendist eemaldada.

3. Valige Vali (Select).
MÄRKUS. Loodud kohandatud mõõtmised ilmuvad kõikidele tulevastele analüüsidele, kuni neid pole loendist 

eemaldatud.
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Aordiklapi tasapinna analüüs
Aordiklapi tasapinna analüüsi funktsioon võimaldab arvutada aordiklapi maksimaalset kiirust, tipprõhu gradienti ja 
keskmist rõhugradienti.

LV automaatse segmenteerimise tulemusi kasutades arvutatakse rõhugradient südame minutimahu põhjal, võttes aluseks 
vasaku vatsakese süstoolse mahu kaader-kaadri kohased muutused.

Aordiklapi tasapinna analüüsimise protseduur
1. Tehke LV automaatne segmenteerimine kõikidel lõikudel ja kõikides faasides (vt lk 66).

2. Valige seeria, mis näitab klapi anatoomiat.

3. Valige mõõtmiste tabelist Aordiklapi pindala (Aortic Valve Area) (Joonis 24) ja tehke aordiklapi planimeetria, nagu 
näidatud Joonis 25.

JOONIS 24. Aordiklapi pindala 

4. ROI määramise järel uuendatakse tabelis tulemusi ja kuvatakse graafik, mis näitab rõhu gradienti ajas.

Kõikide mõõtmiste kustutamiseks klõpsake  .

Soovitatud allikas

Wolff, Steven D., M.D., Ph.D. Noninvasive methods for determining the pressure gradient across a heart valve without using velocity 
data at the valve orifice. U.S. Patent 9,585,568, March 7, 2017.
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JOONIS 25. Aordiklapi tasapinna analüüs

HOIATUS! It is recommended that you are qualified in performing cardiac analysis, if the analysis results are 
to be used to reach a diagnosis.

MÄRKUS. The results of Peak Velocity, Peak Pressure Gradient, and Mean Pressure Gradient obtained by Aortic Value 
Plane Analysis are not valid in patients with mitral regurgitation or a shunt.

Myocardial Contraction Fraction

The myocardial contraction fraction (MCF) requires complete endo and epi LV segmentation of the short axis and is 
reported on the result table for short axis function. It is the user’s responsibility to establish their own normal ranges for 
MCF. 
Tarkvara suiteHEART® kasutusjuhend NS-03-043-0003-ET Red. 2 87



Soovitatud allikad

Abdalla M, Akwo EA, Bluemke DA, Lima JAC, Shimbo D, Maurer MS, Bertoni AG. Association between reduced myocardial 
contraction fraction and cardiovascular disease outcomes: The Multi-Ethnic Study of Atherosclerosis. Int J Cardiol. 2019 
Oct 15;293:10-16. doi: 10.1016/j.ijcard.2019.07.040. Epub 2019 Jul 11. PMID: 31327521; PMCID: PMC7175692.

Arenja N, Fritz T, Andre F, Riffel JH, Aus dem Siepen F, Ochs M, Paffhausen J, Hegenbart U, Schönland S, Müller-Hennessen 
M, Giannitsis E, Kristen AV, Katus HA, Friedrich MG, Buss SJ. Myocardial contraction fraction derived from cardiovascular 
magnetic resonance cine images-reference values and performance in patients with heart failure and left ventricular 
hypertrophy. Eur Heart J Cardiovasc Imaging. 2017 Dec 1;18(12):1414-1422. doi: 10.1093/ehjci/jew324. PMID: 28165128.

Maurer MS, Packer M. How Should Physicians Assess Myocardial Contraction?: Redefining Heart Failure With a Preserved 
Ejection Fraction. JACC Cardiovasc Imaging. 2020 Mar;13(3):873-878. doi: 10.1016/j.jcmg.2019.12.021. PMID: 32139035.
Tarkvara suiteHEART® kasutusjuhend NS-03-043-0003-ET Red. 2 88



Voolu analüüs
Voolu analüüsi režiim toetab nii 2D- kui ka 4D-voolu kujutiste tegemist. Toetatakse nii käsitsi kui ka täisautomaatset 
segmenteerimist vooluhulga, -kiiruse, tagasivoolu mahu, rõhugradiendi, rõhu poolaja ja Qp/Q-de määramisega. Olenevalt 
kasutusmeetodi(te)st saadakse aordi-, mitraal-, kopsu- ja trikuspidaalregurgitatsiooni automaatne arvutamine. Täpsed 
voolutulemused sõltuvad sellest, kas kujutiste saamisel kasutatakse õiget skannimistasapinda, sobivaid 
hõiveparameetreid ja tasandipõhist voolukodeeringut.

MÄRKUS. Kui kujutise kvaliteet on halb, võib automaatne segmenteerimine olla vähem täpne. Sellistel juhtudel 
vastutab kasutaja kontuuride muutmise või käsitsi segmenteerimise eest.

MÄRKUS. Kui on tehtud nii 2D-faasikontrastne kui ka 4D-voolu analüüs, on kõik tulemused saadaval voolu analüüsi 
režiimis.

Eeltöötluse funktsioon toetab veresoone tüüpide tuvastamist 2D-faasikontrastsuse jaoks, nagu on loetletud tabelis 1. Vt 
suiteDXT kasutusjuhendit.

HOIATUS! Pärast eeltöötlust vastutab kasutaja kogu analüüsi täpsuse hindamise ja vajalike paranduste 
tegemise eest. Põhjalik ülevaade peaks sisaldama järgmist.
- ROI paigutust 
- iga kategooria jaoks õige veresoone identifitseerimist
- Algtaseme korrigeerimine

HOIATUS! Kasutaja vastutab kõigi huvipakkuvate piirkondade (ROI) täpse paigutamise ja õige kategooria 
määramise eest, kaasa arvatud need, mis on loodud või muudetud automaatse 
segmenteerimisalgoritmide abil. Tarkvara genereeritud kvantitatiivsed väärtused sõltuvad kõigi 
huvipakkuvate piirkondade täpsest paigutamisest ja õigest veresoone kategooria määramisest.

HOIATUS! Rakendus ainult aitab kujutisi analüüsida ja ei anna automaatselt tulemuste kliinilist tõlgendust. 
Kvantitatiivsete mõõtmiste kasutamine ja paigutus on kasutaja äranägemisel. Kui mõõtmised on 
ebatäpsed, võib see tuua kaasa vale diagnoosi. Mõõtmised peaks tegema ainult nõuetekohaselt 
koolitatud ja kvalifitseeritud kasutaja.
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JOONIS 1. Voolu analüüsi liidese ülevaade

1. Veresoone kategooriad, 2. Valik Täiskasvanu/pediaatria, 3. Aktiivse ROI valik, 4. Graafiku ümberpööramine, 5. Valikute levitamine, 
6. Kustutamise suvandid, 7. Algtaseme korrigeerimise rippmenüü, 8. Nihe: faas, dilatatsioon, vool, 9. Mürapikslite välistamine, 
10. Värvi läbipaistmatuse reguleerimine, 11. Diskreetmoonutuse korrigeerimine, 12. Kõvera režiimi valikud, 13. Tulemuste tabeli valikud, 
14. Kõvera tulemus/kuva, 15. Regurgitatsioonirežiim, 16. Muutmise tööriistad, 17. Integreeritud analüüs

MÄRKUS. Voolu analüüs kuvab magnituudi- ja faasikujutisi kõrvuti asetseva kujutise kuvana. Muid samast 
skannimiskohast saadud kujutise tüüpe ei kuvata ja need tuleks vaaturis üle vaadata.

MÄRKUS. Südame löögisageduse saab teada liigutades kursorit kõvera kuval voolutulemuse kohal.

1
2

3 4 5 6
7 8

9
10

11
12 13

14

15

16

17
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Voolu analüüs Automaatse segmenteerimisega
Kui eeltöötlus on lõpetatud, tehakse uuringus sisalduva 2D faasikontrastsuse seeria põhjal selle automaatne 
segmenteerimine ja määratakse sellele vastav veresoone kategooria (tabel 1). Automaatne segmenteerimine ei nõua 
esialgse ROI paigutamist veresoonele, lihtsalt valige sobiv veresoone kategooria ja õige seeria, mis seda veresoont kuvab. 
Kui eeltöötlust ei tehta, on oluline valida sobiv kategooria, mis vastab saadud veresoone anatoomiale.

HOIATUS! Kasutaja vastutab kõigi huvipakkuvate piirkondade (ROI) täpse paigutuse ja õige kategooria 
määramise eest, kaasa arvatud need, mis on genereeritud eeltöötluse käigus. 

MÄRKUS. Kui ühe vahekaardi kohta on faasikontrastsuse jaoks saadud rohkem kui kuus veresoont, jätab 
eeltöötlusfunktsioon alles ainult kuus kõige värskemat tulemust.

MÄRKUS. Netovoolu tulemus kuvatakse iga veresoone kategooria all. Kui veresoone kategoorias on rohkem kui üks 
voolumõõtmine, kuvatakse keskmist tulemust. Selle peitmiseks valige Tööriistad (Tools) > Eelistused 
(Preferences) > Redigeeri (Edit) ja valige Voolu (Flow) all vooluühikuks PUUDUB (NONE). 

Tabel 1:  Veresoonte kategooriad

Veresoone 
kategooria

Tööriista vihje Silt

LVOT Vasaku vatsakese väljavoolutrakt (pediaatria) 

pAAo Proksimaalne ülenev aort

mAAo Keskmine ülenev aort

pDAo Proksimaalne alanev aort
(Pediaatria)

SVC Ülemine õõnesveen
(Pediaatria)

MPA Peamine kopsuarter

RPA Parem kopsuarter
(Pediaatria)
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Automaatne või käsitsi segmenteerimine 
(Proksimaalse üleneva aordi segmenteerimise näide)

1. Valige Täiskasvanu või pediaatria .

2. Valige  kategooria.

3. Valige sobiv faasikontrastne seeria, mis näitab proksimaalset ülenevat aorti nagu joonisel 2.

JOONIS 2. Proksimaalne ülenev aort

4. Valige aktiivse ROI värv, nagu on näidatud joonisel 3.

JOONIS 3. Aktiivse ROI valimine

LPA Vasak kopsuarter
(Pediaatria)

IVC Alumine õõnesveen
(Pediaatria)

dDAo Distaalne alanev aort
(Pediaatria)

Vool 1, vool 2 Kasutaja määratud kategooriad. Tehke paremklõps ja 
sisestage uus kategooria silt. Silti kuvatakse kohtspikrina. 

Tabel 1:  Veresoonte kategooriad

Veresoone 
kategooria

Tööriista vihje Silt
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Võimalik on teha 6 ROI-d, numbritega 1–6. Värvikood jääb kogu analüüsi vaates, kujutiste vaateavades ja graafikutel 
samaks.

5. Valige .

6. Vaadake üle veresoone segmenteerimine. Veenduge, et segmenteeriti õige veresoon. 
Kui segmenteeriti vale veresoon, tehke segmenteerimine käsitsi.

7. Käsitsi segmenteerimiseks valige .

8. Looge veresoone ümber kontuur, paigutades 4 punkti huvipakkuva veresoone ümber ja viige kursor redaktori aknast 
väljapoole, et ROI saaks kinnitatud.

• Valige automaatseks segmenteerimiseks kõikides lõigu faasides .

või

• valige , et laiendada sama kontuuri kõikidele lõigu faasidele. See on kasulik, kui analüüsitakse väikseid statsionaarseid 
sooni.

9. Redigeerimiseks klõpsake kontuuril, redigeerige ja klõpsake . Vt Kontuuri redigeerimine lk 94.

10. Voolu tulemused kuvatakse graafikul ja tulemuste tabelites. Seotud kõvera graafikult eemaldamiseks valige voolu 
tulemuse kõrval olev märkeruut. 

11. Valige faili rippmenüüst suvand Algtaseme korrigeerimine (Baseline Correction).
Kõveratel, millel on tehtud algtaseme korrigeerimine, on tugevad faasi andmete punktid, nagu on näidatud joonisel 8. Vt 
Algtaseme korrigeerimise suvandid lk 97.

JOONIS 4. Voolu graafik – korrigeerimata (vasakpoolne graafik), korrigeeritud (parempoolne graafik)

Kõik genereeritud voolukõverad kuvatakse positiivses suunas. Ümberpööratud kõveraid tähistatakse nii .
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Veresoone kategooria teisaldamine

Kui pärast ülevaatamist nähtub, et tehtud voolutulemus ei ole õiges veresoone kategoorias, saab seda sobivasse 
kategooriasse liigutada.

Tehke vasakklõps kontuuril, seejärel paremklõps ja laske lahti. Viige kursor veresoonte tüüpidele ja valige õige kategooria, 
nagu on näidatud joonisel 5. (Näidatud on vaid pediaatria kategooriad). Voolu tulemus ilmub nüüd selle kategooria alla.

JOONIS 5. Veresoone kategooria teisaldamise valikud

Kontuuri redigeerimine
1. Valige faas, mida soovite redigeerida.

2. Tehke kontuuril vasakklõps, et see redigeerimiseks aktiveerida.
Kontuur muutub lillaks, mis näitab, et seda saab redigeerida.

3. Kui kuvatakse, redigeerige kontuuri, liigutades punktsplaini kontuuri punkte.

4. Tehke muudatused vaba käega, kasutades klõpsamist ja jooni. 

5. Valimiseks tehke kontuurilvasakklõps ja seejärel paremklõps tööriistade kasutamiseks, nagu on kirjeldatud tabelis 2. 

6. Kasutage vaateava redigeerimistööriistu, nagu on kirjeldatud tabelis 3.
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Faasivahemike redigeerimine
1. Valige soovitud lõik.

2. Valitud lõigu asukoha kõikide faaside vaateakende kuvamiseks valige .

3. Valige redigeeritavate faaside vahemiku esimene faas.

4. Vajutage ja hoidke all Shift-klahvi ning valige redigeeritava vahemiku viimane faas.

5. Redigeerige kontuuri Kujutiseredaktori (Image Editor) aknas.

6. Tühistage kontuuri valik, klõpsates kujutisel valitud kontuurist eemal või liigutades kursorit redaktori aknast 
väljapoole.

Tabel 2:  Paremklõpsu suvandid

Tööriist Kirjeldus

Kustuta praegusest faasist üks ROI

Kustuta kõikidest faasidest kõik ROI-d

Müksamise tööriista valik

Tõmbamise tööriista valik

Näidatakse praegust veresoone kategooriat. Liiguta voolu tulemus teise kategooriasse

Tabel 3:  Vaateava redigeerimistööriistad 

Tööriist Kirjeldus

Kopeeri muudatus faaside lõppu 

Kopeeri muudatus faaside algusesse 

Kopeeri ROI eelmisest faasist 
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Kopeeri ROI järgmisse faasi 

Vähenda ROI suurust 

Laienda ROI suurust

Liigu eelmisse ja järgmisesse faasi

Nihuta ROI-d paremale või vasakule

Nihuta ROI-d üles või alla 

Tabel 3:  Vaateava redigeerimistööriistad 

Tööriist Kirjeldus
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Algtaseme korrigeerimise suvandid
2D-faasikontrastsuse voolu algtaseme korrigeerimiseks on kolm meetodit. Voolukõveratel, millel on rakendatud 
korrigeerimismeetodit, on tugevad faasi andmete punktid.

MÄRKUS. Analüüsiks kasutatavatel faasikontrastsetel kujutistel ei tohiks olla kujutise faaside kokkupakkimist. Kujutisel 
olev faaside kokkupakkimine muudab automaatse algtaseme korrigeerimise kehtetuks.

Automaatne algtaseme korrigeerimine

Automaatne algtaseme korrigeerimine parandab kujutise saamisel tekkivaid faasivigu, uurides faasivigu kaugemates 
fikseeritud organites (nt rindkere seinas, maksas jne) ja sobitades andmeid ruumiliselt lineaarse või kõrgema taseme 
interpolatsiooni abil.

MÄRKUS. Kui 2D magnituudi- ja faasiseeriad luuakse 3D/4D voolu vaaturi abil, loob rakendus ühe korrigeerimata 
seeria ja teise seeria, millele on rakendatud faasivea parandust. Ärge kasutage seeriatel, millel on silt 
Korrigeeritud (Corrected), algtaseme korrigeerimise rippmenüüs valikut Automaatne (Auto).

1. Genereerige voolukõver kasutades sobivat faasikontrastsuse seeriat.

2. Valige algtaseme korrigeerimise rippmenüüst valik Automaatne (Auto).

MÄRKUS. Automaatset algtaseme korrigeerimist rakendatakse automaatselt, kui Eelistustes on valitud Automaatne 
algtaseme korrigeerimine (Auto Baseline Correction).

3. Parandust rakendatakse uuendatud tulemustel, mis kuvatakse otse voolugraafikul.

4. Seeriad, millel sobivuse analüüs ebaõnnestub, tähistatakse hoiatussümboliga, nagu on näidatud joonisel 6.

MÄRKUS. Pildil olev faasi kokkupakkimine põhjustab ebatäpseid voolutulemusi, nagu on näidatud joonisel 7. 
Vooanalüüsiks kasutatavatel 2D-video faasikontrastsetel kujutistel ei tohiks olla kujutise faaside 
kokkupakkimisi, nagu on näidatud joonisel 8.

JOONIS 6. Algtaseme korrigeerimise ebaõnnestumine

Ebaõnnestumise tüübid
1 – Kokkupakkimised kujutisel
2 – Müra kujutisel
3 – Kujutis on sobimatu
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JOONIS 7. Faasi kokkupakkimisega kujutiste näidis (valged nooled)

JOONIS 8. Faasi kokkupakkimiseta kujutiste näidis

Fantoomiga korrigeerimine

Faasikontrastsuse tulemuste täpsuse parandamiseks ja algtaseme faasinihke vigade parandamiseks saab selle vea 
arvutamiseks kasutada fantoomvõtet.

MÄRKUS. Fantoomkorrektsiooni seeriad peavad olema saadud samade skannimisparameetrite ja ettekirjutusega 
nagu algsed faasikontrastsed seeriad. Statsionaarselt objektilt tulev signaal peab täitma fantoomseerias 
kogu kontuuri.

1. Genereerige voolukõver kasutades sobivat faasikontrastsuse seeriat.

2. Valige Algtaseme korrigeerimise (Baseline Correction) rippmenüüst vastav fantoomseeria.

3. Parandust rakendatakse uuendatud tulemustel, mis kuvatakse otse voolugraafikul.

Taustakontuuri korrigeerimine

Seda korrigeerimismeetodit võib kaaluda veresoonte puhul, mis on ümbritsetud liikumatu koega.

MÄRKUS. Optimaalseks korrigeerimiseks tuleb taustakontuur asetada liikumatusse koesse, mis on vahetult 
voolupiirkonna kõrval ja ümbritseb seda.
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1. Genereerige voolukõver kasutades sobivat faasikontrastsuse seeriat.

2. Valige algtaseme korrigeerimise rippmenüüst Tausta ROI (Backround ROI).

3. Kontuuri joonistamiseks klõpsake .

4. Parandust rakendatakse uuendatud tulemustel, mis kuvatakse otse voolugraafikul.

Voolu tööriistad
Nihke suvandid 

Faili rippmenüüs on 3 suvandit: Faas, vool ja dilatatsioon

 Mürapikslite välistamine

See suvand tuvastab väikese intensiivsusega pikslid (suured kiiruste kõikumised), kui need ROI-s esinevad, märgib need 
roosa ülekattega, nagu on näidatud joonisel 10, ja jätab need voolu arvutamisest välja. Mürapikslite protsenti saab 
reguleerida liuguri abil.

JOONIS 9. Mürapikslid

Tabel 4:  

Valik Kirjeldus

Faas Muudab voolukõver ordinaati.

vool Muudab voolukõvera abstsissi väärtust, mis muudab voolutulemuste algtaseme väärtusi.

Dilatatsioon Muudab kõigis faasides segmenteeritud veresoone raadiust ühtlaselt määratud pikslite arvu 
võrra, et kaasata sobivad voolupikslid.
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JOONIS 10. Roosa ülekattega märgitud mürapikslid

Värvülekate
Punase/sinise värvülekatte kuvamiseks, mis näitab magnituudikujutistel kiirust, klõpsake ja lohistage värvi läbipaistmatuse 
liugurit. Kohandage kiirusvahemikku, määrates sinised või punased markerid, nagu on näidatud joonisel 11. Värvi 
läbipaistmatuse kohandamiseks valige Üldisel (Global) vahekaardil Voolu (Flow) alt Tööriistad (Tools) > Eelistused 
(Preferences) > Redigeeri (Edit). Värvülekatte eemaldamiseks seadke läbipaistmatus 0% peale.

JOONIS 11. Värvülekatte juhtnupp

Kiiruse diskreetmoonutuse korrigeerimine

Kiiruse diskreetmoonutuse korrigeerimiseks lohistage faasi lahtipakkimiseks liuguri juhtmarkerit. Muudatuse mõju 
uuendatakse otse faasikujutisel ja voolugraafikut uueneb. Diskreetmoonutust saab korrigeerida ilma, et ROI-d kujutisel 
oleks. Kui seerias on rohkem kui üks lõigu asukoht, mõjutab sätte muutmine kõiki lõigu asukohti. Ühe lõigu asukoha 
muutmiseks kasutage liuguri juhtnupu muutmisel Ctrl- või Alt-klahvi. 
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Kasutaja määratud tippkiirus
1. Valige südametsükli sobiv faas.

2. Kursori paigutamiseks faasi kujutisele kasutage .
Kursor sünkroonitakse nii magnituudi- kui faasikujutisega. Kiiruse tulemused ilmuvad faasi kujutisel kursori kõrval ühikuga 
mm/s.

JOONIS 12. Voolukiirus pikslil

Kõverarežiimi valikud

Tabel 5:  

Valik Režiim Kirjeldus

vool Kõver kujutab iga faasi voolumahtu kogu südametsüklis 
(vaikimisi). Iga kõvera punkt kujutab selle faasi voolu. Kuvatakse 
netovoolu tulemused.

Histogramm Kuvab iga piksli kiiruse diagrammi igas huvipakkuvas piirkonnas 
südametsükli igas faasis. Kuvatakse tipp- ja keskmise 
rõhugradiendi tulemused.

Rõhu poolaeg (PHT) Aeg, mis kulub maksimaalse transmitraalse rõhugradiendi 
vähenemiseks poole võrra. Võimaldab tuvastada graafiku kalde, 
et arvutada PHT ja mitraalklapi pindala (MVA).

Võrdlus Võimaldab kuvada kahe erineva kategooria kõveraid. 

Regurgitatsioon Arvutab negatiivse netovoolu (x-telje all). 
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Histogrammrežiim

Valige histogrammrežiim, et kuvada kiiruste diagramm piksli kohta ning tipp- ja keskmise rõhugradiendi arvutamine.

1. Genereerige voolukõver kasutades sobivat faasikontrastsuse seeriat.

2. Valige .

3. Klõpsake otse graafikul, et aktiveerida faasikujutisel niitrist-kursor, mis näitab piksli asukohta.

4. Kasutage graafiku allosas olevaid topeltnoole nuppe, et leida kiiruse suurima või madalaima väärtuse asukoht (joonis 13).

5. Kasutage üksiknoole nuppe, et suurendada veidi kiiruse väärtusi, nagu on näidatud joonisel 13.

MÄRKUS. Seeria asukoha määramise funktsioon on histogrammirežiimis keelatud, kui klõpsate otse voolukõveral. 
Asukoha määramise funktsiooni lubamiseks lülitage ümber voolurežiimile.

MÄRKUS. Et olla kindel, et kuvatakse õiget magnituudi- ja faasikujutist, töötage ühe voolukõveraga korraga, tühistage 
graafiku kuval teised histogrammikõverad.

MÄRKUS. Tarkvara suiteHEART® varasema versiooniga histogrammirežiimis analüüsitud uuringuid võib olla vaja 
uuesti analüüsida.

JOONIS 13. Histogrammrežiim

Rõhu poolaeg

Rõhu poolaeg (PHT) saadakse, kui mõõdetakse mitraalklapi faasikontrastsete kujutistel E-laine aeglustuskaldeid. See 
režiim võimaldab tuvastada graafiku kalde, et arvutada PHT ja mitraalklapi pindala (MVA).

1. Genereerige voolukõver, kasutades sobivat mitraalklapi faasikontrastset seeriat.

2. ROI laiendamiseks kasutage kopeerimise ja kleepimise suvandit.

3. Valige .

4. Kõvera aeglustusosa suurima kiiruse tuvastamiseks klõpsake otse diagrammil.
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5. Klõpsake kõvera kalde arvutamiseks lõpp-punktil, nagu on näidatud joonisel 14.

6. Arvutuse lähtestamiseks viige kursor lõpp-punkti kohale, tehke paremklõps ja valige prügikast.

JOONIS 14. Rõhu poolaja tulemused

MÄRKUS. Mitraalklapi pindala (MVA) ja rõhu poolaja (PHT) tulemused ei kehti aordipuudulikkusega, südame šundi või 
vähenenud ventrikulaarne vastavusega patsientidel.

MÄRKUS. Otse voolukõveral klõpsates on seeria asukoha määramise funktsioon PHT-režiimis keelatud. Asukoha 
määramise funktsiooni lubamiseks lülitage ümber voolurežiimile.

Allikas:

http://www.csecho.ca/mdmath/?tag=mvaph

Voolu tulemuste vaatamine
Valige voolu tulemuste vaatamiseks tabeli vormingus üks järgmistest suvanditest.

Tabel 6:  Tulemuste tabeli suvandid

Valik Silt Kirjeldus

Integreeritud 
analüüs

Kuvab analüüsitulemused voolu paanilt. Kaasab tulemused 
aordi, mitraalklapi, kopsu ja trikuspidaalse regurgitatsioonis ja 
Qp/Qs kohta. Vt Integreeritud analüüs lk 106.

Voolu 
analüüs

Kokkuvõtlikud tulemused voolukõvera kohta. 

Andmete 
tabel

Loendab üksikasjalikud voolu parameetrid iga faasi ja 
voolukõvera kohta.
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Vool 1 (Flow 1) ja Vool 2 (Flow 2) kategooria sildi 
muutmine
Muuta saab vaid Vool 1 (Flow 1) ja Vool 2 (Flow 2) kategooriate silte.

JOONIS 15. Vool 1, vool 2

Sildi muutmine
1. Tehke paremklõps valiku Vool 1 (Flow 1) või Vool 2 (Flow 2) peal (joonis 15).

2. Sisestage uue sildi nimi (joonis 16).

3. Uusi silte kuvatakse kohtspikritena. 

MÄRKUS. Kõvera tingmärkide sildile määratakse sama silt. 

JOONIS 16. Kategooria sildi redigeerimine 

MÄRKUS. Voolu kategooria sildi muutmine muudab voolu päise silti aruandes.

Kõvera tingmärkide redigeerimine 
1. Tehke paremklõps voolugraafiku allservas tähisel Vool 1:1 (Flow 1:1) (joonis 17).

MÄRKUS. Kui kategooria silti muudeti, näidatakse seda silti.
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JOONIS 17. Kõvera tingmärkide redigeerimine

2. Sisestage uus sildi nimi.

JOONIS 18. Voolukõvera tingmärkide siltide muutmine

MÄRKUS. Uued voolukõvera tingmärgid salvestatakse praeguse malliga.
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Integreeritud analüüs 
Lähtudes kasutaja valitud meetodist arvutab integreeritud analüüs Qp, Qs, Qp/Qs, aordi-, mitraalklapi-, kopsu- ja 
trikuspidaalse regurgitatsiooni mahud ja regurgitatsiooni fraktsioonid (RF%).

HOIATUS! Kasutaja vastutab Qp, Qs, aordi-, mitraalklapi-, kopsu- ja trikuspidaalse regurgitatsioooni mahtude 
ja regurgitatsiooni fraktsioonide määramise meetodi valimise eest. 

HOIATUS! Mõned või ükski meetod ei pruugi olla sobiv, olenevalt patsiendi patoloogiast. Kasutaja vastutab 
selle eest, et määrata, milline meetod on tõlgendamiseks sobiv.

HOIATUS! Kasutaja vastutab kõigi huvipakkuvate piirkondade (ROI) täpse paigutuse ja õige kategooria 
määramise eest, kaasa arvatud need, mis on genereeritud eeltöötluse käigus.

MÄRKUS. Kasutaja saab määrata integreeritud analüüsi jaoks vaikearvutusmeetodi, valides Tööriistad (Tools) > 
Eelistused (Preferences) > Redigeeri (Edit) faili rippmenüüst. Vaikemeetodi valikud on järgmised: Mitte 
ühtegi (None), Kõik (All) või Viimane (Last).
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Integreeritud analüüsi ülevaade (näidatud on täiskasvanu kohta)

• Ühiku valik ml/löök või l/min
• BSA valiku indeks (pikkus ja kaal tuleb sisestada aruandluse liideses)
• Positiivse voolutulemuse valik

Qp ja Q valikud
• Qp: kuvab voolu väärtused MPA kategooriast 
• Qs: kuvab voolu väärtused kas pAAo või mAAo kategooriast
• Qp/Qs tulemus
• LV ja RV löögimahu tulemusi kuvatakse lühikese telje funktsiooni analüüsist.

Allajoonitud Qp või Qs väärtusi saab käsitsi sisestada. Lähtestamiseks kustutage 
väärtus ja vajutage sisestusklahvi.

Arvutusmeetodi saab valida järgmiste kohta: 
• 1 – Aordi regurgitatsioon ja RF%
• 2 – Mitraalklapi regurgitatsioon ja RF%
• 3 – Kopsu regurgitatisoon ja RF%
• 4 – Trikuspidaalne regurgitatsioon ja RF%

Allajoonitud regurgitatsiooni väärtusi saab käsitsi sisestada. Lähtestamiseks 
kustutage väärtus ja vajutage sisestusklahvi. 

1

2

3

4
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Qp/Qs arvutamine
1. Integreeritud analüüsi funktsiooni kasutamiseks valige üleval paremal VOOL (FLOW), nagu on näidatud joonisel 19.

JOONIS 19. Voolu vahekaart

Tabel 7:  Qp/Qs valikud

MÄRKUS.  Kui veresoone kategoorial on rohkem kui üks mõõtmine, kasutatakse keskmist.

MÄRKUS. Qp või Qs jaoks saadakse väärtus ühest või kombineeritud valikust nagu on kirjeldatud tabelis.

Tulemus Valik Kirjeldus

Qp Voolu tulemus MPA kategooriast. 

Qp
(Pediaatria)

Voolu tulemus LPA-st + RPA-st.

Qs Voolu tulemus pAAo või mAAO kategooriast. Qs keskmise tulemuse jaoks valige 
mõlemad veresoone tüübid. 

Qs
(Pediaatria) 

Voolu tulemus LVOT kategooriast.

Qs
(Pediaatria) 

Voolu tulemus SVC + pDAo

Qs
(Pediaatria)

Voolu tulemus SVC + IVC

Qs
(Pediaatria)

Voolu tulemus SVC + dDAo

Qp/Qs= Tulemus põhineb eelnevatel valikutel.
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2. Enne integreeritud analüüsi kasutamist veenduge, et kõik veresooned on õigesti määratud ja kontuurid on täpsed 
kõigis kategooriates.

• Kui segmenteeritud veresoon on vales kategoorias, tehke paremklõps ja liigutage see õigesse kategooriasse.

• Kui segmenteeritud veresoon on selle kategooria jaoks vale veresoon, kustutage aktiivne ROI ja klõpsake .
• Kui on tehtud automaatne segmenteerimine ja veresoon ei ole õigesti määratletud, tehke segmenteerimine käsitsi. Vt 

Automaatne või käsitsi segmenteerimine lk 92.

HOIATUS! Kasutaja vastutab kõigi huvipakkuvate piirkondade (ROI) täpse paigutuse ja õige kategooria 
määramise eest, kaasa arvatud need, mis on genereeritud eeltöötluse käigus.

3. Qp jaoks valige .

4. Qs jaoks valige  või  või mõlemad veresoone kategooriad (kahe kategooria väärtustest võetakse keskmine).

5. Qp/Qs tulemus arvutakse nagu on näidatud joonisel 20.

JOONIS 20. Qp/Qs tulemused (näidatud täiskasvanu kohta)
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Arvutatud regurgitatsioonimaht ja regurgitatsiooni fraktsioon (RF%)
1. Integreeritud analüüsi funktsiooni kasutamiseks valige üleval paremal VOOL (FLOW), nagu on näidatud joonisel 21.

JOONIS 21. Voolu vahekaart

2. Enne integreeritud analüüsi kasutamist veenduge, et kõik veresooned on õigesti määratud ja kontuurid on täpsed 
kõigis kategooriates.

• Kui segmenteeritud veresoon on vales kategoorias, tehke paremklõps ja liigutage see õigesse kategooriasse. 

• Kui segmenteeritud veresoon on selle kategooria jaoks vale veresoon, kustutage aktiivne ROI ja klõpsake .
• Kui on tehtud automaatne segmenteerimine ja veresoon ei ole õigesti määratletud, tehke segmenteerimine käsitsi. Vt 

Automaatne või käsitsi segmenteerimine lk 92.

Tabel 8:  Regurgitatsioonimahu arvutamise meetodid

Valik Klapi tüüp Meetodi kirjeldus

Aordi Otse voolukõveralt (proksimaalne)

Aordi Otse voolukõveralt (keskmine)

Aordi
(Pediaatria)

LVOT positiivne voolukiirus – Qp

Mitraal Kaudne 
(Kasutatud LVSV saadakse lühikese telje funktsiooni tulemustest) 

Mitraal Kaudne
(Kasutatud LVSV väärtus saadakse lühikese telje funktsiooni tulemustest)

Kopsu Otse voolukõveralt (MPA)

Kopsu
(Pediaatria)

Otse voolukõveralt 
LPA + RPA negatiivne vool 

Trikuspidaal Kaudne
(Kasutatud RVSV saadakse lühikese telje funktsiooni tulemustest)

Trikuspidaal Kaudne
(Kasutatud RVSV saadakse lühikese telje funktsiooni tulemustest)
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HOIATUS! Kasutaja vastutab kõigi huvipakkuvate piirkondade (ROI) täpse paigutuse ja õige kategooria 
määramise eest, kaasa arvatud need, mis on genereeritud eeltöötluse käigus.

3. Valige arvutamise režiim. Joonisel 22 näidatud aordi regurgitatsioon ja regurgitatsiooni fraktsioon arvutatakse 

valikuga  ja kopsu regurgitatsioon ja regurgitatsiooni franktsioon arvutatakse valikuga .

JOONIS 22. Aordi- ja kopsuregurgitatsiooni meetodi valikud (näidatud täiskasvanu kohta)

4. Regurgitatsiooni maht ja RF% arvutatakse nii, nagu näidatud joonisel 22. Kasutatud nimetaja väärtus on aordi ja 
mitraalklapi jaoks LVSV ning trikuspidaalklapi ja kopsu jaoks RVSV. Teistsuguse väärtuse sisestamiseks tehke 
vasakklõpsa kolmnurgal ja sisestage väljale uus väärtus. Algväärtuse lähtestamiseks tühjendage lihtsalt väli ja vajutage 
sisestusklahvi, nagu on näidatud joonisel 23.

JOONIS 23. RF nimetaja
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5. Kui on valitud rohkem kui üks arvutusmeetod, võetakse regurgitatsiooni mahu tulemuste väärtustest keskmine. 

6. Mitraalregurgitatsiooni ja RF% arvutamiseks tuleb valida Qp, Qs ja aordi regurgitatsiooni meetod, nagu on näidatud 
joonisel 24.

7. Trikuspidaalregurgitatsiooni ja RF% arvutamiseks tuleb valida Qp, Qs ja pulmonaalse regurgitatsiooni meetod, nagu 
on näidatud joonisel 24.

8. Negatiivseid tulemusi peetakse kehtetuteks tulemusteks ja neid näidatakse kollase kolmnurgana, nagu joonisel 24.

JOONIS 24. Meetodi valik (näidatud täiskasvanu kohta)
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Integreeritud analüüsi tulemuste ülevaatamine

Kõikide tulemuste ülevaatamiseks valige . 

MÄRKUS. Voolu ühikute valik on integreeritud analüüsi paani ülaosas, valige ml/löök või l/min.

MÄRKUS. Tulemusi saab indekseerida BSA-sse, valides integreeritud analüüsi paani ülaosas valiku BSA indeks (Index 
to BSA). Nii pikkus kui ka kaal tuleb sisestada vahekaardile Ajalugu. 

JOONIS 25. Integreeritud tulemused
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Müokardi hindamine 
Kasutaja vastutab huvipakkuvate piirkondade (ROI) korrektse ja täieliku paigutamise eest, kaasa arvatud nende eest, mis 
genereeritakse või muudetakse automaatse segmenteerimise algoritmi poolt. Kvantitatiivsed väärtused, mille genereerib 
tarkvara, sõltuvad nende huvipakkuvate piirkondade täpsest ja täielikust paigutamisest ja rakendatud lävedest.

Uuringu eeltöötlemise funktsioon võimaldab Hilisemat täiustamist (Late Enhancement) eeltöödelda. Vt suiteDXT 
kasutusjuhendit.

Müokardi hindamise (ME) analüüsi tööriist aitab erineva signaaliintensiivsusega piirkondi müokardis kvantitatiivselt 
määratleda. 

Olemas on neli analüüsi vahekaarti.
• Hiline täiustamine (Late Enhancement) – määrab suurenenud ja madala signaaliintensiivsusega müokardi segmendid.
• T2 – määrab suurenenud signaali intensiivsusega müokardi segmendid musta verevoolu piltdiagnostika tehnikaga.
• Signaali diferentsiaal – kuvab taastumismassi tulemused kasutades Hilist täiustamist ja T2 analüüsi ja T2 signaali 

intensiivsuse (SI) suhet.
• Varane täiustamine (Early Enhancement) – määrab müokardi signaali intensiivsuse ja absoluutse müokardi täiustamise 

protsendi suhte T1 kaalutud kujutistest.

HOIATUS! Pärast eeltöötlust vastutab kasutaja kogu analüüsi täpsuse hindamise ja vajalike paranduste 
tegemise eest. Põhjalik ülevaade peaks sisaldama järgmist.
- ROI paigutamine/tuvastamine
- RV sisestamise koht
- Signaali intensiivsuse läve

HOIATUS! Rakendus ainult aitab kujutisi analüüsida ja ei anna automaatselt tulemuste kliinilist tõlgendust. 
Kvantitatiivsete mõõtmiste kasutamine ja paigutus on kasutaja äranägemisel. Kui mõõtmised on 
ebatäpsed, võib see tuua kaasa vale diagnoosi. Mõõtmised peaks tegema ainult nõuetekohaselt 
koolitatud ja kvalifitseeritud kasutaja.

Analüüsi vahekaart
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Mõõtetulemuste siltide määramine
Kasutaja saab mõõtetulemuste silte määrata; vaikimisi silt on Täiustamine (Enhancement).

1. Valige Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit).

2. Sisestage lisasildid tühjadele väljadele, nagu näidatud Joonis 1.

3. Valige vaikimisi silt. 
Seda silti kasutatakse kõikidel uutel analüüsidel. 

4. Klõpsake Salvesta ja välju (Save and Exit).

JOONIS 1. Siltide defineerimine

Mõõtmiste tabelis sildi muutmiseks tehke noolel vasakklõps, et valida uus silt. 

JOONIS 2. ME mõõtetulemuste sildid

Hilisema täiustamise analüüsimise protseduur

1. Valige .
2. Valige Hilise täiustamise (Late Enhancement) vahekaart.
3. Valige sobiv lühikese telje seeria.

4. Automaatseks segmenteerimiseks valige .
5. Vaadake üle kõik endokardi ja epikardi jooned, RV sisestuspunkt ja iga lõigu lävi. 

Vajadusel muutke läve.
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JOONIS 3. Müokardi hindamise analüüs

1. Tulemuste tabel, 2. Polaardiagrammi valik, 3. Polaardiagrammi kuva, 4. Tulemuste tabeli kuva, 5. Kustuta, 6. Polaardiagramm

6. Käsitsi segmenteerimiseks joonistage LV endokard põhimiku kõige kaugemas lõigus, valides .

7. Joonistage LV epikard valides .

8. Paigutage alumine RV sisestuspunkt, valides . 
9. ROI lõpetamiseks viige kursor redaktori aknast väljapoole.
10. Korrake samme 6–9, kuni kogu vatsake on segmenteeritud.
11. Veenduge põhimiku, keskosa ja tipu klassifitseerimises. 

1
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Läve valimine
1. Valige faili rippmenüüst sobiv läve algoritm (Joonis 4).

JOONIS 4. Läve algoritmi valimine

2. Kui vaja, klõpsake , et lõigu läve väärtust maksimeerida. Klõpsake , et rakendada seda väärtust 
kõikidele lõikudele. Vajadusel kasutage liugurit, et iga lõigu läve algoritmi kohandada.

3. Keskmise +2 kuni +7 SD tulemuste saamiseks, paigutage normaalne ROI  normaalse müokardi segmenti. See ROI 
kopeeritakse kõikidesse lõikudesse, kui märkeruut Levita normaalset ROI-d (Propagate Normal ROI) on valitud.

Läve muutmine

1. Kõrge intensiivsusega piirkondade lisamiseks valige . 

2. Madala intensiivsusega piirkondade lisamiseks valige .

3. Kummagi intensiivsusega piirkonna kustutamiseks valige  väike kustutamise tööriist või  suur kustutamise 
tööriist.

Polaardiagrammi kuvavormingud

ME analüüsi tööriistal on 2 polaardiagrammi vormingut: 16 segmendiga ja kontsentriline.

Suvand 1: 16 segmendiga polaardiagramm

1. Valige 16 segmendi (16 Segment) vahekaart .

2. Valige 2 värvi, 4 värvi või pidev.

Värvide kasutamist saab määrata värvide skaalaribal klõpsates.

Väärtuse protsendi muutmiseks klõpsake ja lohistage otse värvijaotajal.
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JOONIS 5. Polaardiagrammid

3.  Polaardiagrammi koondtabeli kuvamiseks valige .

Suvand 2: Lõik-lõigu haaval vorming
1. Valige Kontsentriline (Concentric) vahekaart. 

JOONIS 6. Kontsentriline vahekaart

Kontsentriline vahekaart pakub eelistusi, mis muudavad polaardiagrammi vormingu lõik-lõigu haaval vormingule, kus iga 
rõngas tähistab lõiku. Rõngaste arvu määrab analüüsitud lõikude arv.

2. Valige sektorite arv.

3. Valige alamsektorid, mis näitavad ROI massiprotsendi muutusi sektori kohta.

Alamsektorite valimisel rakendatakse silumisfunktsiooni.

4. Valige märkeruut Pidev (Continuous), et muuta polaardiagramm signaali intensiivsuse protsendiks ja kodeerida 
värvidega pideva spektri väärtused vahemikus 0–100%.

Kontuuride kustutamiseks klõpsake .

MÄRKUS. Hilise täiustamise analüüsi poolautomaatne lävi töötab optimaalselt kõrge kvaliteediga müokardi 
hindamise kujutistel, nagu näidatud allpool (illustratsioon A). Kujutistel, mis saadakse ilma signaalita 
verekogumilt (illustratsioon B) või vale inversiooni ajaga, peab kasutaja subjektiivselt läve sätestama. 

2 värviga polaardiagramm 4 värviga polaardiagramm
Sujuva värviüleminekuga 

polaardiagramm
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JOONIS 7. Müokardi hilise täiustamise kujutised

T2 Analüüs
1. Valge T2 vahekaart.

2. Kui hilise täiustamise seeriat on eelnevalt analüüsitud, saab ROI-d T2-seeriasse kopeerida, valides koopia (vt Joonis 8).

MÄRKUS. ROI-de kopeerimiseks peab täpsete tulemuste saamiseks lõikude arv iga seeria jaoks kokku langema; kui 
lõikude arv ei lange kokku, ei ole kopeerimisnupp saadaval. Kasutada saab DICOM-i importimist, et luua 
vastavad seeriad, mis sisaldavad sama arvu lõike.
Parimate tulemuste saavutamiseks peaksid ülesvõtte parameetrid, nagu maatriks ja FOV, olema iga seeria 
jaoks samad. Pärast kopeerimist vaadake hoolikalt üle kõigi lõikude asukohtade ROI-d ja tehke vajalikud 
muudatused.

JOONIS 8. Kopeerimise nupp
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3. Kui varasemat hilise täiustamise analüüsi ei ole, saab ROI-d luua käsitsi.

4. Joonistage LV endokard kõige põhimikupoolsele lõigule, valides .

5. Joonistage LV epikard valides .

6. Märkige alumine RV sisestuspunkt, valides .

7. ROI lõpetamiseks viige kursor redaktori aknast väljapoole.

8. Korrake samme 4–7, kuni kogu vatsake on segmenteeritud.

9. 2 standardhälbe läve jaoks valige Lisa normaalne ROI (Add Normal ROI)  ja pange ROI normaalsesse müokardi 
segmenti. See ROI kopeeritakse kõikidesse lõikudesse, kui märkeruut Levita normaalset ROI-d (Propagate Normal ROI) 
on valitud. Vaadake üle iga lõigu asukoht ja vajadusel kohandage ROI-d.

MÄRKUS. Kui skeletilihaste ROI ja normaalne ROI on saadud, teostab tarkvara järgmise arvutuse:
Normaliseeritud müokardi T2 SI = müokardi SI / skeletilihase SI; 
Läve arvutamine: Lävi = 2 * STD NORMAL + AVG NORMAL

10. Valige esimene põhimiku lõik ja kasutage lõikude klassifikatsiooni rippmenüüd, et valida Põhimik (Base). Kinnitage 
ülejäänud viilude klassifikatsioonid. Vajadusel kasutage liugurit, et iga lõigu läve algoritmi kohandada.

11. T2 signaali intensiivsuse analüüsi tegemiseks valige Lisa skeletilihase ROI (Add Skeletal muscle ROI)  ja pange ROI 
skeletilihasesse. See ROI kopeeritakse kõikidele kujutistele. Vaadake üle iga lõigu asukoht ja vajadusel kohandage ROI-d.

MÄRKUS. Musta vere kujutistel võib olla ebapiisav voolu summutamine, mis võib põhjustada signaali intensiivsuse 
ebatäpset analüüsi ja läve. Ebapiisav voolu summutamine võib põhjustada signaali kõrge intensiivsuse, 
mida võidakse segamini ajada müokardi tursega. Madala signaali intensiivsusega artefaktid võivad 
põhjustada vale madala tulemuse.

Redigeerimine

Kõrge T2 signaali intensiivsusega piirkondade lisamiseks valige .

Kõrge T2 signaali intensiivsusega piirkondade eemaldamiseks valige väike kustutustööriist  või suur kustutustööriist 

.

Kontuuride kustutamiseks klõpsake .
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Kombineeritud analüüs

Hiline täiustamine ja T2
Kombineeritud analüüsirežiim võimaldab hilise täiustamise ja T2 (turse) kujutiste jaoks kõrvuti analüüsi koos 
redigeerimistööriistadega.

MÄRKUS. Kombineeritud analüüsirežiimi lubamiseks tuleb vahekaardi Hiline täiustamine abil esmalt lõpule viia 
lühikese telje hilise täiustamise seeria analüüs. T2 (turse) kujutised peavad olema samas uuringus.

1. Valige .

2. Valige sobiv uuring nii Hilise täiustamine kui ka T2 (turse) kujutistega. Viige lõpule hilise täiustamise analüüsimise 
protseduur.

MÄRKUS. Enne kombineeritud analüüsirežiimi valimist vaadake vahekaardil Hiline täiustamine üle iga lühikese telje 
lõigu lävi. 

3. Valige vahekaart T2 ja viige läbi T2-seeria analüüsimise protseduur.
Tarkvara suiteHEART® kasutusjuhend NS-03-043-0003-ET Red. 2             121



4. Kombineeritud analüüsi alustamiseks valige , nagu näidatud Joonis 9.

JOONIS 9. Kombineeritud analüüsirežiim

5. Valiku tegemisel ilmuvad režiimi vaate aknasse varem analüüsitud hilise täiustamise seeriad. Sellest aknast saab siis 
redaktori aken hilise täiustamise kujutiste jaoks.

6. Hilise täiustamise kujutiste redigeerimiseks kasutage redigeerimistööriistu, mis asuvad kujutise vaateava all, nagu on 
näidatud joonisel 10.

MÄRKUS. Kinnitage kõik tulemuste uuendused otse vahekaardil Hiline täiustamine (Late Enhancement).

MÄRKUS. Kui LV endokardi või LV epikardi ROI-d on kustutatud, minge joonistamiseks uuesti vahekaardile Hiline 
täiustamine.

T2 (turse) Hiline
Täiustamine
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JOONIS 10. Hilise täiustamise redigeerimistööriistad

7. Vasaku T2 (turse) seeria redigeerimiseks kasutage redigeerimistööriistu, mis asuvad kujutise vaateava kohal, nagu 
näidatud Joonis 11.

JOONIS 11. T2 (turse) analüüsitööriistad
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8. Kasutage miinus- ja plussnuppe, et navigeerida hilise täiustamise seeria erinevale lõigutasemele, nagu on näidatud Joonis 12.
• Lõigu asukohateave asub iga vaateava alumises paremas nurgas.

MÄRKUS. Hilise täiustamise jaoks kuvatav lõigu asukoht määratakse T2 (turse) redaktori aknas lõigu asukoha järgi. 
Selle valiku tühistamiseks kasutage miinus-/plussnuppe. 

JOONIS 12. Hilise täiustamise lõikude sirvimise juhtnupud 

9. Teisele lõigutasandile navigeerimiseks nii hilise täiustamise kui T2 (turse) seeriatel kasutage T2 (turse) redaktori 
vaateava all olevaid miinus- ja plussnuppe, nagu näidatud Joonis 13. 

MÄRKUS. Kombineeritud analüüsirežiimis vasakul olevad miinus- ja plussnupud on ühised sirvitava lõigu mõlema 
vaateava jaoks.

JOONIS 13. Kombineeritud lõigu sirvimise juhtnupud

Lõigu asukoht Lõigu asukoht
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Signaali diferentsiaali tulemused
Valige signaali diferentsiaali vahekaart

MÄRKUS. Taastumismassi tulemuste saamiseks tuleb lõpule viia Hiline täiustamine ja T2 analüüs. T2 analüüs tuleb 
lõpetada skeletilihase ROI paigutamisega T2 signaali intensiivsuse (SI) analüüsi jaoks.

MÄRKUS. Kui T2 (turse) tulemus on väiksem kui hilise täiustamise tulemus (infarkt + MVO), on taastumismassi 
tulemus tühi.

JOONIS 14. Signaali diferentsiaali vahekaart
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Varase täiustamise analüüs
Analüüsiks on vajalikud lühikese telje kujutised, mis kasutavad väravatega spin-kaja T1 järjestust, eel- ja järeltäiustamist. 
Analüüs võimaldab algses seerias epikardi ja endokardi käsitsi segmenteerida kasutades kopeerimisfunktsiooni absoluutse 
võimenduse % (AE) ja Varase Gd täiustamise suhte (EGEr) arvutamiseks. Müokardi piirkondade analüüsimiseks saab 
kasutada kohalikku ROI-d. 

MÄRKUS. Musta vere kujutistel võib olla ebapiisav voolu summutamine, mis võib põhjustada signaali intensiivsuse 
ebatäpset analüüsi ja läve.

1. Valige Varase täiustamise (Early Enhancement) vahekaart.

2. Valige sobiv lühikese telje T1 kaalutud seeria. 

3. Joonistage LV endokard kõige põhimikupoolsele lõigule, valides .

4. Joonistage LV epikard valides .

5. Märkige alumine RV sisestuspunkt, valides .

6. ROI lõpetamiseks viige kursor redaktori aknast väljapoole.

7. Korrake samme 3–6, kuni kogu vatsake on segmenteeritud. 

8. Lisage skeletilihase ROI, valides .

9. Valige põhimiku lõigu asukoht. Klõpsake rippmenüüd Lõigu klassifitseerimine (Slice Classification) ja valige Põhimik 
(Base). 

10. Veenduge iga lõigu põhimiku, keskosa ja tipu klassifitseerimises. 
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11. Konkreetse müokardi piirkonna analüüsimiseks valige  ja joonistage müokardi ROI.

JOONIS 15. Lõikude klassifikatsioon ja seeriatüübi valik

12. Valige seeriatüüp Eelnev (Pre). 
Kui Varane Post (Early Post) seeria segmenteeriti kõigepealt, valige Varane Post (Early Post).

13. Valige sobiv lühikese teljega T1 kaalutud Varane Post (Early Post) seeria tüüp. 
Kui Varane Post (Early Post) seeria segmenteeriti kõigepealt, valige eelseeria (Pre series).

14. Valige Kopeeri.

15. Vaadake üle kõik endokardi ja epikardi jooned, RV sisenemine ja skeletilihaste paigutused ning redigeerige neid 
vastavalt vajadusele.

16. ROI-sid saab kopeerida ainult siis, kui kõik ROI-d ja RV-de sisenemised, lõikude klassifikatsioon, seeriatüüp (sammud 
3-12) on valitud seerias lõpetatud.

MÄRKUS. Kui endokardi või epikardi joon on kustutatud, kasutage Tühista (Undo).

MÄRKUS. Skeleti ROI-d saab reguleerida iga lõigu asukoha puhul. Kustutamise korral tuleb analüüs uuesti teha. 

17. Klõpsake  valige KÕIK (ALL): Varane täiustamine (Early Enhancement) kõikide analüüside eemaldamiseks.

MÄRKUS. ROI-de kopeerimiseks peab täpsete tulemuste saamiseks lõikude arv iga seeria jaoks kokku langema; kui 
lõikude arv ei lange kokku, ei ole kopeerimisnupp saadaval. Kasutada saab DICOM-i importimist, et luua 
vastavad seeriad, mis sisaldavad sama arvu lõike.

MÄRKUS. Parimate tulemuste saavutamiseks peaksid ülesvõtte parameetrid, nagu maatriks ja FOV, olema iga seeria 
jaoks samad. Pärast kopeerimist vaadake hoolikalt üle kõigi lõikude asukohtade ROI-d ja tehke vajalikud 
muudatused.
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Lokaalne ROI tööriist
1. Valige sobiv täiustamiseelne lühikese teljega T1 kaalutud seeria. 

2. Joonistage konkreetses müokardi piirkonnas lokaalne ROI, valides .

3. Lisage skeletilihase ROI, valides .

4. Valige õige lõigu klassifikatsioon ja seeria tüüp nagu näidatud Joonis 16.

JOONIS 16. Lõikude klassifikatsioon ja seeriatüübi valik

5. Valige sobiv lühikese teljega T1 kaalutud Varane Post (Early Post) seeria tüüp.

6. Valige Kopeeri. 

7. Klõpsake  valige KÕIK (ALL): Varane täiustamine (Early Enhancement) kõikide analüüside eemaldamiseks.

Soovitatud allikad

Abdel-Aty H, Boyé P, Zagrosek A, Wassmuth R, Kumar A, Messroghli D, Bock P, Dietz R, Friedrich MG, Schulz-Menger J. 
Diagnostic performance of cardiovascular magnetic resonance in patients with suspected acute myocarditis: comparison 
of different approaches. J Am Coll Cardiol. 2005 Jun 7;45(11):1815-22. doi: 10.1016/j.jacc.2004.11.069. PMID: 15936612.

Amado LC, Gerber BL, Gupta SN, Rettmann DW, Szarf G, Schock R, Nasir K, Kraitchman DL, Lima JA. Accurate and objective 
infarct sizing by contrast-enhanced magnetic resonance imaging in a canine myocardial infarction model. J Am Coll 
Cardiol. 2004 Dec 21;44(12):2383-9. doi: 10.1016/j.jacc.2004.09.020. PMID: 15607402.

Berry C, Kellman P, Mancini C, Chen MY, Bandettini WP, Lowrey T, Hsu LY, Aletras AH, Arai AE. Magnetic resonance imaging 
delineates the ischemic area at risk and myocardial salvage in patients with acute myocardial infarction. Circ Cardiovasc 
Imaging. 2010 Sep;3(5):527-35. doi: 10.1161/CIRCIMAGING.109.900761. Epub 2010 Jul 14. PMID: 20631034; PMCID: 
PMC2966468.

Ferreira VM, Schulz-Menger J, Holmvang G, et al. Cardiovascular Magnetic Resonance in Nonischemic Myocardial 
Inflammation: Expert Recommendations. J Am Coll Cardiol. 2018;72(24):3158-3176. doi:10.1016/j.jacc.2018.09.072.

Galea N, Francone M, Fiorelli A, Noce V, Giannetta E, Chimenti C, Frustaci A, Catalano C, Carbone I. Early myocardial 
gadolinium enhancement in patients with myocarditis: Validation of “Lake Louise consensus” criteria using a single bolus 
of 0.1mmol/Kg of a high relaxivity gadolinium-based contrast agent. Eur J Radiol. 2017 Oct;95:89-95. doi: 10.1016/
j.ejrad.2017.07.008. Epub 2017 Jul 27. PMID: 28987703.
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T1 kaardistamise analüüs
See funktsioon võimaldab mõõta pikisuunalise spinn-võre relaksatsiooniaja (T1) signaali. Rakendus toetab T1 analüüsi nii 
algsete (täiustamata) kui ka täiustusjärgsete kujutiste jaoks ning ekstratsellulaarse mahufraktsiooni (ECV) arvutamist.

Vajalikud kujutised: erinevate inversiooniaegadega (TI) inversiooni või küllastuse taastamise kujutised või järjestusesisesed 
kaardid. Analüüsiks soovitatakse seeriaid, millel on rakendatud liikumise korrektsiooni. Soovitatavad on vasaku vatsakese 
põhimiku, keskosa ja tipu tüüpilised lõikude asukohad.

Täiendavate juhiste saamiseks T1 kaardistamise teostamise kohta vaadake järgmist artiklit.

Messroghli, D.R., Moon, J.C., Ferreira, V.M. et al. Clinical recommendations for cardiovascular magnetic resonance 
mapping of T1, T2, T2* and extracellular volume: A consensus statement by the Society for Cardiovascular Magnetic 
Resonance (SCMR) endorsed by the European Association for Cardiovascular Imaging (EACVI). J Cardiovasc Magn Reson 
19, 75 (2017). https://doi.org/10.1186/s12968-017-0389-8

HOIATUS! Pärast eeltöötlust vastutab kasutaja kogu analüüsi täpsuse hindamise ja vajalike paranduste 
tegemise eest. Põhjalik ülevaade peaks sisaldama järgmist.
- ROI paigutamine/tuvastamine
- RV sisestamise koht

HOIATUS! Rakendus ainult aitab kujutisi analüüsida ja ei anna automaatselt mõõdetavaid tulemusi. 
Kvantitatiivsete mõõtmiste kasutamine ja paigutus on kasutaja äranägemisel. Kui mõõtmised on 
ebatäpsed, võib see tuua kaasa vale diagnoosi. Mõõtmised peaks tegema ainult nõuetekohaselt 
koolitatud ja kvalifitseeritud kasutaja.

HOIATUS! Kasutaja vastutab kõigi huvipakkuvate piirkondade (ROI) täpse paigutamise eest, sealhulgas 
automaatse segmenteerimisega loodud piirkondade eest.

MÄRKUS. T1 kaardistamise eelistuste seadistamiseks valige Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri 
(Edit). Valige T1/T2 kaardistamise (T1/T2 Mapping) vahekaart.

MÄRKUS. Soovitav on oma skanneri tüübi eelistustes seadistada e Automaatne seeriate koostamine analüüsiks 
(Auto Compose Series for Analysis). Analüüsiks on vaja, et kõik lõigu asukohad oleksid ühes seerias. Valige 
Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit). Valige T1/T2 kaardistamise (T1/T2 
Mapping) vahekaart.
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JOONIS 1. T1 kaardistamise liides

1. Automaatne segmenteerimine, 2. T1 tulemused, 3. Hematokriti sisestamine, 4. Järjestuse tüübi valimine, 5. Värvikaardi ülekatte valikud, 
6. Värvikaardi suvandid, 7. Kuvatava sektori ülekate, 8. Redigeerimise levitamine, 9. Endo/Epi nihe, 
10. Kõver või 16 segmendiga polaardiagramm või tabel, 11. T1 kõverad 

Analüüsi tegemine

1. Valige .
2. Valige sobiv ajaseeria või kaardiseeria.
3. Värvikaart kuvatakse automaatselt, kui ülekatte eelistus on valitud.
4. Erineva värviskaala valimiseks kasutage faili rippmenüüd.

5. Üleüldise T1 tulemuse loomiseks valige .

6. Vaadake üle kõik endokardi ja epikardi jooned, RV sisestuspunkt ja verekogumi paigutus.

7. Redigeerige ebatäpseid kontuure.

9

3
4

1

2

5 67 8

10

11
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8. Kasutage kontuuride muutmiseks nihkenuppu Endo (punane) või Epi (roheline). 

 Levita nihet kõikidele lõikudele.  Ühe lõigu nihe.

9. Ühe inversiooniaja redigeerimiseks tühjendage märkeruut .

10. Kinnitage lõikude klassifikatsioon iga lõigu ja seeriatüübi jaoks.

MÄRKUS. Kui lühikese teljega kujutiste virn on segmenteeritud, võetakse T1 tulemuse keskmine põhimiku, keskosa 
või tipu ja 16-segmendiliste polaardiagrammi sektorite jaoks lõikude klassifikatsiooni alusel. Verekogumi T1 
tulemuse puhul ei võeta keskmist.

11. ECV arvutamiseks tehke automaatne segmenteerimine nii algseeriale kui ka täiustamisjärgsetele seeriatele.

12. Vaadake üle kõik endokardi ja epikardi jooned, RV sisestuspunkt ja verekogumi paigutus mõlemas seerias.

13. Müokardi segmendi mõõtmiseks valige .

MÄRKUS. Lokaalse ROI kopeerimiseks kasutage kopeerimist/kleepimist algkujutiselt täiustamisjärgsele kujutisele, kui 
ECV arvutatakse.

MÄRKUS. Saab luua kuni viis lokaalse ROI mõõtmist põhimiku, keskosa ja tipu jaoks.

14. Verekogumi ROI paigutamiseks valige , kui vaja. 

15. Sisestage hematokriti (HCT) väärtus.

16. ECV tulemus (%) kuvatakse tulemuste tabelis.

17. Käsitsi segmenteerimine on võimalik. 

• Joonistage LV endokard valides .

• Joonistage LV epikard valides .

• Märkige RV sisestuspunkt, valides .

• Kui arvutatakse ECV paigutage verekogumi ROI valides .

• Kinnitage lõikude klassifikatsioon iga lõigu ja seeriatüübi jaoks.

Soovitatud allikas 

Wong. et al,. ”Association Between Extracellular Matrix Expansion Quantified by Cardiovascular Magnetic Resonance and 
Short-Term Mortality.” Circulation (2012):126:1206-1216.
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16 segmendiga polaarkaart
MÄRKUS. ECV polaardiagrammiks peab ECV analüüsi olema lõpule viidud.

1. Lõpetage üldine T1 analüüs põhimiku, keskosa ja tipu vahekaartide jaoks.

2. Kinnitage RV sisestuspunkt iga lõigu asukoha jaoks. 

3. Kinnitage õige lõikude klassifikatsioon ja seeria tüüp.

4. Valige 16-segmendiga polaardiagramm .

5. Sektori ülekatte kuvamiseks otse kujutisel valige .

6. Kui analüüsiti ajaseeriat, valige T1 kõverate juurde naasmiseks Graafikud .

T1 tulemuste väärtuste vorming

Tulemus DICOM-i kujutised Kaardi kujutised

Üldine keskmine +/– std keskmine +/– std

Põhimik/keskosa/tipp väärtus +/– viga keskmine +/– std

Kohalikud ROI-d väärtus +/– viga keskmine +/– std

Kohalik keskmine +/– std keskmine +/– std

Verekogum väärtus +/– viga keskmine +/– std
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Kontuuride kustutamine

Valitud seeria KÕIKIDE (ALL) kontuuride kustutamiseks valige .

Ühe kontuuri kustutamiseks tehke kontuuril vasakklõps ja seejärel paremklõps või valige , et kustutada kontuurid 
kõikides ajapunktides.

T1 kõvera ülevaatamine 
1. Kõverale sobivad tulemused näitavad kujutise andmete signaali käitumist. Valest registreerimisest, hingamisest või 

arütmiatest tingitud kujutise artefaktide korral ei pruugi kõvera sobivus olla optimaalne.
2. Signaali intensiivsuse punkti saab arvutusest välja jätta, klõpsates otse graafiku vastaval punktil ja valides kujutisel 

kontuuri, mis muutub lillaks.
3. Valige paremklõpsumenüüst kustutamine (klõpsake ja hoidke all) või vajutage klaviatuuril kustutusklahvi.

MÄRKUS. Kõvera kuva genereeritakse ainult analüüsiks kasutatavate ajaseeriate abil.

HOIATUS! T1 kõverale sobivad tulemused peaks üle vaatama nõuetekohaselt koolitatud ja kvalifitseeritud 
kasutaja. 

Soovitatud allikas 

*Messroghli D. R. et al,. ”Modified Look-Locker Inversion Recovery (MOLLI) for High Resolution T1 Mapping of the Heart.” 
Magnetic Resonance in Medicine (2004) 52: 141-146. 

Tulemus Võrrand Sobivuse tüüp

T1 Look-Locker (MOLLI) y=A-B exp(-t/T1*) Mittelineaarne kõvera sobivus, mis kasutab Levenberg-Marquardt 
algoritmi*
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Siemens MyoMaps inversiooni korrigeerimise faktor 
(ICF)
Skanneri genereeritud T1 kaardiga sarnaste ajaseeriate kujutiste analüüsimisel T1 tulemuste saamiseks kinnitage 
MyoMaps MOLLI protokollide jaoks kasutatud efektiivsuse inversiooniimpulss. Soovitatav on inversiooniparanduse tegur 
ICF = 1,0365, kui skanneril on jaotises Magn Preparation Contrast/Common kaardi all märgitud „Non-sel IR T1 Map“. 
Täiendava selgituse saamiseks on soovitatav võtta ühendust oma Siemensi rakenduste tugispetsialistidega.

Ajaseeriate kujutiste analüüsimiseks sisestage eelistustes sobiv ICF, nagu näidatud Joonis 2.

1. Valige Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit).

2. Valige T1/T2 kaardistamise (T1/T2 Mapping) vahekaart.

3. Tarnijast lähtuvalt sisestage ICF.

JOONIS 2. T1 kaardistamise eelistused

Soovitatud allikas

Kellman, P., Hansen, M.S. T1-mapping in the heart: accuracy and precision. J Cardiovasc Magn Reson 16, 2 (2014).
https://doi.org/10.1186/1532-429X-16-2
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T2 kaardistamise analüüs
See funktsioon võimaldab T2 lõõgastusaja signaali mõõta. T2 kaardistamine on kudede iseloomustamise tehnika.

Vajalikud kujutised: T2 ettevalmistuse järjestus stabiilse oleku vaba pretsessiooni näiduga koos varieeruvate kajaaegadega 
(TE) või järjestusesisesed kaardid. Analüüsiks soovitatakse seeriaid, millel on rakendatud liikumise korrektsiooni. 
Soovitatavad on vasaku vatsakese põhimiku, keskosa ja tipu tüüpilised lõikude asukohad.

Mittelineaarse 2-punktilise võrrand on y = a * exp(-TE/T2), kus TE on kajaaeg või T2 ettevalmistuse kestus, olenevalt 
järjestusest.

Mittelineaarse 3-punktilise võrrand on y = a * exp(-TE/T2) + c, kus a, T2 ja c on koefitsiendid (parameeter tuleb arvestada 
sobivuse järgi).

Lineaarse 2-punktilise võrrand on Y = A – TE/T2, kus Y = log(y) ja A = log(a).

MÄRKUS.  Lineaarse ja mittelineaarse 2-punktilise sobitamise korral tausta lahutamist ei tehta.

Täiendavate juhiste saamiseks T2 kaardistamise teostamise kohta vaadake järgmist artiklit.

Messroghli, D.R., Moon, J.C., Ferreira, V.M. et al. Clinical recommendations for cardiovascular magnetic resonance 
mapping of T1, T2, T2* and extracellular volume: A consensus statement by the Society for Cardiovascular Magnetic 
Resonance (SCMR) endorsed by the European Association for Cardiovascular Imaging (EACVI). J Cardiovasc Magn Reson 
19, 75 (2017). https://doi.org/10.1186/s12968-017-0389-8

HOIATUS! Pärast eeltöötlust vastutab kasutaja kogu analüüsi täpsuse hindamise ja vajalike paranduste 
tegemise eest. Põhjalik ülevaade peaks sisaldama järgmist.
- ROI paigutamine/tuvastamine
- RV sisestamise koht

HOIATUS! Rakendus ainult aitab kujutisi analüüsida ja ei anna automaatselt mõõdetavaid tulemusi. 
Kvantitatiivsete mõõtmiste kasutamine ja paigutus on kasutaja äranägemisel. Kui mõõtmised on 
ebatäpsed, võib see tuua kaasa vale diagnoosi. Mõõtmised peaks tegema ainult nõuetekohaselt 
koolitatud ja kvalifitseeritud kasutaja.

HOIATUS! Kasutaja vastutab kõigi huvipakkuvate piirkondade (ROI) täpse paigutamise eest, sealhulgas 
automaatse segmenteerimisega loodud piirkondade eest.

MÄRKUS. T2 kaardistamise eelistuste seadistamiseks valige Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri 
(Edit). Valige T1/T2 kaardistamise (T1/T2 Mapping) vahekaart.
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MÄRKUS. Soovitav on oma skanneri tüübi eelistustes seadistada e Automaatne seeriate koostamine analüüsiks 
(Auto Compose Series for Analysis). Analüüsiks on vaja, et kõik lõigu asukohad oleksid ühes seerias. Valige 
Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit). Valige T1/T2 kaardistamise (T1/T2 
Mapping) vahekaart.

JOONIS 1. T2 kaardistamise liides

1. Automaatne segmenteerimine, 2. T2 tulemused, 3. Parameetrite sobitamise valikud, 4. Värvikaardi ülekatte valikud, 5. Värvikaardi suvandid, 
6. Kuvatava sektori ülekate, 7. Redigeerimise levitamine, 8. Endo/Epi nihe, 9. kõver või 16 segmendiga polaardiagramm või tabel, 10. Polaardiagramm 

Analüüsi tegemine

1. Valige .
2. Valige sobiv ajaseeria või kaardiseeria. 
3. Ajaseeriate analüüsimisel valige sobitamismeetod.

MÄRKUS. Mittelineaarse sobitamise algoritm ei võta arvesse taustamüra.

1

2

3
4
5 6 7

8
9

7

10
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4. Kui soovite, seadistage värvikaardi eelistus automaatselt värvikaarti kuvama.
5. Erineva värviskaala valimiseks kasutage faili rippmenüüd.

6. Üleüldise T2 tulemuse loomiseks valige .
7. Vaadake üle kõik endokardi ja epikardi jooned ning RV sisestuspunkt.

8. Redigeerige ebatäpseid kontuure.

9. Kasutage kontuuride kohandamiseks Endo (punane) või Epi (roheline) nihet 

.

 Levita nihet kõikidele lõikudele.  Ühe lõigu nihe.

10. Ühe ajakaja redigeerimiseks tühjendage märkeruut .

11. Kinnitage lõikude klassifikatsioon iga lõigu ja seeriatüübi jaoks.

MÄRKUS. Kui lühikese teljega kujutiste virn on segmenteeritud, võetakse T2 tulemuse keskmine põhimiku, keskosa 
või tipu ja 16-segmendiliste polaardiagrammi sektorite jaoks lõikude klassifikatsiooni alusel.

12. Müokardi segmendi mõõtmiseks valige .

MÄRKUS. Saab luua kuni viis lokaalse ROI mõõtmist põhimiku, keskosa ja tipu jaoks.

13. Käsitsi segmenteerimine on võimalik. 

• Joonistage LV endokard valides .

• Joonistage LV epikard valides .

• Märkige RV sisestuspunkt, valides .

• Kinnitage lõikude klassifikatsioon iga lõigu asukoha kohta.
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16 segmendiga polaarkaart
1. Lõpetage põhimiku, keskosa ja tipu T2 üldine analüüs.

2. Kinnitage RV sisestuspunkt iga lõigu asukoha jaoks.

3. Kinnitage õige lõigu klassifitseerimine.

4. Valige 16-segmendiga polaardiagramm .

5. Sektori ülekatte kuvamiseks otse kujutisel valige .

6. Kui analüüsiti ajaseeriat, valige T2 kõverate juurde naasmiseks graafikud .

T2 tulemuste väärtuste vorming

Tulemus DICOM-i kujutised Kaardi kujutised

Üldine keskmine +/– std keskmine +/– std

Põhimik/keskosa/tipp väärtus +/– viga keskmine +/– std

Kohalikud ROI-d väärtus +/– viga keskmine +/– std

Kohalik keskmine +/– std keskmine +/– std
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Kontuuride kustutamine

Valitud seeria KÕIKIDE (ALL) kontuuride kustutamiseks valige  .

Ühe kontuuri kustutamiseks tehke kontuuril vasakklõps ja seejärel paremklõps või valige , et kustutada kontuurid 
kõikides ajapunktides.

T2 kõvera ülevaatamine
1. Kõverale sobivad tulemused näitavad kujutise andmete signaali käitumist. Kokkupakkimisest, valest registreerimisest, 

hingamisest või arütmiatest tingitud kujutise artefaktide korral ei pruugi kõvera sobivus olla optimaalne.

2. Signaali intensiivsuse punkti saab arvutusest välja jätta, klõpsates otse graafiku vastaval punktil ja valides kujutisel 
kontuuri, mis muutub lillaks.

3. Valige paremklõpsumenüüst kustutamine (klõpsake ja hoidke all) või vajutage klaviatuuril kustutusklahvi.

MÄRKUS. Kõvera kuva genereeritakse ainult analüüsiks kasutatavate ajaseeriate abil.

HOIATUS! T2 kõverale sobivad tulemused peaks üle vaatama nõuetekohaselt koolitatud ja kvalifitseeritud 
kasutaja. 
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Müokardi perfusioon 

Müokardi perfusiooni analüüsirežiim võimaldab kasutajal vaadata ja analüüsida müokardi perfusiooni kujutisi. Analüüsiks 
soovitatakse seeriaid, millel on rakendatud liikumise korrektsiooni.

MÄRKUS. Toetatakse poolkvantitatiivset analüüsi. Kui on olemas kahe järjestusega seeria, saab rakendada varjutuse 
korrigeerimist. 

MÄRKUS. Soovitatav on luua üks stressperfusiooniga ja liikumise korrigeerimisega kujutiste seeria ning üks 
puhkeoleku liikumise korrigeerimisega kujutiste seeria.

ETTEVAATUST! Tõusu ja suhtelise tõusu parameetrid ei pruugi olla täpsed kujutistel, millel pole varjutuse 
korrigeerimist tehtud.

HOIATUS! Rakendus ainult aitab kujutisi analüüsida ja ei anna automaatselt tulemuste kliinilist tõlgendust. 
Kvantitatiivsete mõõtmiste kasutamine ja paigutus on kasutaja äranägemisel. Kui mõõtmised on 
ebatäpsed, võib see tuua kaasa vale diagnoosi. Mõõtmised peaks tegema ainult nõuetekohaselt 
koolitatud ja kvalifitseeritud kasutaja.

JOONIS 1. Müokardi perfusiooni analüüsi liides
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Tabel 1:  Analüüsitööriistad

Levita kõikidele lõikudele, kõikidele faasidele.

Levita kõikidele faasidele, ühele lõigule.

Tee automaatne segmenteerimine.

Arvuta analüüs pärast redigeerimist uuesti. (Ainult automaatse segmenteerimise 
korral.)

Kopeeri/kleebi kontuurid kõikidele faasidele. 

Arvuta analüüs pärast redigeerimist uuesti. (Ainult, kui on kopeeritud/kleebitud.)

Varjutuse korrigeerimine rakendatud.

Kuva segmendi värvülekate.

Kuva ilma ülekatteta.

Kuva arvutatud parameetri piksli kaupa värvülekate.

Kuva graafik.

Kuva stressi- ja rahuoleku graafik.

Kuva parameetri tulemuste tabel.

16, 32, 48, 96 segmendiga või kontsentrilise polaardiagrammi valimine.

2, 4 või sujuva värviüleminekuga polaardiagrammi värvide valimine.

Kontsentrilise polaardiagrammi valikud.
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Müokardi perfusiooni analüüsi tegemine

1. Valige .

2. Valige Stressi (Stress) või Rahuoleku (Rest) vahekaart. 

   

3. Valige müokardi perfusiooni seeria.

4. Automaatseks segmenteerimiseks ja analüüsi arvutamiseks valige .

5. Vaadake üle iga lõigu endokardi ja epikardi jooned, RV sisestuspunkt ja vajadusel redigeerige.

6. Veenduge põhimiku, keskosa ja tipu klassifitseerimises.

7. Käsitsi segmenteerimiseks valige , et joonistada endokardi kontuur ühele või kõikidele lõikudele.

8. Valige , et joonistada epikardi kontuur ühele või kõikidele lõikudele.

9. Valige , et kopeerida/kleepida kontuurid kõikidele faasidele.

10. Paigutage alumine RV sisestuspunkt, valides .

11. Vaadake üle iga lõigu endokardi ja epikardi jooned, RV sisestuspunkt ja vajadusel redigeerige.

12. Veenduge põhimiku, keskosa ja tipu klassifitseerimises.

13. Analüüsiks kasutatavad algus- ja lõpukaadrid määratakse automaatselt saabumisaja ja tippaja järgi. Kohandamiseks 

valige .

• Algusfaasi määramiseks klõpsake , seejärel klõpsake otse maatriksi lahtrile. 

• Lõppfaasi määramiseks klõpsake , seejärel klõpsake otse maatriksi lahtrile.
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Kontuuri redigeerimine

Pärast redigeerimist tuleb analüüs uuesti arvutada. Ilmub redigeerimise hoiatusmärk. Klõpsake  uuesti 
arvutamiseks.

Tulemuste ülevaatamine
1. Arvutatud parameetri ülevaatamiseks valige see faili rippmenüüst. Vt Joonis 2.

Kui panna kursor polaardiagrammil segmendi kohale, tõstetakse esile vastava segmendi graafik.

JOONIS 2. Arvutatud parameetrite rippmenüü

Graafiku/tabeli tulemuste ülevaatamine
1. Graafiku tulemuste ülevaatamiseks valige see rippmenüüst, Joonis 3, mis asub graafiku kuva all vasakul.

2. Graafiku kuvamiseks klõpsake .

Segmendi värvülekatte kuvamisel tõstab kursori asetamine otse värvilisele segmendile esile selle segmendi 
vastava graafiku.

3. Nii stress- kui rahuolekukõverate kuvamiseks klõpsake .

4. Parameetrite tulemuste kuvamiseks klõpsake .
JOONIS 3. Graafiku tulemused
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Suhtelise tõusu (RU) ja reservi indeksi (RI) arvutamine
1. Verekogumi ROI paigutatakse automaatse segmenteerimise ajal automaatselt.

2. Verekogumi lõigu asukoha muutmiseks kasutage pisipiltide vaadet, et valida mõni muu lõigu asukoht. Uue 

verekogumi ROI automaatseks loomiseks valige  või .

3. Verekogumi ROI käsitsi paigutamiseks valige , joonistage ROI ja seejärel valige  või .

Soovitatav on põhimiku lõigu tase.

4. Verekogumi ROI kustutamiseks tehke paremklõps ja valige 

MÄRKUS. Reservi indeksi arvutamiseks peab olema olemas nii stressi- kui rahuoleku analüüs.

ETTEVAATUST! Südamelihase perfusiooni tõusu ja suhtelise tõusu parameetrid ei pruugi olla täpsed kujutistel, 
millel pole varjutuse korrigeerimist tehtud. 
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Müokardi perfusiooni kõvera alusel arvutatud paremeetrite definitsioonid

 

Saabumisaeg aeg (sekundites) algtaseme ja tõusu ristumisel

Tippaeg aeg (sekundites), mil signaali intensiivsus saavutab oma maksimumi 

SI suhe SI(tippaeg – algtase)/ algtase

Tõus Tõus arvutatakse kaalutud lineaarse sobitamise abil, kasutades saabumisaja ja tippaja 
vahelisi punkte

Suhteline tõus RU = müokardi tõus / verekogumi tõus

Reservi indeks Müokardi reservi indeks (RU) defineeritakse nii:
                    RI = RU STRESS / RU RAHUOLEK

Signaali intensiivsus

Tõus

Täiustamine

Algtase

Saabumisaeg Tippaeg
Aeg
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Avatud ovaalmulgu (PFO) 
analüüs 

PFO analüüsi tööriist võimaldab genereerida signaali-aja kõvera, mis näitab PFO tuvastamise varajast tippu. 

HOIATUS! Rakendus ainult aitab kujutisi analüüsida ja ei anna automaatselt tulemuste kliinilist tõlgendust. 
Kvantitatiivsete mõõtmiste kasutamine ja paigutus on kasutaja äranägemisel. Kui mõõtmised on 
ebatäpsed, võib see tuua kaasa vale diagnoosi. Mõõtmised peaks tegema ainult nõuetekohaselt 
koolitatud ja kvalifitseeritud kasutaja.

PFO käivitamine
1. Valige Fail (File) > Vali analüüs (Select Analysis) > PFO.

 

2. Valige reaalaja seeria.
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JOONIS 1. PFO analüüsimise aken

1. PFO redigeeritavad vahekaardid, 2. Aktiivsed ROI-d, 3. Kustuta, 4. Alusta ja lõpeta faas, 5. Signaali intensiivsuse ja faasi suhte kõver, 
6. PFO analüüsi ikoonid

Koja anatoomia valimine

Valige kujutis, kus saab vasaku koja (LA) ja parema koja (RA) anatoomiat hinnata.

Vasaku koja (LA) intensiivsuse kõvera genereerimine

1. Joonistage kõver, valides . 

2. Joonistage Kujutiseredaktori (Image Editor) aknas LA kontuur. 

3. Viige kursor Kujutiseredaktori (Image Editor) aknast väljapoole.

4. Genereerige LA intensiivsuse kõver.

LA signaali intensiivsuse kõver genereeritakse automaatselt.

Parema koja (RA) intensiivsuse kõvera genereerimine
1. Genereerige RA intensiivsuse kõver järgides samu samme, mis loetletud LA intensiivuse kõvera jaoks, kasutades 

.

Kõverad asetatakse üksteise peale ja kuvatakse kõvera tulemuste aknas.

1
3

5

6

2

4
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MÄRKUS. Kui ROI on näiteks paigutatud faasi 1 ja algusfaasi muudetakse, on kasutaja joonistatud ROI endiselt 
originaalkujutisel olemas seal, kuhu ROI paigutati.

JOONIS 2. PFO kõvera tulemused

Kõvera tulemuste ülevaatamine ja faasivahemiku valimine
1. Vaadake aruande aknas kõverad üle ja kohandage Algusfaasi (Start Phase) ja Lõpufaasi (End Phase).
2. Kasutage üles- ja allanooli, et valida Algusfaas (Start Phase) ja Lõppfaas (End Phase) kõvera kuvamise vahemiku 

seadistamiseks.

Algus- ja lõppfaaside kohandamine mõjutab PFO-kõvera kuvamist.

Graafiku mingil punktil klõpsamine uuendab kuvatavad faasid Kujutiseredaktori (Image Editor) aknas.

JOONIS 3. Algus- ja lõppfaasi valimise kuva

MÄRKUS. Kui samas seerias on kaks ülesvõtet, saate määrata esimese võtte algus- ja lõppfaasi, joonistada LA ja RA 
ROI-d (mille tulemuseks on kõverate automaatne genereerimine) ja seejärel korrata protsessi teisel PFO 
vahekaardil teise kujutiste komplekti jaoks. Kõik PFO vahekaardi sildid on redigeeritavad.
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Kontuuride redigeerimine

Mitme faasi redigeerimine ühes lõigu asukohas.

1. Valige lõigu asukoht

2. Valige 

3. Valige redigeeritavate faaside vahemiku esimene faas.
4. Vajutage ja hoidke all Shift-klahvi ning valige redigeeritava vahemiku viimane faas.

Valitud pisipilte kuvatakse esiletõstetuna ja punase servaga.

5. Redigeerige kontuuri Kujutiseredaktori (Image Editor) aknas.
6. Tühistage kontuuri valik, klõpsates kujutisel valitud kontuurist eemal või liigutades kursorit redaktori aknast 

väljapoole.

ROI redigeerimist saab juhtida ulatuse määramisega.

Valige kujutisevaaturis sobiv ulatuse funktsioon.

 Ulatus kõik (Scope All) – rakendab ROI muudatused kõikidele faasidele.

 Ulatus praegune kuni lõpp (Scope Current to End) – rakendab ROI muudatused praegusest faasist lõpuni.

 Ulatus ainult praegune (Scope Current Only) – rakendab ROI muudatused ainult praegusele faasile.

Kontuuride kustutamine

Kõikide (ALL) kontuuride kustutamiseks klõpsake .

Kõikides ajapunktides kontuuride kustutamiseks tehke kujutisel vasakklõps ja seejärel paremklõps valimaks .

Lõplike kõveratulemuste ülevaatamine

Kontuurist lähtuvalt genereeritakse pikslite intensiivsuse-aja graafik. Aruandesse saatmiseks tehke paremklõps .
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T2*

T2* analüüsi tööriist arvutab T2* koe väärtused mitme kajaga kiire gradiendi kajajada järgi.

T2* kõver on signaali intensiivsuse ja kajaaja graafik, mis kasutab eksponentsiaalse sumbumiskõvera valemit. T2* 
sobitusalgoritm põhineb Levenberg-Marquardti mittelineaarsel vähimruutude algoritmil.

T2* sumbumiskõvera arvutus on järgmine: y = a *exp(-TE/T2*) + c

 Kus

HOIATUS! Rakendus ainult aitab kujutisi analüüsida ja ei anna automaatselt tulemuste kliinilist tõlgendust. 
Kvantitatiivsete mõõtmiste kasutamine ja paigutus on kasutaja äranägemisel. Kui mõõtmised on 
ebatäpsed, võib see tuua kaasa vale diagnoosi. Mõõtmised peaks tegema ainult nõuetekohaselt 
koolitatud ja kvalifitseeritud kasutaja.

Tabel 1:  

y on signaali intensiivsus ajahetkel TE

a on ristmagnetiseeritus ajahetkel 0 (null)

TE on kajaaeg

T2* on sumbumise konstant ja

c on taustamüra
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Südame analüüsimise protseduur
JOONIS 1. T2* analüüsi liides

1. Valige . 

2. Valige sobiv seeria.

3. Valige pisipiltide paanilt lühikese telje lõik.

4. Joonistage kontuur, mis hõlmab vatsakeste vaheseina kasutades .

Arvutatakse T2* ja R2*, mida kuvatakse tulemuste tabelis.

Arvutatakse R2 väärtus, mida kuvatakse graafikus.
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Müokardi värvikaardi loomine

1. Joonistage endokardi piirjoone kontuur kasutades .

2. Joonistage epikardi piirjoone kontuur kasutades . 

T2*/R2* värvikaart pannakse kujutise peale. 

3. R2* värvikaardi väärtust saab muuta.

MÄRKUS. T2* puhul on 1.5T kujutiste vaikevahemik 5–500 ms. T2* puhul on 3.0T kujutiste vaikevahemik 2,5–
1000 ms. 

4. Värvikaardi dünaamilise värvivahemiku reguleerimiseks klõpsake ja lohistage nooltel üles või alla. 

Värvülekate Kujutiseredaktori (Image Editor) aknas muutub dünaamiliselt.

Hz ja ms väärtused muutuvad samuti dünaamiliselt.

5. T2* and R2* väärtusi saab määrata valides  ja pannes selle kujutisel värvikaardi ülekatte peale.

Parameetrite sobitamine
T2* sumbumiskõverale valige 2 parameetriga või 3 parameetriga sobitamine. 

JOONIS 2. Parameetrite sobitamine

Kahe parameetriga sobitamine on ekspertkirjanduse põhjal laialdaselt aktsepteeritud [1]. Selles mudelis arvutatakse taustmüra 
c histogrammipõhise algoritmi abil ja lahutatakse signaali intensiivsusest, mille järel tehakse mittelineaarne sobitamine.

3 parameetriga sobitamine on samuti saadaval, nagu on viidatakse ekspertkirjanduses [2]. See mudel on mittelineaarne 
lähenemine, mis töötab otse algse sisendsignaaliga.

Mõlema mudeli puhul hinnatakse algset T2* väärtust, kasutades lineaarse testsobitamist.

1. D.J Pennell, et al. „Cardiovascular T2-star (T2Star) magnetic resonance for the early diagnosis of myocardial iron 
overload,“ Eur Heart J 2001; 22: 2171–2179.

2. Ghugre NR, et al. „Improved R2* Measurements in Myocardial Iron Overload,“ Journal of Magnetic Resonance 
Imaging 2006; 23: 9–16.
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T2* tulemuste ülevaatamine
1. Vaadake üle kõikide kujutiste kontuuri asukoht. 

2. Tabelis on loetletud üksikud T2*/R2* mõõtmised ja arvutatakse ka keskmine väärtus.

MÄRKUS. T2* kõver on signaali intensiivsuse ja kajaaja graafik, mis kasutab eksponentsiaalse sumbumiskõvera 
valemit. Mõnikord võib kõvera paremaks sobitamiseks osutuda vajalikuks hilisemad kajapunktid 
lagunemiskõveralt eemaldada. See võib ilmneda äärmuslikel raua ülekoormuse juhtudel, kui signaali 
intensiivsus võib olla väga madal.

Kujutiselt üksiku kontuuri kustutamiseks

1. tehke vasakklõps valitud kontuuril, mis muutub lillaks.

2. Prügikasti valimiseks tehke paremklõps või kasutage kontuuri eemaldamiseks klaviatuuril kustutusklahvi.
• Kontuur kustutatakse ja kõvera sobivus arvutatakse uuesti.

JOONIS 3. T2* kõver

HOIATUS! T2* kõvera tulemuste sobivuse peab üle vaatama koolitatud ja kvalifitseeritud kasutaja.

Koefitsienti 1000 kasutatakse, kuna T2 ja T2* on esitatud millisekundites (ms) ning R2 ja R2* hertsides (või s-1).

Tabel 2:  R2*/T2* konversioonid

Tulemus Ühik Konversioon

R2* Hz R2*=1000/T2*

T2* ms T2*=1000/R2*
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3D/4D voolu vaatur
Pakub 3D- ja 4D-voolu kujutiste interaktiivset kaldu ümbervormindamist. On olemas tööriistad 2D faasikontrastsuse ja 2D 
funktsiooni kujutiste loomiseks 4D-st, mida saab analüüsida. Saab teha järjestusevoolu analüüsi. 

MÄRKUS. Isomeetriliste vokslite ja kattuvate lõikudega 3D-seeria parandab ümbervormindatud kujutiste kvaliteeti.

MÄRKUS. 3D/4D voolu vaatur kuvab 4D-seeriaid ainult siis, kui 4D on litsentsitud.

MÄRKUS. Kui on tehtud nii 2D faasikontrastsuse kui ka järjestuse 4D voolu analüüs, on kõik tulemused saadaval voolu 
analüüsi režiimis. 

ETTEVAATUST! 3D- või kujutise ümbervormindamised annavad ainult täiendavat lisateavet diagnoosi 
tegemisel ja neid tuleks alati kasutada koos tavapäraste piltdiagnostika tehnikatega.

HOIATUS! Suhtestage kõik 3D ümbervormindamisedalati algsete ülesvõtte andmetega.

HOIATUS! Akna laiuse ja tasandi (WW/WL) seadistused võivad mõjutada erinevate patoloogiate ilmnemist ja 
võimet eristada teisi anatoomilisi struktuure. Valed WW/WL-seaded võivad põhjustada 
kujutiseandmete mittekuvamise. Kõigi kujutiseandmete ülevaatamiseks võib vaja minna erinevaid 
WW/WL-seadeid.
Tarkvara suiteHEART® kasutusjuhend NS-03-043-0003-ET Red. 2 154



3D/4D voolu vaaturi liidese komponendid

JOONIS 1. Kuva juhtimise tööriistad ja vaateavad

Vaate juhtimise

3D vaateava Aksiaalne vaateava

Kaldus vaateava 1 Kaldus vaateava 2

tööriistad
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Tabel 1:  Vaate juhtimise tööriistad

Tööriist Kirjeldus
Ristniit-kursor – sünkroonib liikumise kõigi vaateavade vahel. 

Orientatsiooni nupud – muudavad kujutise tasapinda 3D ja kaldus 
vaateavades.

S = Superior (ülemine)
I = Inferior (alumine)
A = Anterior (eesmine) 
P = Posterior (tagumine) 
L = Left (vasak)
R = Right (parem) 
Kaldus režiim – kuvab kaldu ümbervormindatud tasandi ja risti 
oleva vaheseina, et kuvada soovitud anatoomia. 

Kaksikkaldu režiim – kuvab kolm kaldu tasapinda, mis on 
määratletud kolme kohandatava värviteljega – sinine, kollane ja 
roheline. Ühe telje kohandamine uuendab teist kahte tasapinda. 

3D vaate režiim – kujutise sirvimise režiim 3D vaateavades

Pind – komposiitalgoritmil põhinev visualiseerimine
MIP = maksimaalse intensiivsuse projektsioon (vaikimisi)
MINIP = minimaalse intensiivsuse projektsioon

Voolujooned – visualiseerib 3D-kiirusvälju konkreetses ajafaasis.

Sätted:
Voolufilter – reguleerib voolujoonte intensiivsust.

Vektorid – verevoolu kiirust ja suunda näitavad nooled. 

Sätted:
Vektori filter – reguleerib verevoolu läve. 
Samm – reguleerib noolte tihedust.
Suurus – reguleerib noole skaalat kohaliku kiiruse järgi.
1 Värvülekate* (inaktiveeritud, kui on valitud voolujooned ja 
vektorid.)
2 Värvülekatte eemaldamine*
3 Faasi visualiseerimine*
*Olemas vaid 4D voolul.

1 2 3
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Kiiruse vahemik – kohandab voolu suuna kiiruse värvi määramist. 
Olemas vaid 4D voolu kujutistel.
Kiiruse vahemiku värviriba tingmärki kuvatakse iga vaateava 
parempoolses servas. Väärtus on hinnanguline.

Läbipaistmatus – reguleerib kujutisel kiiruse värvi läbipaistmatust 
alloleva anatoomia paremaks visualiseerimiseks. Olemas vaid 4D 
voolu kujutistel. 

Video – kontrollib kaadrite arvu sekundites ja määrab video algus- 
ja lõppkaadri. Olemas ainult 3D ajalahutusega ja 4D voolu kujutistel. 
Kasutage klaviatuuri tühikuklahvi video käivitamiseks ja pausile 
panemiseks.

Seeriate salvestamine (Save series) – loob analüüsimiseks 
konventsionaalsed 2D funktsiooni ja voolu kujutisteseeriad või 
järeltöödeldud MIP-kujutised. Kasutatakse lõikude arvu, lõikude 
paksuse, vahe ja vaatevälja sisestamiseks. Need parameetrid on 
märgitud igas vaateavas üleval vasakul. Kasutage 
klahvikombinatsiooni Ctrl + T sisse-/väljalülitamiseks.

Ainult magnituud (Magnitude only) – loob originaalkujutistest ühe- 
või mitmelõigulise mitmefaasilise magnituudiseeria funktsiooni 
analüüsi jaoks.

Magnituud ja faas (Magnitud and Phase) – loob originaalkujutistest 
ühe- või mitmelõigulise mitmefaasilise magnituudi- ja faasiseeriad 
voolu analüüsi jaoks. See suvand on olemas ainult juhul, kui on 
valitud 4D voolu seeria. (Luuakse ka duplikaatseeria, millel on 
automaatne faasi korrigeerimine).

Järeltöödeldud (Post-Processed) – loob 3D kujutisest maksimaalse 
intensiivsusega projektsioonikujutise. Kui 4D vooluandmed on 
olemas, luuakse kujutistele ülevaatamiseks ühe- või 
mitmelõigulised mitmefaasilised värvülekattega seeriad.

Järeltöödeldud, kõik (Post-processed All) – salvestab igast 
vaateavast kõik vormindatud kujutised.
Salvesta – salvestab seeria definitsiooni järgi loodud kõik kujutise 
seeriate tüübid kohalikku andmebaasi. 

Rx planeerimine – määrab seeria definitsiooni järgi loodud soovitud 
skannimise tasapinna telje. 

Tabel 1:  Vaate juhtimise tööriistad

Tööriist Kirjeldus
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Sirvimine ja lõigu paksus – muudab MIP-kujutiste paksust ja sirvib 
tervet kujutiste komplekti. 

1 = klõpsake ja lohistage äärmisi nuppe MIP-kujutise paksuse 
muutmiseks
2 = klõpsake ja lohistage liugurit terve kujutiste komplekti 
sirvimiseks või kasutage kerimisratast. 

Juhtnupud on valitud vaateavast paremal.

Lineaar – sirgel joonel oleva kauguse mõõt.
Klõpsake otse mõõdu peal ja seejärel tehke paremklõps, et 
kustutada, lokaliseerida või sildistada.

3D rotatsioon – kallutab või pöörab kujutisi 3D vaateavas ja/või 
kaldus vaateavades 1 ja 2. Kallutamiseks või pööramiseks tehke 
vasakklõps ja lohistage otse vaateavasse. 

Voolu suund – kuvab kaldus vaateavades 1 ja 2 risttasapinna. 
Kasutamiseks tehke vasakklõps otse huvipakkuval anatoomisel 
kohal. Olemas vaid 4D voolu kujutistel.

Aken/tasand – olemas kõikides vaateavades.

Panoraam – olemas kõikides vaateavades.

Suum – olemas kõikides vaateavades.

Roteeri – olemas 3D vaateavas, vaateavas 1 ja vaateavas 2.

Tabel 1:  Vaate juhtimise tööriistad

Tööriist Kirjeldus
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3D/4D voolu vaaturi paigutus ja seeriate loomise väljund
Olenevalt sellest, millised kujutisteseeria tüübid ümberformateerimiseks valiti, on kujutise loomise tüübid ära toodud allolevas tabelis. 

Lähtesta – olemas kõikides vaateavades.

Skannimisparameetrid – paremklõps suvalises vaateavas.

Tabel 2:  Kiirklahv

Funktsioon Tegevus
Kursor sihtkohale Pange kursor soovitud anatoomilisele kohale ja 

vajutage klahve Shift + Ctrl.
1 x 1 paigutus Topeltklõps mistahes 2 x 2 vaateavas lülitab paigutuse 1 

x 1 versioonile või tagasi 2 x 2 versioonile. 
Lineaarne mõõtmine Tehke, klõpsates Shift + 1.

Tabel 3:  3D/4D voolu vaaturi paigutus ja väljund

3D/4D voolu vaaturi paigutus 3D-kujutiste seeria väljund 4D voolu kujutiste seeriate väljund

3D vaade (ülemine vasakpoolne 
vaateava)

Järeltöödeldud Järeltöödeldud

Aksiaalne (ülemine parempoolne 
vaateava)

Ainult magnituud

Järeltöödeldud (MIP)

Ainult magnituud*, magnituud ja 
faas* ja järeltöödeldud 
(värvülekattega)*

Kaldus 1 (alumine vasakpoolne 
vaateava)

Ainult magnituud

Järeltöödeldud (MIP)

Ainult magnituud*, magnituud ja 
faas* ja järeltöödeldud 
(värvülekattega)*

Kaldus 2 (alumine parempoolne 
vaateava)

Ainult magnituud

Järeltöödeldud (MIP)

Ainult magnituud*, magnituud ja 
faas* ja järeltöödeldud 
(värvülekattega)*

*Neid seeriatüüpe saab kasutada konventsionaalseteks analüüsideks tarkvaras suiteHEART®.
Iga magnituudi- ja faasiseeria jaoks luuakse automaatse faasikorrektsiooniga duplikaat.

Tabel 1:  Vaate juhtimise tööriistad

Tööriist Kirjeldus
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Näidistöövoog 3D kujutisteseeriast MIP-kujutiste loomine
1. Valige sobiv uuring ja käivitage tarkvara suiteHEART®.

2. Valige .

3. Valige seeriate sirvimise rippmenüüst sobiv 3D-seeria. Valitud kujutisetüüp näidatakse nupul, nagu on näidatud Joonis 2.

JOONIS 2. Seeriate sirvimine

4. Valige  ja klõpsake soovitud vaateaval. Ilmuvad ümbervormindamise jooned, nagu on näidatud Joonis 3.

JOONIS 3. Topeltkaldu režiim
 

5. Klõpsake pideval joonel, tehke vasakklõps ja lohistage ning kallutage joont, et kuvada soovitud anatoomia. 
a.) Klõpsake salvestamiseks soovitud vaateaval. 
b.) Kohandage MIP-i paksust, kasutades vaateava parempoolses servas olevaid juhtnuppe. 
c.) Lõpetage seeria defineerimise sisestused, nagu näidatud joonisel 4. 
d.) Klõpsake salvestamise nupul, et MIP-kujutis kohalikku andmebaasi salvestada.
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JOONIS 4. Seeriate defineerimine

6. Looge MIP-kujutiste virn, valides .

MÄRKUS. Loodud järeltöödeldud MIP-kujutiste maksimaalne arv võib olla 512.

7. Klõpsake vaateaval, mille kujutist kasutatakse võrdlusena ja defineerige kujutistevirna pakk, nagu näidatud Joonis 5.
a.) Laiendage lõikudega katmise vahemikku.
b.) Kohandage lõigu suunda näitavat nurka ja nooli.
c.) Liigutage Rx telge.

JOONIS 5. Rx planeerimine

8. Sisestage seeria defineerimise suvandid ja klõpsake , et salvestada kujutiste pakk kohalikku andmebaasi. 

9. Loodud seeriate vaatamiseks lülitage funktsiooni analüüsi režiimile, valige ülevaatuse režiim ja klõpsake Värskenda 
(Refresh). 

1. Valige järeltöödeldud
2. Klõpsake
Salvesta

b

a a

c

Tarkvara suiteHEART® kasutusjuhend NS-03-043-0003-ET Red. 2 161



Näidistöövoog Analüüsimiseks 2D seeria loomine

Konventsionaalsete 2D faasikontrastsete või 2D funktsiooni kujutiste loomiseks on vaja 4D voolu seeriat, millel on nii 
ajalahutusega magnituudi kui ka voolu konventsioonid R/L, A/P ja S/I.

4D voolu kujutistest loodud ainult magnituudi või magnituudi- ja faasi-seeriad on sobivad 2D-tavaseeriad, mida saab 
kasutada funktsiooni või voolu analüüsis.

Seeriatel, mis on loodud 4D voolu järeltöötlusest, on värvivoo ülekate.

1. Valige sobiv uuring ja käivitage tarkvara suiteHEART®.

2. Valige .

3. Valige seeriate sirvimise rippmenüüst sobiv 4D seeria, nagu näidatud Joonis 6. Valitud kujutisetüüpi näidatakse nupul, 
nagu on näidatud Joonis 6.

JOONIS 6. Seeriate sirvimine

4. Valige  ja klõpsake soovitud vaateaval. Ilmuvad ümbervormindamise jooned, nagu on näidatud Joonis 7.

JOONIS 7. Topeltkaldu režiim

5. Klõpsake pideval joonel, tehke vasakklõps ja lohistage ning kallutage joont, et kuvada soovitud anatoomia. 
a.) Klõpsake salvestamiseks soovitud vaateaval ja valige magnituudi ja faasi režiim, et luua 2D faasikontrastne seeria või 

valige magnituud, et luua funktsiooni seeria. 
b.) Kohandage lõigu paksust kasutades vaateava parempoolses servas olevaid juhtnuppe. 
c.) Lõpetage seeria defineerimise sisestused, nagu näidatud joonisel 8, ja klõpsake salvestamise nupul, et seeria kohalikku 

andmebaasi salvestada.
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JOONIS 8. Seeria defineerimine ja salvestamine

6. Mitme lõiguga mitmefaasiliste kujutiste paki loomiseks klõpsake .

MÄRKUS. Loodavate multifaasiliset kujutiste maksimaalne arv on 32. 

MÄRKUS. Magnituudi ja faasi seeria salvestamisel rakendatakse teisele seeriale automaatne algtaseme korrektsioon. 
Seeriale lisatakse silt „korrigeeritud“ (corrected) nagu joonisel 9.

JOONIS 9. Automaatse paigutusvea korrigeerimisega faasi seeria näide

1. Valige magnituud ja faas

2. Klõpsake Salvesta
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7. Klõpsake vaateaval, mille kujutist kasutatakse võrdlusena ja defineerige kujutistevirna pakk nagu näidatud Joonis 10.

JOONIS 10. Rx planeerimine

8. Valige seeria defineerimise suvand ja klõpsake , et salvestada kujutiste pakk kohalikku andmebaasi. 

9. Loodud seeriate analüüsimiseks lülitage vastavale analüüsirežiimile ja klõpsake Värskenda (Refresh). 

Näidistöövoog Voolu mõõtmiste loomine 

Voolu analüüsi liidese tööriistade kohta lisateabe saamiseks vt Voolu analüüs lk 89.

1. Valige Analüüsi vahekaart (Analysis Tab).

2. Lokaliseerige huvipakkuv veresoon. Automaatseks segmenteerimiseks toetatakse vaid aordi ja kopsuveresoonte 

anatoomiat, nagu on näidatud. Voolukõver genereerimiseks klõpsake .
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JOONIS 11. Aordi ja kopsuveresoonte näide

HOIATUS! Kasutaja vastutab kõigi huvipakkuvate piirkondade (ROI) täpse paigutuse ja õige kategooria 
määramise eest, kaasa arvatud need, mis on genereeritud eeltöötluse käigus.

3. Käsitsi segmenteerimiseks lokaliseerige huvipakkuv veresoon ja klõpsake,  nagu näidatud Joonis 12.

Võimalik on teha 6 ROI-d, numbritega 1–6. Värvikood jääb kogu analüüsivaates, kujutiste vaateavades ja graafikutel 
samaks.

4. Looge veresoone ümber kontuur, paigutades 4 punkti huvipakkuva veresoone ümber.

5. Kõikides faasides segmenteerimiseks klõpsake .

JOONIS 12. ROI paigutamine käsitsi
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Kiiruse diskreetmoonutuse korrigeerimise tegemine

Kiiruse diskreetmoonutuse korrigeerimiseks lohistage faasi lahtipakkimiseks liuguri juhtnuppu. Muudatuse mõju 
uuendatakse otse faasi kujutisel ja tulemused kuvatakse otse voolugraafikul. Kõigi kolme kiirusega kodeeritud kujutise 
kontrollimiseks kolmes ortogonaalses (x, y, z) suunas valige rippmenüüst, nagu näidatud Joonis 13.

JOONIS 13.
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Aruandlus

HOIATUS! Aruanne tuleks enne kinnitamist ja väljastamist üle vaadata, et veenduda, et sisu vastab 
analüüsile. Kui aruandes esineb vigu, võib tekkida diagnoosimise edasilükkumine või 
valediagnoos. Analüüsi ja selle tõlgendamise peaks läbi viima nõuetekohaselt koolitatud ja 
kvalifitseeritud kasutaja.

Aruandluse liidesele saab ligi klõpsates liidese alumises parempoolses nurgas  või vajutades Alt + R. Südame 
kujutistest aruannete tegemiseks on soovitav kasutada kahte ekraani. 

Kui kasutatakse mitut ekraani, klõpsake ekraani valimiseks liidese ülemises parempoolses nurgas .

Aruandluse liides (Joonis 1) pakub menüüpõhist valikut. Valikuid saab teha otse liideses, valides sobiva aruande jaotise ja 
seda tekstiga täites. Aruande tekstid ja kategooriate vahemikud parameetrite tulemustega saab defineerida eelistustes. 
Valige Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit), valides vahekaardi Aruandlus (Reporting).

JOONIS 1. Aruandluse liides

1. Südame anatoomia valik, 2. Tulemused, 3. Menüü valikud, 4. Polaardiagrammide skeemid, 5. Monitori valimine, 6. Kopeeri aruanne HTML-
vormingus, 7. Aruande sisu, 8. Patsiendi demograafilised andmed, 9. Makro vahekaardid, 10. Lisa aruandesse kujutisi, graafikuid, tabeleid

1

2 3

4

5 6

7

8

9

10
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Patsiendi demograafilised andmed
Kirjelduse jaotis sisaldab patsiendi demograafilisi andmeid DICOM-i päisest. Välju saab redigeerida (esiletõstetud) nagu näidatud 
Joonis 10. 

MÄRKUS. Redigeerimine ei muuda DICOM-i päist. 

JOONIS 2. Demograafilised andmed

1. DICOM-i päise teave, 2. BSA valik 

BSA arvutamise tüüpi saab valida, tehes vasakklõpsu ümberpööratud kolmnurgal.

Allikas: http://halls.md/formula-body-surface-area-bsa/

Sobivat südame anatoomiat aruande jaoks saab valida liidese ülevalt vasakult, nagu näidatud Joonis 3. 
• LV: vasak vatsake 
• RV: parem vatsake 
• Kojad (Atria) 
• Klapid (Valves)

JOONIS 3. Südame anatoomia valik

BSA arvutamise meetod Valem

DuBois ja DuBois BSA (m2) = 0,20247 x pikkus(m)0,725 x kaal(kg)0,425

Mosteller BSA (m2) = SQRT ([pikkus(cm) x kaal(kg) ]/3600)
BSA (m2) = SQRT ([pikkus(in) x kaal(lbs) ]/3131)

Gehan ja George BSA (m2) = 0,0235 x pikkus(cm)0,42246 x kaal(kg)0,51456

Haycock BSA (m2) = 0,024265 x pikkus(cm)0,3964 x kaal(kg)0,5378

Boyd BSA (m2) = 0,0003207 x pikkus(cm)0,3 x kaal(grammides)0,7285 – (0,0188 x 
LOG(grammides))

1

2
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Aruande tegemine
MÄRKUS. Kategooriate vahemike täitmine võimaldab aruande automaatset eeltäitmist. Tekst eeltäidetakse vastavalt 

kasutaja määratud väärtustele. Kui aruande tegemise ajal tehakse menüü liidesest valik, siis eeltäitmise 
funktsioon enam ei tööta.

1. Valige menüüdest uuringu jaoks asjakohased leiud. Kui valitakse LV, täidetakse vasaku vatsakese aruande jaotis 
tekstiga, nagu näidatud Joonis 4.

JOONIS 4. Vasaku vatsakese valimise näide 

2. Asetage kursor sulgudest väljapoole ja vajutage klaviatuuril tagasinoolt, et eemaldada terve sulgudega rida, või 
asetage kursor sulgude sisse, et teksti käsitsi lisada või redigeerida.

MÄRKUS. Enne tulemusparameetrite loomist tuleb teha kõik asjakohased analüüsid.

3. Kõiki aruande jaotisi saab käsitsi redigeerida. Makrosid saab luua aruannete jaotiste Ajalugu, Mulje, Tehnika ja Leiud 
jaoks. Makrode konfigureerimiseks valige Tööriistad (Tools) > Eelistused (Preferences) > Redigeeri (Edit) ja valige 
Makro vahekaart.

JOONIS 5. Ajaloo vahekaart koos kasutaja defineeritud makrodega 

4. Valige aruande jaotises märkeruudud, et sisu aruandesse lisada või sellest välja jätta. Vt Joonis 6.

JOONIS 6. Aruande sisu

5. Aruande eksportimiseks HTML-vormingus klõpsake .
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Aruandesse kujutiste, graafikute või tabelite lisamine

1. Tehke mistahes vaateaval, graafikul või tabelil paremklõps ja valige .

2. Vaadake graafikuid või tabeleid valides .

MÄRKUS. Aruandesse saab saata mitme lõiguga kujutisi. Valige Tööriistad (Tools) > Eelistused (Preferences) > 
Redigeeri (Edit). Valige jaotises Üldine (General) märkeruut Mitme lõiguga kujutised aruandesse (Multi-
slice Image to Report). 

Tehke ülevaate režiimis paremklõps nupul ; pange tähele, et video peab olema pausile pandud.

JOONIS 7. Kujutised, graafikud, tabelid

1. Vaata graafikuid ja tabeleid, 2. Pealdise sisestamine, 3. Juhtnupud 

Juhtnupud 

Kujutiste, graafikute või tabeli sirvimine

Kaasa raportisse, kui saadaval

Kujutise formaat, väike või suur

Eemalda kujutis, graafik või tabel

Kujutise asukoht

1 2

3
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Polaardiagrammid
Polaardiagramme saab aruandesse lisada, kui täita vastav skeem. Polaardiagrammid on olemas funktsioonis, täiustatud 
režiimis ja perfusioonis. Polaardiagrammi aruandesse lisamiseks valige märkeruut, nagu näidatud Joonis 8.

JOONIS 8. Skeemid 

Segmendi valimine
1. Tehke vasakklõps värvkodeeritud kirjeldajal ja vasakklõps segmendil või 

paremklõps otse valitaval segmendil valides selle loendist või 
valige segmendist eemal, et seadistada kõik segmendid.

2. Kui segment valitakse funktsioonis või täiustatud režiimis, ilmub vastavasse aruande jaotisse kas Vasak vatsake või 
Parem vatsaka koos tehtud valiku teksti kirjeldajatega nagu näidatud Joonis 9.

3. Konfigureerige vaikimisi silt „Täiustatud“ (Enhancement) valides Tööriistad (Tools) > Eelistused (Preferences) > 
Redigeeri (Edit) ja sisestades soovitud sildi Müokardi hindamise (Myocardial Evaluation) alla. Valige Müokardi 
hindamise analüüsi (Myocardial Evaluation Analysis) vahekaardil sobiv silt.

MÄRKUS. Kui pikitelje tipusegment on tehtud, vormindatakse aruandel 17 segmendiga polaardiagramm.

MÄRKUS. Täiustatud skeemi saab sisse/välja lülitada, kui vaadatakse perfusiooni skeeme.

4. Polaardiagrammi seadistamiseks 4 värvile, valige Tööriistad (Tools) > Eelistused (Preferences) > Aruandlus (Reporting) 
> Polaardiagrammi värv (Polar Plot Color) ja valige 4-värviline (4-color).

JOONIS 9. Segmendi valimine 
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Aruande ülevaade 

1. Valige Fail (File) > Aruande ülevaade (Preview Report) või valige alt paremalt .

2. Vaadake aruanne üle, et kindlustada, et kõik soovitud tulemused ja struktureeritud teave oleks olemas.

3. Aruande salvestamiseks valige .

4. Valige faili tüüp ja asukoht.

MÄRKUS. Aruande failinime saab konfigureerida Eelistustes (Preferences). Vt Aruande eelistuste valikud lk 29.

TÄHTIS! Punasega toodud väärtused on vahemikust väljas ja seda ei ole näha, kui aruanne prinditakse mustvalgelt. 

JOONIS 10. Salvestamise aken

5. Aruande printimiseks valige Print.

HOIATUS! Aruanne tuleks enne kinnitamist ja väljastamist üle vaadata, et veenduda, et sisu vastab 
analüüsile. Kui aruandes esineb vigu, võib tekkida diagnoosimise edasilükkumine või 
valediagnoos. Analüüsi ja selle tõlgendamise peaks läbi viima nõuetekohaselt koolitatud ja 
kvalifitseeritud kasutaja.

Uuringu kinnitamine 
Rakendusel on funktsioon, mis kinnitab ja lukustab aruanded. Kinnitatud aruanne salvestatakse ja seda saab vaadata, kuid 
mitte muuta.

MÄRKUS. Eeltingimused: kasutajal peab olema aruande allkirjastamise õigus. Vt Aruannete lubatud kinnitajad lk 30.

MÄRKUS. Nupp ja menüü „Kinnitatud uuring“ (Approved Exam) ei ole aktiivsed, kuni kujutisel tehakse tegevusi.
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1. Valige Kinnita uuring (Approve Exam) või valige Fail (File) > Kinnita uuring (Approve Exam).

JOONIS 11. Uuringu kinnitamise aken

2. Sisestage allkirjastaja kirjeldus, kui soovite.

3. Valige Nime (Name) rippmenüüst oma kasutajanimi.

4. Sisestage oma salasõna.

5. Klõpsake Kinnitan (Approve), et kinnitada ja aken sulgeda. Klõpsake Tühista (Cancel), et aken ilma allkirjastamise 
protseduurita sulgeda.

Toodud kirjelduse järgi luuakse seeria.

MÄRKUS. Kui kinnitatud uuring on tehtud, on aruandel kuupäeva- ja ajatempel.

Eksportimise suvandid
1. Valige Tööriistad (Tools) > Ekspordi (Export) > Aruanne DICOM-i (Report to DICOM).

Luuakse sekundaarne ülesvõte (SCPT) ja salvestatakse seeriate loendisse.

2. Valige Tööriistad (Tools) > Ekspordi (Export) > Aruanne Excel-isse (Report to Excel).
Ekspordib aruande Excel-faili.

3. Valige Tööriistad (Tools) > Ekspordi (Export) > Aruanne XML-i (Report to DICOM).
Ekspordib aruande XML-faili.

4. Valige Tööriistad (Tools) > Ekspordi (Export) > Kujutised DICOM-i (Images to DICOM).
Luuakse sekundaarne ülesvõte (SCPT) ja salvestatakse seeriatesse.

5. Valige Tööriistad (Tools) > Ekspordi (Export) > Aruanne saata... (Report to ...).
Ekspordib aruande kolmanda isiku aruandesüsteemi.

6. Valige Tööriistad (Tools) > Ekspordi (Export) > Kujutised JPED-i, AVI-sse jne (Images to JPEG, AVI, etc.).
Kuvatakse Salvesta video (Save Cine) hüpikaken.

7. Valige Tööriistad (Tools) > Ekspordi (Export) > Andmed Matlab-i (Data to Matlab) (Ainult litsentsi olemasolul).
Ekspordib binaarvormingus Mat-faili.
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JOONIS 12. Salvesta video aken

1. Valige eksporditavad failitüübid.

2. Sirvige asukohta, kuhu fail(id) salvestada.

3. Eksportimise alustamiseks ja akna sulgemiseks klõpsake Salvesta (Save). Hetkel vaadatav seeria on ainus eksporditav 
fail.

MÄRKUS. Andmete eksportimisel AVI- või MOV-failidesse seab tarkvara suiteHEART® maksimaalseks 
kaadrisageduseks 20 kaadrit sekundis, olenemata rakenduses vaatamiseks kasutatavatest seadistustest.

MÄRKUS. Kui ekspordite kohandatud seeriat nii mitme faasiga kui ka ühe faasiga kujutistega .avi- või .mov-failina, 
veenduge, et enne eksportimist oleks valitud mitmefaasilist kujutist sisaldav vaateava.

Kinnitatud uuringu ülevaatamine 
1. Valige Fail (File) > Laadi üles kinnitatud uuring (Load Approved Exam). 

Kuvatakse aken Kinnitatud uuringu valimine (Select Approved Exam). Kõik kinnitatud uuringud, mis on seotud 
uuringuga, kuvatakse loendis.

JOONIS 13. Kinnitatud uuringu valimise aken
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2. Valige loendist seeria.

3. Kinnitatud uuringu ja sellega kaasneva analüüsi laadimiseks ja kuvamiseks klõpsake nuppu Laadi (Load). 
• Kinnitatud uuringut saab ainult vaadata.
• Kinnitatud uuringu põhjal saab luua uue uuringu, redigeerides kinnitatud aruannet ja salvestades need muudatused uuele 

uuringule. Uus uuringu salvestatakse teise ülesvõtte seeriana.

MÄRKUS. Kinnitatud uuringu ja analüüsi laadimisel kirjutatakse praeguse analüüsiseansi teave üle.

MÄRKUS. Tarkvara suiteHEART® varasemate versioonidega analüüsitud uuringute taastamisel ja kui on tehtud „Laadi 
üles kinnitatud uuring“ (Load Approved Exam), ei ole aruandel kinnitaja nime ega kuupäeva ja kellaaja 
templit. Soovitav on enne aruande väljastamist kõik analüüsid üle vaadata ja kõik tulemused kinnitada.
Tarkvara suiteHEART® kasutusjuhend NS-03-043-0003-ET Red. 2 175



Aruande andmebaas

Aruande andmebaas võimaldab otsida varem kinnitatud aruannete sisust. Aruanne sisestatakse aruande andmebaasi 
ainult pärast selle kinnitamist.

Aruande andmebaasi tööriista protseduur
1. Valige Tööriistad (Tools) > Aruande andmebaas (Report Database).

Valige otsingukriteerium
2. Valige otsingu jaoks Otsingute mallide (Search template) rippmenüüst õige mall.

3. Valige Ajaloo (History) rippmenüüst otsingupäring. Hetke päringuriba kuvab valitud väärtused.

JOONIS 1. Otsingu suvandid

MÄRKUS. Kui soovitud päringut veel ei eksisteeri, looge uus.
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 Päringu tegemine
1. Valige Ajalugu (History) reast paremalt Uus (New), nagu näidatud joonisel 1. 

Loodud päringute paane kuvatakse Aruande andmebaasi (Report Database) aknas.

JOONIS 2. Andmebaasi päringu paan

1. Päringu analüüside vahekaardid, 2. Päringu rühm, 3. Päringu väljad, 4. Päringu tähised, 5. Päringu parameetrid, 6. Loo päring (Create Query), 
7. Uus päring (New Query), 8. Päringu reeglid, 9 Päringu käivitamine, 10. Päringu suvandid

2. Valige päringu kategooria vahekaart Uuring (Study), Funktsioon (Function), ME, T2*, T1 kaardistamine (T1 Mapping) 
või T2 kaardistamine (T2 Mapping). Päringu rühmad ja väljad uuendatakse vastavalt sellele.

3. Valige päringu rühm.

4. Valige päringu väli.

MÄRKUS. Aruande andmebaas ei saa teha otsingut kohandatud mõõtmiste järgi.

5. Otsingu parameetrite määramiseks valige tähis.

6. Sisestage otsingukriteeriumi väärtuse jaoks parameetrid.

7. Valige Loo päring (Create Query) päringu kuvamiseks Reeglite (Rules) paanil. Ühe otsingu jooksul saab teha mitu 
päringut. Korrake samme 1 kuni 7 iga lisareegli jaoks.

Nupp Mitte (Not) tähistab, et päringu väärtus on negatiivne.

1

2

3

4 5

6 7

8

9

10
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Nupp Või (Or) ühendab mitu päringut, rahuldades otsingu vaid ühe päringuga. Nupu Või (Or) toime kohandub 
ülal tehtud päringureeglile.

Nupp Kustuta (Delete) annab võimaluse päringu reeglit valida ja kustutada.

8. Andmebaasist otsimiseks valige Käita (Run).
Otsingu tulemused kuvatakse Päringu tulemuse (Query Result) aknas. Päringu väärtused, mis rahuldavad 
otsingut, kuvatakse tulemuse akna kõige parempoolsemas veerus.

JOONIS 3. Päringu tulemuse aken

1. Ajaloo riba, 2. Päringu tulemused, 3. Prindi loend (Print list), 4. Prindi aruanded (Print Reports), 5. Ekspordi loend (Export list), 6. Kustuta, 
7. Too uuringud (Retrieve Studies)

MÄRKUS. Uue päringu tulemused ainult luuakse uuringu ID, uuringu kuupäeva, lubatud kinnitaja allkirja ja aruande 
malli kordumatu kombinatsiooni järgi. Kui nende väljade duplikaat tuvastatakse, asendatakse vana aruanne 
uuega.

Too uuringud (Retrieve Studies) 
1. Valige Päringu tulemuste (Query Result) aknast DICOM-i allikas (DICOM source).
2. Valige tulemuste loendist Uuringud (Studies).
3. Klõpsake Too (Retrieve).

JOONIS 4. Päringu tulemuse aken

1

2 3
4
5
6

7
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Tulemuste vaatamine
1. Aruande vaatamiseks tehke topeltklõps Päringu tulemuse akna mistahes kirjel. 

Avaneb uus aken, kus kuvatakse valitud aruanne. Kui olemas on rohkem kui üks aruanne, kasutage aruannete 
sirvimiseks nuppe Järgmine aruanne (Next Report) ja Eelmine aruanne (Previous Report). Aruande vaatamise 

akna sulgemiseks klõpsake akna sulgemise märgil .

JOONIS 5. Aruande vaatur

2. Peamisest aruandest lähtudes teeb andmebaasi liides järgmisi tegevusi.

Redigeeri (Edit) > Vali kõik (Select All) – valib kõik otsingutulemused.

Redigeeri (Edit) > Tühjenda valik (Clear Selection) – tühistab kõik otsingutulemuste valimised.

Redigeeri (Edit) > Lülita valik ümber (Invert Selection) – lülitab ümber kõigi tulemuste valimise olekud.

Redigeeri (Edit) > Tühjenda ajalugu (Clear History) – kustutab eelmiste päringute kirje.

3. Päringu loendi saatmiseks printerisse valige Prindi loend (Print List).
4. Valitud aruannete printerisse saatmiseks valige Prindi aruanded (Print Reports).
5. Loendi salvestamiseks html-failina ja aruande salvestamiseks pdf-failina valige Ekspordi loend (Export List).
6. Valitud aruande/aruannete eemaldamiseks aruande andmebaasist valige Kustuta (Delete).
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Päringu salvestamine
1. Valige Lemmikud (Favorites) > Lisa lemmikutesse (Add to Favorites). 
2. Sisestage Lisa lemmikutesse (Add To Favorites) tekstiväljale päringu silt ja klõpsake OK.

JOONIS 6. Lemmikute menüü

JOONIS 7. Lemmikute rippmenüü
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Lemmikute kustutamine
1. Valige Aruande andmebaasist Lemmikud (Favorites) > Halda lemmikuid (Manage Favorites).

JOONIS 8. Lemmikute haldamise aken

2. Valige lemmiku kirje.

Tulemuse aknas kuvatakse terve päringu valem.

3. Klõpsake Kustuta (Delete).
Kinnitamise hüpikaken kontrollib teie kustutamise valikut. Valige Jah (Yes).

4. Valige Sulge (Close).
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Otsingu tulemuste eksportimine HTML-faili
1. Valige Aruande andmebaasi akna paremas servas Ekspordi loend (Export List). 

JOONIS 9. Eksportimise aken

2. Valige kataloog, kuhu loend eksportida.

3. Valige OK.
• Hüpikaken küsib, kas kaasata tuleb ka aruanded.
• Loend ja aruanded eksporditakse HTML-faili. 
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Ekspordi andmebaas
Kui andmebaas muutub mahukaks, on soovitav andmed arhiveerida.

1. Valige Aruande andmebaasi menüüribalt Fail (File) > Ekspordi (Export).
2. Valige kataloog, kuhu loend eksportida.

3. Valige OK. Andmebaas eksporditakse välisesse salvestusseadmesse.

Andmebaasi importimine
Andmebaasi saab importida teisest arvutist, kuhu see eksporditi. 

1. Valige Fail (File) > Impordi (Import). 

JOONIS 10. Importimise aken

2. Valige kataloog, kuhu andmebaas importida.

3. Imporditud andmebaas liidetakse olemasolevaga. 
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Lisa
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Lisa B – Funktsiooni analüüsi skannimistasapinna näide
Täpsete funktsiooni analüüsi tulemuste saamiseks tuleks analüüs läbi viia lühikese telje vaates, nagu on näidatud alloleval esimesel 
joonisel.
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Õige skannimistasapinna ettekirjutus lühikese telje vaate saamiseks. Lõigud tuleks määrata vasaku vatsakese pikiteljega risti, vähemalt 
2 lõiku põhimikust kõrgemal ja 1 lõik pärast seeriasse kaasatud tippu.
Tarkvara suiteHEART® kasutusjuhend NS-03-043-0003-ET Red. 2 186



Indeks

Arvandmed
3D/4D voolu vaatur 154

Liidese komponendid 155
Seeriate loomise väljund 159
Vaaturi paigutus 159

Ä
Abimenüü suvandid 11

Algtaseme korrigeerimine 97

Andmebaas, sirvija 18

Andmebaasi sirvimine 18

Aruande andmebaas 176
Eksportimine, otsing HTML-i 182
Importimine, andmebaas 183
Lemmikute kustutamine 181
Otsingukriteerium 176
Päring 177
Salvesta päring 180
Tööriistade kasutamine 176

Aruande eelvaade 172

Aruandlus 167
Ekspordi 173
Polaardiagrammid 171
Protseduur 169
Ülevaade, aruande 172
Ülevaatamine, kinnitatud uuringu 172, 174

Aruanne
Eelistuste protseduur 29
Kinnitajad 30
Kinnitajad, haldamine 31
Kujutiste, graafikute, tabelite lisamine 170

Automaatne LV ja RV segmenteerimine 64

Automaatne segmenteerimine 91
Kõik lõigud, lõik faasid 66
Kõik lõigud, üks faas 67
Protseduur 92

Automaatne värskendamine 56

Avatud ovaalmulgu (PFO) analüüs 146
Tarkvara suiteHEART® kasutusjuhend NS-03-043-0003-ET Red. 2             187



E
Eelistused

Aruande kinnitajad 31
Aruanne 29
Ekspordi 47
Eksportimine (kujutis/video) 36
Funktsioon 34
Importimine 47
Jõudeoleku taimer 33
Kujutise/video eksportimine 36
Määramine 28
Makro 40
Mallid 37
Printimise vahekaart 42
Redigeerimine 28
Seeria filter 35
T1/T2 kaardistamise vahekaart 44
Üldine 31
Virtual Fellow® 30
Virtual Fellow® vahekaart 43
vool 32

Ekspordi
Eelistused 47

Eksportimine, osingu tulemus HTML-i
Aruande andmebaas 182

F
Faasivahemikud, redigeerimine 95

Failimenüü suvandid 10

Fantoomiga korrigeerimine 98

Funktsiooni analüüs 63
Kiire LV protseduur 80
Kohandatud mõõtmine

Lisa 85
Mõõtmised

Eemalda 85
Kustutamine 85
Lisa 85

Mõõtmiste seadistamine 84
Vatsakeste funktsiooni analüüsi tulemused 76

H
Hiline täiustamine

T2 121

Hilisema täiustamise analüüsimise protseduur 115
Tarkvara suiteHEART® kasutusjuhend NS-03-043-0003-ET Red. 2             188



Histogrammrežiim 102

HTLM, tulemuste eksportimine 182

I
Importimine

Andmebaas 183
Eelistused 47

Indeksmõõdud, arvutamine 64

Indeksmõõtude arvutamine 64

Integreeritud analüüs, tulemused 113

J
Jõudeoleku taimeri seadistused 33

K
Kambrite mahtude tabel 77

Käsitsi segmenteerimise protseduur 92

Kasutajaliides
Abimenüü 11
Analüüsirežiimid 9
Aruandlus 18
Failimenüü 10
Kujutise töötlemine 12
Kujutisevaaturi juhtnupud 11
Redaktori aken 10
Režiimi vaade 10
Ristlõigete režiim 12
Seeriate sirvimine 9
Tööriistade menüü 10
Ülevaade 8
Video 11

Kasutusnäidustused 2

Kasutusotstarve 2

Kiirklahvid 14

Kiiruse diskreetmoonutuse korrigeerimine 100

Klapi tasapinna analüüs 86

Kojad (Atria) 81

Kombineeritud analüüs 121

Kontuuri kustutamine 62

Kontuuri redigeerimine
Kustutamine 62
Tarkvara suiteHEART® kasutusjuhend NS-03-043-0003-ET Red. 2             189



Müksamise tööriist 59
ROI punktsplain 58
Tõmbamise tööriist 60

Kontuuri tõmbamise tööriist 60

Kontuuride redigeerimine 58

Kõvera tingmärgid, redigeerimine 104

Kõverarežiimi valikud 101

Kujutise töötlemise tööriistad 12

Kujutisehalduse tööriistad 21
Võrdlusrežiim 24

Kujutisevaaturi juhtnupud 11

Kustuta lemmik, aruande andmebaas 181

L
LA

automaatne 82
käsitsi 81

Lineaarne mõõtmine
Seadistamine 84

Lokaalne ROI tööriist 128

LV
käsitsi 68

LV segmenteerimine 64

M
Makro

Eelistused 40
Kustutamine 41
Muljed, lisamine 40
Rakendamine 41
Tekst 40

Mallid
Eelistused 37

Mittesünkroonsuse analüüs 79

Mõõtmised
Kohandatud, eemalda 85
Kohandatud, lisa 85
Kustutamine 85
Lineaar 84

Mõõtmised, vaikimisi 84

Mõõtmiste kustutamine 85

Müksamise tööriist 59
Tarkvara suiteHEART® kasutusjuhend NS-03-043-0003-ET Red. 2             190



Muljed
Makro, lisamine 40

Müokardi hindamine 114
Polaardiagrammi vormingud 117
T2 analüüs 119

Müokardi värvikaart 152

Mürapikslid, välistamine 99

Mürapikslite välistamine 99

N
Nihke suvandid 99

Õ
Ohud seadmetest 3

Ohutusmärkused 3

P
Päringu salvestamine, aruande andmebaas 180

Patsiendi demograafilised andmed 168

Piirkondlikud analüüsid 78

Põhimiku interpoleerimine 69

Polaardiagrammid
Segmendi valimine 171

Printimise vahekaart 42

Q
Qp/Qs

Arvutamine 108
Valikud 108

R
RA

Analüüs, käsitsi 81
Automaatne analüüs 82

Rakenduse käivitamine 6

Rakendusest väljumine 6

Redigeerimistööriistad, vaateava 95

Regurgitatsiooni fraktsioon, arvutamine 110
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Regurgitatsioonimaht, arvutamine 110
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Video režiim 11

Virtual Fellow® 48
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